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Shop Floor Tracking and Reporting Module
The Shop Floor Tracking and Reporting Module (SFRM) provides interactive tools for planning and 
controlling production activity. The SFRM Module allows you to setup workcenter calendars, plan capacity, 
perform dispatching, coordinate the manufacturing activities using a planning and schedule board, track 
order status and costs, track labor and resource utilization, follow up on material shortages, and generate 
shop paperwork.

The SFRM Module uses the following resource information currently in other Fourth Shift modules:

• Routings - Standard Products. Routings are defined by entering sequences of workcenter 
operations within a bill of material. In this manner you can also identify tools and tool returns. 
Operation sequences are controlled by Pt Use and Seq while timing is controlled by lead time 
offset. You can phase in planned routing changes by effectivity date and modify order-
dependent routings to reflect alternate operations and tools.

• Routings - Custom Products. Routings are defined by entering workcenter operations, tools 
and outside operations for a custom product order.

• Calculating Costs. Product and job costs based on the routings and workcenter labor/
overhead rates are calculated in the system. You can then assess the cost impact of changes 
to costs and routings.

• Reporting Actual Production Activities. Actual production activities are reported against 
manufacturing and custom product orders. You can then report actual operation times and unit 
completions by operation, parent receipts, and order closures.

Module Prerequisites
The Shop Floor Tracking and Reporting Module has the following prerequisites:

• SYSM (System Control)

• INVM (Inventory Control)

• BILM (Bill of Material)

• MOMM (Manufacturing Order Management)

• PRCM (Product Costing)

• MRPM (Material Requirements Planning)

• CUSM (Order Entry) or SOPM (Sales Order Processing)

• CPMM (Custom Products Manufacturing), when applicable

• PURM (Purchasing)
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Setting Up the Shop Floor Tracking and Reporting Module
Setting Up the Shop Floor Tracking and Reporting Module provides an overview of how to 
implement the module. It covers:

• guidelines to consider before you implement the module

• how to prepare your data for loading

• suggested procedures for loading your data

• suggestions for using the module

Before You Implement the Module
The primary function of the Shop Floor Tracking and Reporting Module (SFRM) is to provide a 
method for planning and controlling production activity. To efficiently use this functionality, your 
procedures should be reviewed in order to verify the requirements for your workcenters and 
calendars.

Workcenter Master
Workcenters within the SFRM Module are defined on the Workcenter Master. Workcenters are 
defined by a name and description and include a capacity amount and assigned calendar. Details, 
such as unit of measure and lead time, are also entered for the Run, Setup and Completion 
records for each workcenter. While a Run record is required for each workstation, the Setup and 
Completion records are optional and can be added to provide additional workcenter tracking and 
reporting capabilities for the workcenter. Records available for the workcenter include the 
following:

• Run. The Run record provides the information necessary for the Capacity Planning, Dispatch 
List and Router/Traveler functionality. The workcenter's daily capacity and calendar is defined 
on the Run record. By reporting actual hours expended against orders, you can track each 
order's remaining load at the workcenter. The Run record can also be used in product costing 
to reflect value-added labor and overhead costs incurred for each hour of workcenter 
operation. By reporting actual hours expended against orders, you can track labor and 
overhead variances.

• Setup. The Setup record can be used in product costing to reflect value-added labor and 
overhead costs incurred for each hour of setup operations amortized over accounting lot size. 
The Setup allows you to have labor/overhead rates for setup operations which are different 
than the rates for run-time operations. By reporting actual hours expended against orders, you 
can track labor and overhead variances for setups.

• Completion. The Completion record tracks unit completions at workcenters that reflect control 
points. By using a Completion record to report actual unit completions, the Dispatch List 
identifies the available balance-due units. If Completion records are not defined, unit quantities 
displayed on the Dispatch List reflect the parent order quantity. Remaining work is calculated 
based on hours, not completions, of parent receipts. The Completion record can also be used 
in product costing to reflect value-added labor/overhead costs incurred for each output unit. 
For example, you could allocate overhead based on production output (units) in contrast with 
production input (hours).

Workcenters as Resource Items
After a workcenter is entered on the Workcenter Master, the data is passed along to the Item 
Master, and resource items are automatically created for the workcenter records. A five-character 
Shop Floor Reporting 5
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prefix is added to the workcenter records. The prefix WC[?] defines how the item is used for 
routing and reporting purposes. Item prefix values are:

For example, the SAW workcenter is defined using run, setup and completion resource items. The 
PAINT workcenter is defined using run and setup resource items.

Workcenter Setup Examples
Workcenter load capacity is analyzed by combining resource components entered for each 
workcenter. The resource components are identified as a workcenter unit by using the same Pt 
Use/Seqn combination and are entered as a contiguous group. The end of a workcenter unit is 
reached when any of the following situations exist:

• one each of related WC[R], WC[S] and WC[C] components is encountered

• a WC[?] component of another workcenter is encountered

• another WC[?] component of the same workcenter is encountered after one each of related 
WC[?] components is encountered

• Pt Use and/or Seqn changes

• a non-WC[?] component is encountered

Listed here are several examples of how bills of material support, or do not support, the way the 
SFRM Module handles workcenters and the resource components considered to be associated 
with workcenters. It is recommended that you keep the use of the shop floor components simple. 
Do not attempt to record every detail of what happens on the shop floor. Only record enough 
information to assist in determining what orders need to be worked on in a workcenter and to 
assist with capacity planning.

Bills of Material: Supportive
The following are examples of bills of material that support how the SFRM Module handles 
workcenters.

• WC[S], WC[R] and WC[C]. This bill of material includes a contiguous group of setup, run and 
completion components for workcenter 100. The Pt Use/Seqn combination is the same for the 
WC[S], WC[R] and WC[C] components. Each WC[?] represents a different activity at 

Prefix Description

WC[R] Run-time hours for workcenter operations

WC[S] Setup hours for workcenter operations

WC[C] Unit completions for run-time operations at the workcenter

Workcenter in SFRM Type UM Item

SAW Run HR WC[R]SAW

SAW Setup HR WC[S]SAW

SAW Completion EA WC[C]SAW

PAINT Run HR WC[R]PAINT

PAINT Setup HR WC[S]PAINT
Shop Floor Reporting 6
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workcenter 100. The Pt Use/Seqn combination is used to tie the set up, run and completion 
components together and display workcenter information properly.

• WC[S] and WC[R]. A WC[C] component is optional. Completion units are not displayed by the 
SFRM Module without including the WC[C] component. The WC[R] is the only required 
component. If a WC[S] is specified, a WC[R] with the same Pt Use/Seqn combination must be 
specified for the workcenter.

• WC[R] and WC[C]. The WC[S] component is optional. If a WC[C] component is specified, a 
WC[R] component with the same Pt Use/Seqn combination must be specified for the 
workcenter.

• WC[R]. The WC[R] run component for a workcenter is required. The load to run the job 
through the workcenter is displayed in the SFRM Module.

Bills of Material: Supportive Examples
Supportive workcenters can be defined in many different ways. In the examples listed below, the 
related WC[S], WC[R] and WC[C] components are contiguous and have the same Pt Use/Seqn 
combination. The change in the Pt Use/Seqn combination signals the beginning of a new 
workcenter.

When a workcenter is used more than once in a bill of material, the Pt Use/Seqn combination 
must be different for each time through the workcenter so that activity can be tracked properly.

For example, the details for the following Pt Use/Seqn combinations include:

• Workcenter 100 is defined by WC[S], WC[R] and WC[C] components.

• Workcenter 200 is defined by WC[S] and WC[R] components.

• Workcenter 300 is defined by WC[C] and WC[R] components.

• Workcenter 100 is used a second time defined by a WC[R] component.

• Workcenter 200 is used a second time defined by WC[S] and WC[R] components.

Pt Use Seqn Component

100 001 WC[S]100

100 001 WC[R]100

100 001 WC[C]100

Pt Use Seqn Component

100 001 WC[S]100

100 001 WC[R]100

100 001 WC[C]100

Pt Use Seqn Component

200 002 WC[S]200

200 002 WC[R]200
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Note: To include a labor component on a bill of material, it must have a unique Pt Use/Seqn 
combination to differentiate the labor from the workcenters.

Bills of Material: Unsupportive
The following are examples of bills of material that do not support how the SFRM Module 
handles workcenters. 

• Two WC[R] Components. This example shows a bill of material which includes four WC[?] 
components with the same Pt Use/Seqn combination. Two WC[R] components are listed 
which causes unexpected results. Only one WC[R] component can be included for each 
workcenter. The WC[R]100-1 component may represent a different machine or activity within 
workcenter 100, but this two-level configuration cannot be processed correctly. The 
WC[R]100-1 component is treated as a different workcenter.

• Pt Use/Seqn Combination. This bill of material has WC[S], WC[R] and WC[C] components 
that do not have the same Pt Use/Seqn combination to associate them properly with 
workcenter 100. The Pt Use and Seqn fields are different for each component.

Pt Use Seqn Component

300 003 WC[C]300

300 003 WC[R]300

Pt Use Seqn Component

400 004 WC[R]100

Pt Use Seqn Component

500 005 WC[S]200

500 005 WC[R]200

Pt Use Seqn Component

26000 001 WC[S]100

26000 001 WC[R]100

26000 001 WC[R]100-1

26000 001 WC[C]100

Pt Use Seqn Component

10000 100 WC[S]100

20000 200 WC[R]100

30000 300 WC[C]100
Shop Floor Reporting 8



Fourth Shift Release 8.00 Setting Up the Shop Floor Tracking and Reporting Module
• Seqn Identification. This bill of material has WC[S], WC[R] and WC[C] components that do 
not have the same Pt Use/Seqn combination to associate them properly with workcenter 100. 
The Pt Use fields are the same, but the Seqn fields are different for each component. The Pt 
Use/Seqn combination is therefore not the same.

• Multiple Setups. This bill of material has several WC[S] components to represent multiple 
setups and a tear down of a machine. This information does not track properly since each 
WC[S] component must have a corresponding WC[R] component for the workcenter. It would 
be best to combine all the setups and the tear down into one WC[S]100 at Pt Use = 040 and 
Seqn = 004.

Workcenter Calendars
Workcenter calendars within the SFRM Module are initially based on the Fourth Shift Shop 
Calendar. You can use the Workcenter Calendars functionality to customize the initial shop 
calendar to fit the needs of each individual workcenter. For example, some workcenters may be 
used only during one shift, but other workcenters may be used during multiple shifts.

Determine if the Fourth Shift Shop Calendar or a customized calendar will be used for each 
workcenter.

Preparing Your Data for Loading
Information for workcenters and routings may exist in a variety of forms. There is no “one best 
method” for preparing this data. The following suggestions will help minimize data entry time and 
effort when you enter the data during startup.

System Configuration
Use Resource Component = 2 on the CNFG (System Installation Setup) screen to indicate 
routings are used. A routing (or bill of resources) defines the value-added labor and overhead 
costs associated with each manufactured item, and enables you to report actual labor/overhead 
expenditures against the routing. 

Pt Use Seqn Component

10000 001 WC[S]100

10000 002 WC[R]100

10000 003 WC[C]100

Pt Use Seqn Component

010 001 WC[S]100

020 002 WC[S]100

030 003 WC[S]100

040 004 WC[R]100

050 005 WC[S]100
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Workcenter Calendars
The initial Fourth Shift Shop Calendar can be customized for specific workcenters. Customizations 
can include changing shop days to nonshop days and adjusting capacity for the workcenter. 
Prepare the following information in order to customize the calendar for each workcenter:

• calendar name

• upper and lower tolerance limits for capacity

• shop days and nonshop days selection

• capacity amount

You can use the Calendar Save As functionality to copy calendar information from one to another 
by simply saving a calendar to another name. Use this functionality to save on data entry time if 
you need several calendars that have similar information.

Workcenter Default
New workcenters are created using default information. A workcenter default record can be setup 
in order to enter workcenter data more efficiently. For example, you can customize several fields 
on the default workcenter and these field values are automatically included on all newly added 
workcenters. Prepare the following information for the workcenter default:

• unit of measure

• planner

• buyer

• decimal precision

• yield

• lead time: run, fixed and inspection

• calendar name

• capacity

The Item Master includes the following resource items if the run, setup and completion records are 
selected for the default workcenter:

Default information for cost data is not included in the workcenter default but it should be manually 
entered using the ITMC (Item/Work Center Cost Data) and ITPB (Item Price Book) screens. See 
Workcenter Cost Data for additional information.

Workcenter Cost Data
Workcenter cost data is not included in the workcenter default and therefore the cost data must be 
manually entered using the ITMC (Item/Work Center Cost Data) and ITPB (Item Price Book) 
screens. Prepare the following information so that it can be loaded into your system.

Resource Item Description

WC[R]Default default run-time record

WC[S]Default default setup record

WC[C]Default default unit completions record
Shop Floor Reporting 10
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Cost Data on the ITMC Screen
Workcenter cost data is set up and maintained on the ITMC screen for Run and Setup resource 
items. Zero costs are typically entered for the Completion resource items. Use the following 
information to enter cost data for the Run and Setup resource items.

(1) Workcenter Overhead Rate: If you use overhead rates by workcenter, reflecting labor burden 
or other traceable overhead costs, enter the costs in the Var Ovrhd field and 0 (zero) in the Fix 
Ovrhd field. 

For example, when a workcenter's overhead rate is 100% of value-added labor and the 
workcenter's labor rate is $8.75 per hour, enter $8.75 in the Var Ovrhd field.

(2) Workcenter/Corporate Overhead Rate: If you use a combination of workcenter overhead 
rates and a corporate overhead rate based on value-added material, enter the workcenter rate in 
the Var Ovrhd field and 0 (zero) in the Fix Ovrhd field. Use the CROL task to calculate the value for 
the Fix Ovrhd field using the corporate overhead rate formula specified in the CROL task 
parameters.

Note: If you allocate overhead based on production output (units) at a workcenter, you can 
enter the workcenter's overhead rate per unit in the Var Ovrhd or Fix Ovrhd field for 
the WC[C] resource item. The choice of an overhead field depends on whether the 
fields are being used for other purposes. For example, the Var Ovrhd field may 
already be used for a workcenter labor burden rate, or the Fix Ovrhd field may already 
be used for a corporate overhead rate based on value-added material.

Price Data on the ITPB Screen
In a custom product manufacturing environment where you are selling workcenter capacity on 
customer orders and the Custom Product Pricing Method = P on the CNFG screen, use the 

Field Value

Inventory Acct No No significance. Define a dummy account on the GLCA screen and use the 
dummy account for all WC[?] resource items.

Set Up Cost 0

Avg Unit Pr 0

Sales Acct No Leave blank unless you intend to sell workcenter capacity on customer orders

COGS Acct No Leave blank unless you intend to sell workcenter capacity on customer orders

Cost Type Use the same value as on the CNFC screen. At a minimum, costs should be 
established for Cost Type = 0.

Cost Code 4

Costs Added at this 
Level

Matl = 0 (run and setup), enter value-added material costs for outside services.

Labor = labor rate incurred for each hour of processing (run and setup)

Var and Fix Ovrhd = Choose one of two options: Workcenter Overhead Rate 
(1)or Workcenter/Corporate Overhead Rate (2)

You can have different labor and overhead rates for the run and setup opera-
tions.

Rolled Costs 0
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ITPB (Item Price Book) screen to specify the hourly price of a workcenter operation for Run-time or 
Setup operations.

Routings and Workcenter Operations
Each operation in an item's routing is defined by entering the workcenter as a resource component 
using the BILL (Single Level Bill), PICK (Picklist) or CPMT (Custom Product Maintenance) screen. 
The operation description is entered on the Bill of Material Detail or Custom Product Component 
Detail screen. You can specify operation sequences and print the routing with detailed operation 
descriptions as part of shop paperwork.

Routing Definition: The BILL Screen
Use the following field suggestions to set up operations and routings on the BILL screen:

Field Value

unit price hourly price of the workcenter operation

Field Value

Pt Use (1) Point of Use is used to sequence your bills and picklists when the Component 
Sort Basis field = P on the CNFG screen.
If the Pt Use field has no significance, enter the operation sequence number or 
enter 0.

Seqn Operation sequence; should be the same when the run-time, setup and comple-
tions refer to the same task.

Component Run: workcenter prefixed with WC[R]
Setup: workcenter prefixed with WC[S] 
Completion: workcenter prefixed with WC[C]

Quantity Run: run-time hours
Setup: setup hours (2)

Completion: 1 (3)

QT Run: I (per item)
Setup: O (per order)
Completion: I (per item)

CT R for resource component

In/Out Effectivity 
Dates

Schedule planned engineering changes affecting operations on the date on 
which they become effective.

LT Offset Number of days the operation is typically performed after the order start date. 
This LT Offset reflects the parent item's lead time.
Operations are scheduled without consideration for lot size. If the lot size greatly 
affects operation start and due dates, you can manually override the system-cal-
culated operation due dates on the Picklist Detail screen for a given order.

Scrap Suggested entry is 0
For run and setup operations, the scrap factor indicates workcenter "inefficiency" 
for the particular operation. Scrap cannot be greater than 99.9%. 
For completions, the scrap factor represents "yield loss" for the particular opera-
tion.
Shop Floor Reporting 12
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(1) The Pt Use/Seqn combination is the same for the components associated with one workcenter.

(2) Setup costs are amortized by the CROL task based on the lot size for the parent item.

(3) If the operation makes multiple units, which then get combined into a parent item at a later 
operation, enter the conversion factor in the Quantity field. For example, the operation may need 
to complete 2 units which then get combined into one parent. In this case, enter .5 for the quantity 
per item.

Custom Product Routings
In a custom products manufacturing environment, you can easily configure the custom product 
routing using the OPSL (Option Selection) screen. The configuration information fields include: 
Group Name, Cnfg Type (configuration type), Cnfg Qty (configuration quantity) and Module 
Indicator.

One of three approaches can be used for entering configuration information for workcenter 
operations on the Bill of Material Detail:

• No Option Selection. Do not enter anything in the configuration fields. Workcenter operations 
are not displayed as options on the OPSL screen.

• Option Selection Only. Enter configuration information and 0 (zero) in the Cnfg Qty field. 
Enter the estimated number of hours for run-time and setup operations on the OPSL screen 
when configuring the order.

• Load Profile and Option Selection. Use the Quantity field on the BILL screen, for run-time 
and setup operations, to reflect the probability that the workcenter operation will be required 
for a custom product.

Use the Cnfg Qty field on the Bill of Material Detail screen to reflect the typical number of hours 
required when the workcenter operation is required. This configuration quantity can be overridden 
on the OPSL screen when more detailed information is known about the custom product being 
ordered.

Based on a forecast or production plan for the custom product, the PLNG (MRP Planning) task 
explodes the load profile so you can perform resource planning.

Custom product routings can also be defined directly on the CPMT (Custom Product Maintenance) 
screen. Use the following field suggestions when defining a workcenter operation as part of the 
routing on the CPMT screen.

Field Value

Seq The operation sequence should be the same when the run-time, setup and unit 
completions refer to the same task.

Typ R for resource

Component/WC# Run: workcenter prefixed with WC[R]
Setup: workcenter prefixed with WC[S] 
Completion: workcenter prefixed with WC[C]

Quantity Run: run-time hours
Setup: setup hours (1)

Completion: 1 (2)

QT Run: R (run hours), P (pieces per hour), M (move hours)
Setup: S (setup time)
Completion: R

Start Date Operation start date
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(1) Setup costs are amortized based on the order quantity for the custom product item.

(2) If the operation makes multiple units, which then get combined into a parent item at a later 
operation, enter the conversion factor in the Quantity field. For example, the operation may need 
to complete 2 units which then get combined into one parent. In this case, enter .5 for the quantity 
per item.

Operation Descriptions
If you have standard operation descriptions which are used in numerous routings, it is helpful to 
reuse the Text No assigned to the operation description. As a suggested method for identifying 
the Text No associated with each operation description, first prepare a written list of all possible 
operation descriptions. Use the TEXT (Text Review) screen to enter each operation description. 
Write the corresponding Text No on the previously prepared list, so that you can easily reuse the 
"operation id." 

• After a run-time or setup operation is entered on the BILL screen, use the Bill of Material Detail 
screen to enter the operation description.

• After a run-time or setup operation is entered on the CPMT screen, use the Custom Product 
Component Detail screen to enter the operation description.

Data Entry Alternatives
Data sets can be copied and updated to reduce data entry time and ensure accuracy. Use the 
following to copy data or enter repetitive data:

• Mask Setup. Use the Mask Setup window as a tool when entering repetitive or similar 
component data on the BILL screen. For more information, see "Default Data Entry Masks" in 
the Fourth Shift Basics manual.

• Copy Routings. Use the CBIL screen to copy bills of material.

• Engineering. If you are using the Engineering Module, use the copy functionality found within 
the Bill of Material feature to copy engineering or production bills of material.

Initial Cost Roll
An initial cost roll should be performed after workcenters are automatically entered on the Item 
Master and routings and operations are entered onto the Bills of Material. Tasks for a simulation 
cost roll looks similar to the following:

01  CROV  C F0 T9
05  CROL  T9 R E123102
10  CROV  E F9 T0

• Use the CROV (Cost Roll-over) task to copy product costs from Cost Type 0 to the simulation 
cost type, Cost Type 9. If costs already exist for the simulation cost type, you must first delete 
the costs using the CROV task.

• Use the CROL (Cost Roll-up) task to calculate product costs for the simulation cost type. The 
parameters depend on your choice of Roll-Up Method, Effectivity Date and calculation of 
corporate overhead. This example uses a regenerative roll-up method for Cost Type 9, an 
Effectivity Date of 12/31/02 and no corporate overhead rate.

• Use the CROV task to exchange product costs between the simulation cost type and Cost 
Type 0. 

Due Date Operation due date
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Note: Changing standard costs (Cost Type 0) should be undertaken with care since it may 
revalue general ledger inventory values and create variances for open and releases 
manufacturing orders.

Workcenter Load Calculations
Workcenter loads are derived from the routings for planned and firm-planned orders, and from the 
order-dependent routings for open and released orders. The PLNG (MRP Planning) task is used 
to calculate the manufacturing plan and corresponding workcenter loads.

Loading Your Data
Once your data has been prepared for entry, use this section to load your data into the Shop Floor 
Tracking and Reporting module.

A validation tool is identified for each screen or task listed in this section. Use the validation tool 
to double-check the accuracy of the data you have entered. Validation tools include:

• Screen reports. Create these reports by choosing Print from the File menu. For more 
information, see "Screen Reports" in the Fourth Shift Basics manual.

• Print screens. When other report options are not available, you can capture an image of your 
screen and use it to validate your data entry. For more information, see "Using the Print 
Screen Key" in the Fourth Shift Basics manual.

Other validation tools, such as batch processes and data extracts, may also be listed.

1. Check System Configuration

2. Configure the Module

Screen/Task Module Description Validation Tool

CNFG SYSM Verification:
Resource Component policy

print screen

Shop Calendar SYSM Verification:
shop calendar

print

CNFC SYSM Verification:
cost types

print screen

Screen/Task Module Description Validation Tool

FS.CFG file n/a CELSLotSizes configuration 
variable that defines default val-
ues for the Lot Size Estimate 
field.

print file

WorkCenterDelimiter configura-
tion variable that defines default 
delimiter as brackets [  ].

print file
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3. Define Workcenter Calendars

4. Define Default Workcenter

5. Define Workcenters

6. Define Operations and Routings

WorkCenterItemClass configu-
ration variable that defines the 
location of the workcenter capac-
ity in the Item Class field. Default 
value if not present is 7. 

print file

CELS tab from Options on the 
View menu

SFRM Optionally define cost roll 
options.

print screen

Screen/Task Module Description Validation Tool

Workcenter Calendars SFRM calendar name and tolerances screen report

Shop Day Selection available 
from Workcenter Calendars

SFRM calendar shop and non-shop 
days

print screen

Screen/Task Module Description Validation Tool

Workcenter Master SFRM DEFAULT workcenter screen report

ITMB INVM DEFAULT workcenter values screen report

Item Master Planning Detail INVM DEFAULT workcenter values screen report

Screen/Task Module Description Validation Tool

Workcenter Master SFRM define workcenters screen report

ITMC INVM cost data values screen report

ITMC INVM labor and overhead rates associ-
ated with a workcenter for Cost 
Type Ø

screen report

ITPB INVM default hourly price value screen report

Screen/Task Module Description Validation Tool

BILL BILM routings screen report

Bill of Material Detail BILM operation description print screen
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7. Calculate Product Costs

8. Verify Calculated Costs

9. Calculate Workcenter Loads

Screen/Task Module Description Validation Tool

CNFC SYSM cost type for simulation or budget 
purposes
For example, set up Cost Type 9 
with a description of "Simulated 
Cost" or set up Cost Type B with 
a description of “Budget Cost”

print screen

CROV and CROL PRCM batch process:
CROV task: 
exchange product costs between 
Cost Type 0 and the simulation 
cost type.
CROL task:
calculate product costs for the 
simulation cost type.
CROV task:
copy calculated product costs 
from the simulation cost type to 
Cost Type 0

log file

Screen/Task Module Description Validation Tool

ITCB INVM total cost for each item screen report

ITMC INVM all costs defined for each item screen report

CSLB PRCM costs for each parent item and 
related first-level components

screen report

CMLB PRCM costs for each parent item and all 
related components

screen report

INVR INVM batch process:
inventory values sorted by mas-
ter account number

INVR report
The values should 
reconcile to the G/L 
Inventory account 
balance.

Screen/Task Module Description Validation Tool

PLNG MRPM batch process:
MRP planning

log file
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Suggestions for Using the Module
The ways in which the SFRM Module are used vary from company to company. The following 
guidelines may be helpful for using the module in your company. See Workcenter Setup Examples 
under Before You Implement the Module for bill of material examples that support, or do not 
support, the SFRM Module.

Navigation and Selection Options
Several methods are available for navigating and selecting within the Shop Floor Tracking and 
Reporting Module. Navigational and selection methods include the following:

• Menu Options. Use the mouse to select an option from a menu. Click the menu title to view 
the options for each menu. Menu options may not always be available. If an option is 
unavailable, the text is grayed and the option cannot be selected. Click on the menu option to 
start the action listed. 

• Toolbar Buttons. Use the mouse to select a button from the main toolbar. The toolbar 
provides a quick way to access some of the most frequently used features of the module. 

• Mouse Conventions. Use the mouse to “drag and drop” components from one category to 
another. For example, to add a user to a group, simply select the user and then drag and drop 
the user into the specified group. Click the left or right mouse buttons to select open menus 
and options.

• Keyboard Conventions. You can use the standard keyboard keys to navigate within the 
system. Keyboard conventions are key or key combinations that allow you to carry out a 
command or action.

Menu and Toolbar Options
Menu options and toolbar buttons provide several methods for accessing the module features. The 
menu bar is located at the top of the application window. The toolbar is located below the menu 
bar at the top of the application window. Options may vary based on available features and for 
inquiry-only features. 

Menu Options
The following menu options are available:

Menu Option Description

File Open Opens based on specified information.

Go to Frame Allows navigation to the module features.

Print Preview Displays a report available for the specified parent item.

Quick Print Displays record selection options available to print an ad-hoc report.

Exit Exits you from the application.

View Refresh Clears the active field.

Find Opens the Find application that allows you to search for a specific 
component based on search criteria.

Find Next Repeats the search using the criteria defined in the Find feature.

Shop Calendar Opens the Shop Calendar, which allows you to calculate shop days 
based on specified criteria and view embedded revision information.
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Toolbar Buttons
The following toolbar buttons are available:

Maintaining Routings
The routings should represent the actual manufacture of your products. The BILL screen allows 
you to maintain routings one level at a time, and the system automatically maintains multi-level 
routings. Use the PICK screen to maintain an order-dependent routing.

Finder Allows you to open a Finder for searching.

Options Allows you to specify or review configuration settings.

Help Help Topics Opens the help.

Setting Up the Mod-
ule

Opens the help at the Setting Up the Module section.

About SFRM Displays version and release information

Toolbar Options Description

Go to Frame Allows navigation to the module features.

Open Opens based on specified information.

Print Preview Generates a report based on the current column settings and displays report on 
screen for review. Print the generated reports using your standard Windows print-
ing procedures.

Quick Print Displays record selection options available to print an ad-hoc report.

Refresh Clears the active field.

Find Opens the Find application that allows you to search for specific information in 
the displayed list.

Find Next Repeats the search using the criteria defined in the Find feature.

Find Workcenters Opens the Workcenter Finder for searching.

Find Items Opens the Item Finder for searching.

Find Customer 
Orders

Opens the Customer Order Finder for searching.

Find Manufacturing 
Orders

Opens the Manufacturing Order Finder for searching.

Find Purchase Orders Opens the Purchase Order Finder for searching.

Last Message Displays the previous message that was in the Status Bar, which is located at the 
bottom of the form.

Shop Calendar Opens the Shop Calendar, which allows you to calculate shop days based on 
specified criteria and view embedded revision information.

View Allows you to select a previously specified view using a drop menu.

Save Current View Saves the current layout of fields into a view.

Help Displays the contents of the help.
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The operation sequence in a routing should reflect the sequence of operations. Two resource 
components should have the same sequence number if they are needed at the same operation, or 
if they represent parallel operations. Material needed at an operation should have the same 
sequence number.

In some cases, it makes sense to define a group of operations that define a standardized routing. 
Define a parent for the "group item" on the item master as a normal make item, and use the BILL 
(Single Level Bill of Material) screen to define the resource components for the operations. Assign 
the group of operations to an item by adding the "group item" as a phantom component. 

Selling Workcenter Capacity
The suggested approach for selling workcenter capacity uses the capabilities of the Custom 
Products Manufacturing module. Stated simply, you take the customer order for a "type of 
capacity" and then configure what machines (or labor) are required. Use the following steps to sell 
work center capacity:

1. Define a normal item on the Item Master for each "type of capacity" that you sell, and specify a 
planning policy of "P" (production plan). For example, the "type of capacity" may be heat treat, 
assembly or painting. The unit of measure represents the pricing basis for selling capacity, 
such as hours or pounds.

Optionally, you can also do the following:

- Define a list price for each type of capacity (that reflects the item’s unit of measure, 
such as price per hour). Use the ITPB (Item Price Book) screen and the capabilities in 
the Advanced Price Book module.

- Define a planning bill that represents the "typical load profile" for the sale of capacity. 
With the planning bill, you can forecast (and production plan) the amount of demand 
for each type of capacity.

2. Enter the customer order line item for the custom product "type of capacity" and then configure 
the needed resource components on the CPMT (Custom Products Maintenance) screen.

Optionally, you can also do the following:

- Define the customer item, customer item description and line item text to describe the 
desired work for the CO line item

- Configure the resource components using option selection from the planning bill.

- Calculate the price of the CO line item using a "cost-plus markup" approach or a 
"rolled price approach".

- If the customer supplies materials and tools, you may want to track them. Define the 
customer-supplied material on the item master and include the material components 
in the configuration.

- Use a quote status on the CO line item, and then convert the quote to an order.

3. Schedule the load on the resource components. For example, use the Schedule Board to 
schedule the load. Be sure to record actual hours (and unit completions) for the resource 
component.

4. Complete and ship the job. Record job completion with a custom product order receipt using 
the CORV screen and shipment using the SHIP screen with Issue Type = I. Alternatively, you 
can ship right from work-in-process (Issue Type = I), or even use a backflush shipment 
transaction (Issue Type = E).

Reporting Labor and Overhead
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Workcenter labor and overhead details can be reported using several screens within the system. 

• Use the Workcenter Labor Reporting functionality available from the Router/Traveler screen to 
report the labor issued or reverse issued for the run, setup and completion records. 

• Use the LRRP (Labor/Resource Reporting) screen to report the expenditure of resources for 
specific orders. Then use the TRUD (Transaction Update) task on a periodic basis to update 
the database.

• Use the PICK (Picklist) screen to enter labor and resource expenditures.

• Use the BKFL (Backflush) task to backflush labor.

Capacity Planning
Capacity planning serves two primary purposes: long-range rough-cut capacity planning to assess 
the feasibility of your master schedule and short-range detailed capacity planning for workcenter 
scheduling.

Use the Capacity Planning feature to examine load versus capacity for the bottleneck 
workcenter(s). Start with monthly increments and then check weekly increments. In overloaded 
periods, use the Workcenter Load dialog to determine which items and orders should be 
rescheduled to level the load. Reschedule the load by changing the order due dates; you may 
need to firm up planned orders (thereby locking down the quantity and due date) to perform 
"schedule-fitting" and level the load on a rough-cut basis.

Run the PLNG (MRP Planning) task, and then use the Capacity Planning feature to assess your 
master schedule's feasibility.

Assessing Master Schedule Feasibility
When the PLNG task run time becomes too lengthy and you need to quickly assess master 
schedule feasibility, use the following suggestions to help minimize the time needed to perform 
iterative analyses. These suggestions are especially applicable when a limited number of 
workcenters are consistently identified as bottlenecks.

1. Define a WC[R] resource item on the ITMB (Item Master) screen for the bottleneck 
workcenters. Specify daily capacity, but enter zero costs. If a bottleneck workcenter already 
has a WC[R] resource item for detailed routing purposes, then define a second "dummy" 
WC[R] resource item.

2. Define a load profile. Use the BILL (Bill of Material) screen to enter the WC[R] resource item 
as a component to the appropriate production plan item or master schedule item, with a 
quantity that reflects average run-time hours (e.g., average run-time hours for all members of 
the product family).

3. Use the BSET (Batch Process Setup) screen to set up a batch process containing the PLNG 
(MRP Planning) task with the L (net change, one level then stop) parameter.

4. Use the BSET (Batch Process Execution) screen to run the batch process containing the 
PLNG task level-by-level task to recalculate the load on bottleneck workcenters. Depending 
on how you defined your load profiles, you may have to run this batch more than once to 
calculate loads correctly.

5. Sign onto Fourth Shift and use the Capacity Planning feature to review bottleneck 
workcenters, identify the items and orders in overloaded periods and perform schedule fitting 
to level the load.

6. When the master schedule has been roughly level-loaded, run the PLNG task in net change 
mode to process your entire product structure.
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Workcenter Scheduling
The Schedule Board is designed to give you a visual review of your workcenters and allows you to 
plan and schedule accordingly. Using the Schedule Board you can coordinate the manufacturing 
activities to meet commitments, improve overall production efficiency and improve resource 
utilization. You can also promise valid delivery dates based on material and capacity availability.

See "Dispatching" for additional information on workcenter scheduling.

Scheduling Differs From Capacity Planning
The Schedule Board differs from the Capacity Planning feature in that instead of displaying one 
workcenter at a time, it allows you to view groups of workcenters. For example, fabrication 
supervisors may only want to see the Fabrication workcenter, so they would use the Capacity 
Planning feature. Production Managers may want to view various workcenters, so they would use 
the Schedule Board to display specific groups of workcenters. 

The Schedule Board allows drill down capability. You can see the complete routing detail for an 
order and check the status of each operation using the Workcenter Load, Order Detail and Routing 
Detail dialogs.

Schedule Board Display
Schedule Board orders and operations are displayed using the following default colors. Default 
colors can be changed by selecting Options from the View menu on any Shop Floor and Reporting 
screen. 

Schedule Board orders:

Schedule Board operations:

Dispatching
Use the Dispatch List feature to coordinate the flow of work through production in order to meet the 
master schedule. For a given workcenter, the Dispatch List displays the orders to be worked on 
next, in operation due date sequence. The following screens can also be used to assist 
dispatching.

Color Description

purple customer order

light purple customer order routing

blue manufacturing order

light blue manufacturing order routing

white order rescheduling

Color Description

Red over capacity

Yellow with red over capacity (within upper tolerance)

Yellow under capacity (within lower tolerance)

Green under capacity

Gray available capacity (no load)
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• The Schedule Board feature provides planning and scheduling for standard products. Use the 
Schedule Board to promise valid delivery dates based on material and capacity availability.

• The Capacity Planning feature identifies overloaded periods. Use the Workcenter Load dialog 
to identify items and orders in overloaded periods. Then try to sequence orders to minimize 
setup times, facilitate similar setups, lessen change-over time, maximize reuse of fixtures/
tools or take advantage of natural job sequences.

• The Location Index feature summarizes all manufacturing activity related to a parent item, 
providing a tool for answering "Where are we?" questions at any manufacturing level in the 
product structure. Open the Status of Open/Released Manufacturing Orders dialog to view 
manufacturing activity for a critical component. Open the Order Progress Against Routing 
dialog for detailed status about a selected order.

• The Router/Traveler feature displays the operations, tools, materials and outside services 
needed to manufacture an order and can be used to print shop paperwork.

Analyzing Lead Times
Use the Lead Time Analysis feature to identify the critical path of components, which helps focus 
lead time reduction efforts on those items directly contributing to the parent item's cumulative lead 
time. Lead time reduction helps you become more competitive and improves financial 
performance.

When assessing an assemble-to-order production strategy for a product, use the Lead Time 
Analysis feature to identify what items should be built to an intermediate (or subassembly) level. 
The final assembly lead time should be reflected in the demand fence so you only final assemble 
actual orders.

Analyzing Order Status
Use the Order Completion Status feature to answer inquiries about the status of released and 
closed orders. You can review quantity ordered versus quantity received and date scheduled 
versus date needed for released and closed orders.

Analyzing Order Costs
Use the following screens to analyze costs associated with manufacturing and S-type purchase 
orders:

• Use the OCST (Order Cost Variance Status) screen to compare planned costs (based on the 
order-dependent bill/routing) and actual costs incurred to-date.

• Use the MCST (Manufacturing Order Cost Analysis) screen in the Product Costing Module to 
review the actual order costs compared to the evaluation costs associated with each 
component required to manufacture the parent item on a manufacturing order.

• Use the PCST (Purchase Order S-Line Cost Analysis) screen in the Product Costing Module 
to review the order costs compared to the evaluation costs associated with a parent item on a 
purchase order for Ln# Type = S line items.

See "Calculating Costs" in the Product Costing manual for more information on order costs.

Estimating Product Costs
Use the Cost Estimate by Lot Size feature to perform a cost roll-up for an individual item. Use 
"what-if" simulations to assess the impact of changing cost data by using a different cost type. 
Assess product structure changes by using a different effectivity date. Changes to lot size affect 
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amortization of setup costs. The Cost Estimate by Lot Size feature also provides a separate 
breakout of setup and outside services costs.

Expediting Material Shortages
Component availability is typically checked prior to order release from the MOAN (Planner Action) 
and POAN/POAS (Buyer Action) screens by using the related Material Shortages Detail screen. 
Item shortages are listed on these screens by action messages indicating the need to release or 
reschedule orders and to follow up on past-due orders. 

The Buyer and Planner Action screens provide time-phased action messages for acting on 
shortages. The SDAL (Supply/Demand Analysis) screen is an on-line representation of the 
projected inventory balances for a specified item. Use the following two screens within the SFRM 
Module for supplemental information to what is provided on the buyer and planner action and 
SDAL screens:

• Use the Item Shortages feature to identify all items with shortages. When prompted that 
received material is needed in production immediately, use the Item Shortages feature to 
expedite the received material to the appropriate orders. Check the Show Order Detail box to 
display the released manufacturing order detail.

• Use the Shortages by Order feature to view material shortages for a specified order. Open the 
Other Orders Requiring Item dialog to resolve order allocation priorities and expedite order 
completion.

Using the Finder
The Finder is used to locate records, such as items or components, in the database. The Finder 
displays all records that match the known search criteria you supply.

The Finder is made up of two grids: the Search criteria grid and the Results list grid.

Using the Search Criteria Grid
The Finder allows you to search for records or values that meet a set of defined search criteria. 
By entering known field values, you can locate a record and open it for review or modification. 

You can:

• Locate a record by a known value. For example, you can use the Finder to locate an item by 
entering the item's id. In this case, the Item you enter is the search criteria.

• Locate a record by an incomplete value. If you know the first three characters of an Item, 
for example, you can enter them as the search criteria. The Finder displays a list of all of the 
available items whose Item begins with those three characters.

• Locate a record using values for multiple fields. If you know part of an item's description in 
addition to the first three characters of the Item, you can enter information for both the Item 
and Description. The Finder displays a list of all of the available items whose Item begins with 
those three characters and includes the partial description. It is important to note that the 
Finder locates records that meet both criteria, not either criteria.

• Locate a record using a wildcard character. If you know part of an item's description in 
addition to part of the Item identifier, you can enter a wildcard for both the Item and 
Description. Use the "*" wildcard character in addition to the partial item and description. 

For example, if you want to search for components where the item identifier contains the word 
front and the description includes the word wheel, enter *front* for the partial Item and *wheel* for 
the partial Description. The Finder displays a list of all the available items whose Item and 
Description match the partial descriptions.
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As a general rule, the more specific your search criteria, the easier it will be to locate the record 
you are looking for.

Using the Results List Grid
The Results list grid displays the records that match the search criteria. Each record appears in a 
row in the Results list grid.

The Results list grid contains the same columns that appear in the Search criteria grid. When it 
displays the records that meet the search criteria, it displays values in all of the available columns. 
The number of records displayed in the Results list depends on how specific the search criteria is.

System Administration
The System Administration manual outlines the tasks involved in maintaining Fourth Shift. The 
Shop Floor Tracking and Reporting Module includes special considerations in the areas of 
backups, configuration variables, server processes and security.

Configuration Variables
The following configuration variable is used in the Shop Floor Tracking and Reporting Module and 
can be customized, if desired:

Server Processes
To successfully run the SFRM Module, you need to have the following server processes running:

• ODBC Server 

• Fourth Shift Transactional Interface (FSTI)

The SFRM Module uses the ODBC Server process to access the Fourth Shift database and it 
uses FSTI to update the Fourth Shift database when processing schedule board transactions and 
reporting workcenter labor. See "Fourth Shift Transactional Interface" in the System Administration 
manual for more information.

Security
It is generally advisable to limit screen access to only those personnel responsible for maintaining 
an accurate database. Each user who will be using the SFRM Module should be assigned security 
access to the following tasks and screens in order for the SFRM Module to communicate and 
update data with the Fourth Shift database:

Variable Description

CELSLotSizes Identifies the default values for the Lot Size Estimate field.

SFRMDir Shop Floor Tracking and Reporting database location

WorkCenterDelimiter Identifies the delimiter used for workcenters. Default is “[“ (bracket). Valid 
delimiters include: [ - * . / + %

WorkCenterItemClass Identifies which position in the Item Class field is being used to specify 
daily capacity. Valid positions are 7 or 8. Default value is 7 if the variable is 
not present.
If you chose position 8, the Capacity values on the MPSS (Master Produc-
tion Schedule Summary) screen for workcenters display zeros. Use posi-
tion 7 to specify capacity that can also be viewed on the MPSS screen.
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• ITMB (Item Master)

• PICK (Picklist)

• POMT (Purchase Order)

• COMT (Customer Order)

• MOMT (Manufacturing Order)

• CPMT (Custom Product Order)

Use the FCMT (Function Code Maintenance) and PASS (Password Maintenance) screens in the 
System Control Module to set up security for the SFRM Module. See "Special Security 
Considerations" in Suggestions for Using the Module in the System Control manual for more 
information.
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CAPC – Capacity Planning
Capacity Planning compares workcenter load to capacity using a stacked bar chart. Two basic formats are 
available, absolute hours and percent of capacity, with variations based on period size and starting date. 
Used interactively, Capacity Planning brings to your attention the periods in which load exceeds capacity, 
and helps diagnose bottlenecks using the detailed load information in the Workcenter Load and Order 
Progress Against Routing pop-up windows. 

• Workcenter Load. Lists the workcenter run and setup operations with due dates occurring 
within the selected period. The item, order number, line number, run load and setup status are 
displayed. In an overload situation, you can identify orders and items which need to be 
rescheduled or rerouted to reduce the load, or you can anticipate the need to increase 
capacity.

Note: Double-click anywhere in the CAPC screen graph area or on a specific day to display 
the Workcenter Load window. 

- Click in any blank area on the graph to display all workcenter load information.

- Click on a specific bar on the graph to get just the information related to that date.

- Use Print or Print Preview to produce the Capacity Planning Workload report.

• Order Progress Against Routing. Lists the detailed status of each operation in the routing 
for the specified order. Detail information includes the workcenter, available quantity, 
completed quantity, setup status and remaining run load to complete for each operation.

Note: Double-click on any line on the Workcenter Load window to display the Order 
Progress Against Routing window and view the detailed status for a selected order.

Be sure to review the load for a specific workcenter to ensure realistic schedules. You can view the 
capacity load details going to a specific load and then clicking the right mouse button.

Capacity Planning Graphical Features
Capacity Planning displays a stacked bar chart of load requirements. The chart varies slightly 
based on the customizations and selected parameters.

• You can customize the following aspects of the capacity planning bar chart by selecting 
Options from the View menu:

- Columns. Specify the number of columns displayed. Default is 12.

- Chart type. Specify the chart as 2- or 3-dimensional. Default is 3.

- Chart colors. Specify the colors of the actual load, planned load, overloads for both 
actual and planned loads, and unused capacity (excess loads).

• Several fields can change the display of the chart. The Format field defines the vertical axis as 
scaled to absolute hours or percent of capacity. The Period field defines the column as daily, 
weekly or monthly.

• The height of each column reflects the total load within the Period.

• In each column, actual load (based on firm, open and released orders) is shown as a straight 
line pattern, while planned load (based on planned orders) is shown as a criss-cross pattern. 
The white bar in each column reflects the total capacity within the period. Total capacity is 
displayed only when all of the following conditions are met:

-  Load exists for the period.
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-  A baseline capacity is defined in the workcenter calendar.

-  The period is in the present or future; capacity cannot be displayed for past periods.

• The first column reflects the date entered in the Start Date field. After you press ENTER to 
display the chart, the Start Date defaults to a date that enables you to view the next set of 
periods.

Reports

Capacity Planning Reports
To generate the report, choose Print Preview from the File menu.

Stack Bar Chart
Report Description
Lists the capacity information as a stacked bar chart.

Access Method
To generate the report, choose Print Preview from the File menu. 

Report Template
For more information on report templates, see "Reporting for SQL Server Systems" in the System 
Help topics.

Available From
  Capacity Planning

Workcenter Load
Report Description
Lists workcenter load and capacity including if setup is required.

Access Method
To generate the report, choose Print Preview from the File menu. 

Report Template
For more information on report templates, see "Reporting for SQL Server Systems" in the System 
Help topics.

Available From
Capacity Planning

Report Title

Capacity Planning -- Stack Bar Chart
Lists the capacity information as a stacked bar chart.

Capacity Planning -- Workcenter Load
Lists workcenter load and capacity including if setup is required.

Location Index -- Order Progress Against Routing
Lists operations statuses to-date in the routing for a specified order
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Fields
Avail Qty

Available Quantity of Units indicates the number of units completed at the Prior 
Workcenter available for processing at the specified workcenter operation.

Where Used: Capacity Planning; Dispatch List; Location Index; Schedule Board

Capacity
Capacity is the total number of hours available per period for performing work. Capacity is 
used with Item Type = R (resource) items and is typically specified as a daily rate for a 
workcenter using the Item Class #7 field on the Item Master Detail screen. Entry is up to 
9999999999.

Where Used: Capacity Planning; Dispatch List; MPSR; MPSS; Workcenter Master

Complete Qty
Units Completed indicates the number of units reported as complete at a specified 
workcenter operation.

Where Used: Capacity Planning; Location Index; Schedule Board

Description
Item Description identifies the item in terms of its characteristics. When space is limited, a 
partial description is displayed. Entry is any alphanumeric combination of up to 70 characters.

Where Used: A/P Received Item List; ABCR; Advance Ship Notice Line; APPI; APPV; 
Available Pricing; AVII; AVIT; BILI; BILL; Bill of Material; Bill of Material Detail; Browse Setup 
(item); Capacity Planning; CCAN; CCAT; CMLB; COBK; COCP; COMP; Comparison Bill; 
Comparison of Summarized Bills; Contract Item Detail; Contract Item Detail/Pricing; CORV; 
Cost Estimate by Lot Size; Costed Bill Detail; CSLB; Custom Product Component Detail; 
Customer Item + General; Customer Order; Customer Order Receipt/Reverse; CWIP; 
Demand Peg Detail; Dispatch List; Engineering; FCST; ICCR; IHIR; INVA; Inventory 
Allocation; Inventory History List; Inventory Transaction History Report; INVR; IORD; IPPD; 
ISVI; ITBI; ITCB; ITCI; Item + Alternates; Item + Quantity; Item Availability; Item Availability + 
Quantity; Item Browse; Item Browse Detail; Item History; Item Lot Trace and Serialization 
Detail; Item Master; Item Master Detail; Item Master Planning Detail; Item Responsibility 
Assigned Results; ITMB; ITMC; ITMI; ITPB; ITPI; Job Estimates and Performance Report; 
Lead Time; Lead Time Analysis; Lead Times Assigned Results; LEXP; Line Item Details + 
Item; LMSI; LMST; Location Index; Lot Detail; Lot Inventory Transaction History Report; Lot 
Trace; Lot Trace Issue Detail; Lot Trace Receipt Detail; LOTR; LVAL; Manufacturing Order 
Line Item Detail; Manufacturing Order Receipt/Reverse; Material Exposure; MBIL; MCST; 
MOMI; MOMT; MORI; MORV; MPSR; MPSS; MSMT; Multi-Level Bill; Multi-Level Costed Bill; 
Multi-Level Where Used; MUSE; Open Order Detail; OPSL; Order Completion Status; Order 
Cost Variance Status; Order Detail; Order Line Items; OVAR; Package Content; Packaging 
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Detail; Partner Item Detail; PBCI; PBCT; PBII; PICI; PICK; Picklist Detail; POAN; POAS; 
POCI; POCR; POCT; POMI; POMT; PORI; PORR; PORV; POYE; Production; Purchase 
Order Line Item Detail; Purchase Order Line Item Detail (CPMT); Purchase Order Line Items; 
Purchase Order Receipt History; Purchased Component Detail; QSRC; QUOI; QUOT; Router/
Traveler; SDAB; SDAL; Shipment Allocation Detail; Shipments by Line Item; Shipping Detail; 
Shortages by Order; SHPL; Single-Level Configuration Bill of Material Report; SSII; SSIL; 
Standard Costs Assigned Results; Standard Product Detail; Summarized Bill; Supply Peg 
Detail; Transaction Detail; VDII; VDIT; VDSC; VITI; Where Used; WIPR; WUSE

Format
Display Format indicates how the stacked bar chart of load hours should be displayed. The 
Display Formats are:

Absolute = Display load in absolute hours
Percent = Display load as a percent of capacity

Where Used: Capacity Planning

Item
Item is the unique identifier for a part, whether it be a piece part, tool, raw material, an 
assembly or finished product. All items are set up using the ITMB screen. Within a product 
structure, an item can be a component as well as a parent. Entry is any alphanumeric 
combination of up to 30 characters.

Where Used: A/P Received Item List; ABCR; Advance Ship Notice Line; Allowance/Charge 
Detail (Detail); APPI; APPV; AUDT; Available for Shipping Allocation Batch; AVII; AVIT; Bill of 
Material Accuracy Results; Browse Setup (item); Capacity Planning; CBIL; CCAN; CCAT; 
CIMT; CINV; COAN; COBK; COCD; COMI; COMP; Comparison Bill; Comparison of 
Summarized Bills; COMT; Contract Item Detail; Contract Item Detail/Pricing; Contract 
Summary; CORV; CSTU; Cumulative Detail; Customer Item + General; Customer Order; 
Customer Order Line Price Adjustment; Customer Order Receipt/Reverse; CWIP; Demand 
Peg Detail; Engineering; FCST; GASN; ICCR; IHIR; IMTR; INVA; Inventory Adjustment 
Application; Inventory Allocation; Inventory History List; Inventory Transaction History Report; 
INVR; IORD; IPPD; ISVI; ITBI; ITCB; ITCI; Item + Quantity; Item Availability; Item Availability + 
Quantity; Item Browse; Item Browse Detail; Item History; Item Lot Receipt; Item Lot Trace and 
Serialization Detail; Item Master; Item Master Detail; Item Master Planning Detail; Item 
Responsibility Assigned Results; Item Shortages; ITHC; ITHR; ITMB; ITMC; ITMI; ITPB; ITPI; 
Lead Times Assigned Results; LEXP; LHIS; Line Item Details + Item; LMSI; LMST; Lot Detail; 
Lot Inventory Transaction History Report; Lot Selection; Lot Trace; Lot Trace Issue Detail; Lot 
Trace Receipt Detail; LOTR; LVAL; Manufacturing Order Line Item Detail; Manufacturing 
Order Receipt/Reverse; Material Shortages Detail; MCST; MOAN; MOFR; MOMI; MOMT; 
MORI; MORV; MPIT; MPSR; MPSS; MSMT; Multi-Level Bill; Multi-Level Costed Bill; Multi-
Level Where Used; MUSE; Open Order Detail; Order Completion Status; Order Cost Variance 
Status; Order Detail; OVAR; Package Content; Packaging Detail; Packing List; Partner Item 
Detail; PBCI; PBCT; PBII; PICI; PICK; Picklist Detail; POCI; POCR; POCT; PORI; PORV; 
POYE; Pricing Maintenance + Action Detail; Pricing Maintenance + Action List; Pricing 
Maintenance + Items/Customers; Pricing Maintenance + Test Order; Production; Purchase 
Order Receipt History; Purchased Component Detail; QSRC; QUOI; QUOT; Router/Traveler; 
Schedule Board; SDAB; SDAL; Selection Setup; Serial Number List; Serial Numbers Shipped; 
SHIP; Shipment Allocation Detail; Shipment Allocation List; Shipments by Line Item; Shipping 
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Allocation Batch; Shortages by Order; SHPL; SSII; SSIL; Standard Costs Assigned Results; 
Standard Product Detail; Summarized Bill; Supply Peg Detail; Transaction Detail; VDII; VDIT; 
VDSC; VEIT; Vendor/Item Detail; VETI; VITI; VPFR; WIPL; WIPR; WIPS; WUSE

Ln#
Line Number is the identification of a line item on an order. The Line Number is system-
assigned. Entry is up to 3 numbers.

Where Used: A/P Invoice Matching Detail; A/P PO/Inv Variance by Invoice; A/P Receiving 
Detail; Advance Ship Notice Line; Advance Ship Notice Order Detail; APEX; APID; APPI; 
APPV; APUV; Available for Shipping Allocation Batch; Backflush Issue Reconciliation Report; 
Bill of Material Accuracy Results; Capacity Planning; CCAN; CINV; COAN; COCD; COCP; 
COMI; COMT; CORV; CPMT; CSTU; Custom Product Component Detail; Custom Product 
Detail; Customer Order; Customer Order + Order Header; Customer Order Line Price 
Adjustment; Customer Order Receipt/Reverse; CWIP; Demand Peg Detail; Dispatch List; 
GASN; IHIR; IMTR; Inventory Transaction History Report; IORD; Item Shortages; JEST; Job 
Estimates and Performance Report; LHIS; LMSI; LMST; Location Index; Lot Detail; Lot 
Inventory Transaction History Report; Lot Trace Issue Detail; Lot Trace Receipt Detail; LOTR; 
LRRP; Manufacturing Order Line Item Detail; Manufacturing Order Receipt/Reverse; Material 
Shortages Detail; MCST; MOAN; MOFR; MOMI; MOMT; MORI; MORV; MSMT; Open Order 
Detail; OPSL; Order Completion Status; Order Cost Variance Status; Order Detail; Order Line 
Items; OVAR; Package Content; Packaging Detail; Packing List; PCMT; PCST; PICI; PICK; 
Picklist Detail; POAN; POAS; POMI; POMT; PORI; PORR; PORV; POSR; POVD; Pricing 
Maintenance + Test Order; Purchase Order Line Item Detail; Purchase Order Line Item Detail 
(CPMT); Purchase Order Line Items; Purchased Component Detail; Router/Traveler; 
Schedule Board; SDAB; Serial Number List; SHIP; Shipment Allocation Detail; Shipment 
Allocation List; Shipments by Line Item; Shipping Allocation Batch; Shortages by Order; 
SHPL; STAD; Standard Product Detail; Supply Peg Detail; Transaction Detail; TRUD; VDSC; 
VPFR; WIPL; WIPR; WIPS

Ln# Sta
Line Number Status indicates the item's current position within the order process. Line 
Number Statuses are:

blank = Order Point Quantity Level Reached. 
PREV and MRP have determined that the order point quantity of the item has been 
reached.

1 = MRP Planned Order. 
MRP has automatically planned an order for the item.

2 = Firm Planned. 
The item's order quantity and scheduled date are fixed and are not automatically 
changed.

3 = Open. 
The item's order quantity and scheduled date are fixed. The order-dependent bill of 
material is attached to the item.

4 = Released. 
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The item's order quantity and scheduled date are fixed. The order-dependent bill of 
material is attached to the item. The order and picklist can be printed and receipts/
issues can be made.

5 = Closed. 
All required receipts or issues have been made for the item.

6 = Closed. 
The order closure report has reported this order closure.

7 = Closed. 
The order is ready to be deleted from the active file and retained in order history.

Line Number Status can in most cases only be incremented. You can reopen an order, which 
decrements the Line Number Status from 5 to 4. For purchase orders, Line Number Status 
= 4 can be changed to 3 if no receipts were completed for that line item and the line is not Ln# 
Typ = S.

Where Used: Capacity Planning; CCAN; Demand Peg Detail; Dispatch List; IHIR; Item 
Shortages; Location Index; Manufacturing Order Line Item Detail; Manufacturing Order 
Receipt/Reverse; Material Shortages Detail; MCST; MOAN; MOMI; MOMT; MORI; MORV; 
MSMT; Open Order Detail; Order Completion Status; Order Cost Variance Status; Order Line 
Items; PCST; PICI; PICK; Picklist Detail; POAN; POAS; POMI; POMT; PORI; PORR; PORV; 
Purchase Order Line Item Detail; Purchase Order Line Item Detail (CPMT); Purchase Order 
Line Items; Purchased Component Detail; Router/Traveler; Schedule Board; Shortages by 
Order; Supply Peg Detail; Transaction Detail; WIPL; WIPR; WIPS

Ln# Typ
Line Number Type determines the use of the item order quantity in planning, manufacturing 
and accounting. Line Number Types available depend on the screen where the transaction is 
completed; these include:

B = By-product. 
Created as part of another order.

M = Manufacturing. 
Dependent demands are automatically created.

R = Rework. 
Dependent demands are not automatically created but are manually added.

U = Tool Return. 
Created as part of another order.

X = Custom Product. 
Make-to-order and engineer-to-order products.

Where Used: Capacity Planning; CCAN; Demand Peg Detail; Dispatch List; IHIR; Item 
Shortages; Location Index; Manufacturing Order Line Item Detail; Manufacturing Order 
Receipt/Reverse; Material Shortages Detail; MCST; MOAN; MOMI; MOMT; MORI; MORV; 
Order Completion Status; Order Cost Variance Status; Order Line Items; OVAR; PICI; PICK; 
Picklist Detail; Router/Traveler; Schedule Board; Shortages by Order; Supply Peg Detail; 
WIPL; WIPR; WIPS
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Load
Load is the aggregate number of hours of work per period, typically calculated for a 
workcenter based on the time required to perform workcenter operations with due dates within 
the period.

Where Used: Capacity Planning; Dispatch List

Oper Date
Operation Due Date is system-calculated for planned orders based on the order start date 
plus the component's lead time offset, where the order start date is based on the order due 
date minus the parent's lead time. After creating an order-dependent routing (e.g., for opened 
or released orders), the Operation Due Date can be modified on the Picklist Detail screen. 
For custom products, the Operation Due Date can also be modified on the CPMT screen.

Where Used: Capacity Planning; Dispatch List; Location Index; Schedule Board

Order No
Order Number is the user-defined identifier for a purchase, manufacturing or customer order. 
Entry is any alphanumeric combination of up to 30 characters.

Where Used: APEX; Backflush Issue Reconciliation Report; Bill of Material Accuracy 
Results; Browse Setup (order); Capacity Planning; CINV; COCP; Dispatch List; EDIX; IHIR; 
IMTR; Inventory Transaction History Report; IORD; Item Shortages; LMSI; LMST; Location 
Index; Lot Detail; Lot Inventory Transaction History Report; Lot Trace Issue Detail; Lot Trace 
Receipt Detail; LOTR; LRRP; MSMT; Order Browse; Order Completion Status; Order Cost 
Variance Status; ORST; OVAR; Router/Traveler; Schedule Board; SDAB; SHIP; Shipment 
Allocation List; Shortages by Order; STAD; TRUD; VDSC

Period
Period Increment identifies the increment in which the information is to be displayed. Period 
Increments are:

Daily = Increments on a daily basis.
Weekly = Increments on a weekly basis.
Monthly = Increments on a monthly basis.

Where Used: Capacity Planning; Dispatch List

Pt Use
Point of Use is a key field that, along with the Seqn field, defines the sort sequence of 
components in a bill of material. The Point of Use field accepts any information you choose to 
enter, but the intended use is to identify the "work center" where the component should be 
delivered when assembling the parent, the "find number" of the component referenced on the 
drawing for the parent, or the "component reference designator" of the component on a printed 
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circuit board. If the Point of Use field is not applicable in your company, you may enter 0 
(zero). Entry is any alphanumeric combination of up to 5 characters.

Where Used: BILI; BILL; Bill of Material; Bill of Material Detail; Capacity Planning; 
Comparison Bill; Custom Product Component Detail; Demand Peg Detail; Dispatch List; 
Engineering; Exceptions; Job Estimates and Performance Report; Lead Time; Location Index; 
LRRP; Material Shortages Detail; MBIL; Multi-Level Bill; Multi-Level Where Used; MUSE; 
Order Cost Variance Status; OVAR; PICI; PICK; Picklist Detail; Pricing Maintenance + Test 
Order; Production; Purchase Order Line Item Detail; Purchase Order Line Item Detail (CPMT); 
Router/Traveler; Schedule Board; Single-Level Configuration Bill of Material Report; TRUD; 
Where Used; WUSE

Reqd Quantity
Required Quantity is the number of component items required for the parent item. Entry is up 
to 10 numbers. Decimal places are allowed.

Where Used: Capacity Planning; Custom Product Component Detail; Item Shortages; 
Location Index; Material Shortages Detail; Picklist Detail; Purchase Order Line Item Detail 
(CPMT); Router/Traveler; Schedule Board; Shortages by Order

Run Load
Run Load indicates the remaining run time to complete the workcenter operation, and is the 
Bal Due times the per-unit run-time hours on the routing.

Where Used: Capacity Planning; Dispatch List; Location Index; Router/Traveler; Schedule 
Board

Seqn
Sequence Number is a key field that, along with the Pt Use field, defines the sort sequence of 
components in a bill of material. The field accepts any information you choose to enter, but the 
intended purpose is to identify the operation sequence number on the parent’s routing that 
calls out the component. If the Sequence Number is not applicable in your company, you may 
enter 0 (zero). Entry is up to 3 numbers.

Where Used: Backflush Issue Reconciliation Report; BILI; BILL; Bill of Material; Bill of 
Material Detail; Capacity Planning; CINV; COCP; Comparison Bill; CPMT; Custom Product 
Component Detail; CWIP; Demand Peg Detail; Dispatch List; Engineering; Exceptions; Job 
Estimates and Performance Report; Lead Time; Location Index; LRRP; Material Shortages 
Detail; MBIL; MCST; Multi-Level Bill; Multi-Level Where Used; MUSE; OPSL; Order Cost 
Variance Status; OVAR; PCST; PICI; PICK; Picklist Detail; PORI; PORV; Production; 
Purchase Order Line Item Detail; Purchase Order Line Item Detail (CPMT); Purchased 
Component Detail; Router/Traveler; Schedule Board; Single-Level Configuration Bill of 
Material Report; TRUD; Where Used; WIPL; WIPR; WUSE
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Set Up
Setup Status indicates whether any time has been reported against the workcenter setup 
operation. The Setup Status options are:

Yes = Time has already been reported against the setup operation.
blank = No workcenter setup item WC[S] exists for this operation.

Where Used: Capacity Planning; Dispatch List; Location Index; Schedule Board; 
Workcenter Master

Start Date
Start Date specifies the first period that should be displayed when requesting an analysis, 
such as the first column of stacked bar charts on the Capacity Planning screen.

Where Used: Capacity Planning; Schedule Board

Workcenter
Workcenter is the identifier for a specific production facility, consisting of one or more people 
and/or machines, which can be considered as one unit for the purposes of capacity planning, 
scheduling and costing. If the SFRM Module is installed, workcenters are defined on the 
Workcenter Master. If the SFRM Module is not installed, workcenters are established on the 
Item Master as resource items. The workcenter's run, setup and completion records define 
how the workcenter should be used when constructing the bills of material.

When the workcenter is displayed on the Item Master, a five-character prefix is added to the 
workcenter name. Prefixes include:

WC[R] = Run-time hours for workcenter operations
WC[S] = Setup hours for the workcenter operations
WC[C] = Unit completions for run-time operations at the workcenter

Workcenter entry is any alphanumeric combination of up to 10 characters.

Where Used: Capacity Planning; Dispatch List; Location Index; Router/Traveler; Schedule 
Board; Workcenter Master

Workcenter Load
Operation Due Date is system-calculated for planned orders based on the order start date 
plus the component's lead time offset, where the order start date is based on the order due 
date minus the parent's lead time. After creating an order-dependent routing (e.g., for opened 
or released orders), the Operation Due Date can be modified on the Picklist Detail screen. 
For custom products, the Operation Due Date can also be modified on the CPMT screen.

Where Used: Capacity Planning; Dispatch List; Location Index; Schedule Board
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CELS – Cost Estimate by Lot Size
Cost Estimate by Lot Size simulates the impact of in-effectivity date, cost type and lot size on item costs. 
Cost data is calculated for various user-specified lot sizes using the product structure in effect as of the 
user-specified date and the set of cost data for the user-specified Cost Type. For each lot size the screen 
displays the total and per unit costs, a breakdown of material, labor and overhead costs, and setup costs.

Cost roll options are specified by selecting Options from the View menu. Cost roll options include selecting 
to roll components of "buy" items, always include yield (ignore Cost Codes = 2, 4), and always include 
scrap (ignore Cost Codes =3, 4). Costs for production plan items are not estimated.

A detailed breakdown of item costs for a specific lot size is available by clicking on the magnifying glass 
icon next to the Lot Size Estimate field. Cost detail includes a breakdown of material, labor and overhead 
costs for item related, order related, unit cost and extended costs for the lot size. Click on the arrows to 
scroll to the other lot size estimate fields and view cost breakdown detail.

Reports

Cost Estimate by Lot Size Reports
To generate the report, choose Print Preview from the File menu.

Report Description
Lists cost estimate simulation results and includes a detailed breakdown of item costs.

Access Method
To generate the report, choose Print Preview from the File menu. 

Report Template
For more information on report templates, see "Reporting for SQL Server Systems" in the System 
Help topics.

Available From
Cost Estimate by Lot Size

Fields
As of

The Bill as of Date is used to request a product structure in effect as of a specified date for 
the purposes of displaying or analyzing the bill/routing for the parent item.

Where Used: Cost Estimate by Lot Size; Lead Time Analysis

Report Title

Cost Estimate by Lot Size
Lists cost estimate simulation results and includes a detailed breakdown of item 
costs.
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Cost Type
Cost Type specifies the basis for item cost. You can define up to 11 Cost Types using the 
CNFC screen. Cost Type 0 is always used for inventory valuation. Entry options include:

0 = Cost Type 0
1 = Cost Type 1
2 = Cost Type 2
3 = Cost Type 3
4 = Cost Type 4
5 = Cost Type 5
6 = Cost Type 6
7 = Cost Type 7
8 = Cost Type 8
9 = Cost Type 9
B = Cost Type B (budget)

Where Used: CMLB; CNFC; COMP; Cost Estimate by Lot Size; Cost Selection; Costed Bill 
Detail; CSLB; ITBI; ITCB; ITCI; ITHC; ITMC; Multi-Level Costed Bill; QUOI; QUOT

Description
Item Description identifies the item in terms of its characteristics. When space is limited, a 
partial description is displayed. Entry is any alphanumeric combination of up to 70 characters.

Where Used: A/P Received Item List; ABCR; Advance Ship Notice Line; APPI; APPV; 
Available Pricing; AVII; AVIT; BILI; BILL; Bill of Material; Bill of Material Detail; Browse Setup 
(item); Capacity Planning; CCAN; CCAT; CMLB; COBK; COCP; COMP; Comparison Bill; 
Comparison of Summarized Bills; Contract Item Detail; Contract Item Detail/Pricing; CORV; 
Cost Estimate by Lot Size; Costed Bill Detail; CSLB; Custom Product Component Detail; 
Customer Item + General; Customer Order; Customer Order Receipt/Reverse; CWIP; 
Demand Peg Detail; Dispatch List; Engineering; FCST; ICCR; IHIR; INVA; Inventory 
Allocation; Inventory History List; Inventory Transaction History Report; INVR; IORD; IPPD; 
ISVI; ITBI; ITCB; ITCI; Item + Alternates; Item + Quantity; Item Availability; Item Availability + 
Quantity; Item Browse; Item Browse Detail; Item History; Item Lot Trace and Serialization 
Detail; Item Master; Item Master Detail; Item Master Planning Detail; Item Responsibility 
Assigned Results; ITMB; ITMC; ITMI; ITPB; ITPI; Job Estimates and Performance Report; 
Lead Time; Lead Time Analysis; Lead Times Assigned Results; LEXP; Line Item Details + 
Item; LMSI; LMST; Location Index; Lot Detail; Lot Inventory Transaction History Report; Lot 
Trace; Lot Trace Issue Detail; Lot Trace Receipt Detail; LOTR; LVAL; Manufacturing Order 
Line Item Detail; Manufacturing Order Receipt/Reverse; Material Exposure; MBIL; MCST; 
MOMI; MOMT; MORI; MORV; MPSR; MPSS; MSMT; Multi-Level Bill; Multi-Level Costed Bill; 
Multi-Level Where Used; MUSE; Open Order Detail; OPSL; Order Completion Status; Order 
Cost Variance Status; Order Detail; Order Line Items; OVAR; Package Content; Packaging 
Detail; Partner Item Detail; PBCI; PBCT; PBII; PICI; PICK; Picklist Detail; POAN; POAS; 
POCI; POCR; POCT; POMI; POMT; PORI; PORR; PORV; POYE; Production; Purchase 
Order Line Item Detail; Purchase Order Line Item Detail (CPMT); Purchase Order Line Items; 
Purchase Order Receipt History; Purchased Component Detail; QSRC; QUOI; QUOT; Router/
Traveler; SDAB; SDAL; Shipment Allocation Detail; Shipments by Line Item; Shipping Detail; 
Shortages by Order; SHPL; Single-Level Configuration Bill of Material Report; SSII; SSIL; 
Shop Floor Reporting 37



Fourth Shift Release 8.00 CELS – Cost Estimate by Lot Size
Standard Costs Assigned Results; Standard Product Detail; Summarized Bill; Supply Peg 
Detail; Transaction Detail; VDII; VDIT; VDSC; VITI; Where Used; WIPR; WUSE

Extended Cost
Extended Cost is the value of the item calculated as Unit Cost * Lot Size Estimate.

Where Used: Cost Estimate by Lot Size

Fixed Overhead
Fixed Overhead is the total fixed overhead cost to manufacture an item. It is the sum of the 
fixed overhead costs of the item's components and the Fixed Overhead of the item itself. 
Displays are based on the specified Cost Type.

Where Used: Cost Estimate by Lot Size

Item Related
Item Related is the cost of all items (Quantity Type = I) and their components. The Item 
Related cost is included in the Unit Cost and Extended Cost.

Where Used: Cost Estimate by Lot Size

Labor
Labor represents the total labor cost to manufacture an item. It is the sum of the labor costs of 
the item's components and the Labor of the item itself. Displays are based on the specified 
Cost Type.

Where Used: Cost Estimate by Lot Size

Lot Size Estimate
Lot Size Estimate is a user-specified lot size quantity for the purposes of estimating product 
costs. Entry is up to 6 numbers for each Lot Size Estimate. You can enter up to 5 Lot Size 
Estimates. Enter a positive quantity to display total product costs.

Where Used: Cost Estimate by Lot Size

Lot Size Option
Lot Size Option is the user-selectable costing option that determines the cost rollup method 
used on the Cost Estimate by Lot Size screen. Entry options include:

1 = end item lot size
2 = all lot sizes
3 = lot size multiples
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Where Used: Cost Estimate by Lot Size

Material
Material represents the total material cost to manufacture an item and is the sum of the 
material costs of the item's components. Displays are based on the specified Cost Type.

Where Used: Cost Estimate by Lot Size

Order Related
Order Related is the cost of all items (Quantity Type = O) and their components. The Order 
Related cost is included in the Unit Cost and Extended Cost.

Where Used: Cost Estimate by Lot Size

Parent
Parent is a term that describes the structural relationship between an item and its components 
in a bill of material. A Parent item is the higher level item in the parent-component relationship. 
A parent cannot be used in itself. Entry is any alphanumeric combination of up to 30 
characters.

Where Used: BILI; BILL; Bill of Material; Bill of Material Detail; CMLB; Comparison Bill; 
Comparison of Summarized Bills; Cost Estimate by Lot Size; CSLB; Dispatch List; 
Engineering; Lead Time; Lead Time Analysis; Location Index; Material Exposure; MBIL; Multi-
Level Bill; Multi-Level Costed Bill; Multi-Level Where Used; MUSE; Production; Summarized 
Bill; Where Used; WUSE

Setup
Setup is the total hours of setup time times the hourly rate for workcenter setup operations. A 
workcenter setup operation contains a five-character prefix “WC[S]” to the workcenter id when 
specified on the Item Master.

Where Used: Cost Estimate by Lot Size

Total Cost
Total Cost represents the total cost to manufacture an item. It is the sum of the item’s 
Component Costs per Assembly and Costs Added at This Level.

Where Used: Cost Estimate by Lot Size
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Unit Cost
Unit Cost is the cost per unit of an item. Entry is numbers only up to 16 characters. Decimal 
places are allowed.

Where Used: CINV; Cost Estimate by Lot Size; CPMT; Custom Product Component Detail; 
CWIP; ITBI; ITCB; ITHC

Unit Cost
Unit Cost is the sum of the Item Related and Order Related costs per unit of an item.

Where Used: Cost Estimate by Lot Size

Variable Overhead
Variable Overhead represents the total variable overhead cost to manufacture an item. It is 
the sum of the variable overhead costs of the item’s components and the Variable Overhead 
of the item itself. Displays are based on the specified Cost Type.

Where Used: Cost Estimate by Lot Size
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DISP – Dispatch List
Dispatch List allows you to review the orders comprising a workcenter's load, based on a user-specified 
start date, with optional inclusion of MRP planned order requirements. The Dispatch List can be used as 
an expediting tool, since the orders are sequenced by operation due date. The Dispatch List displays unit 
completions at the prior workcenter, setup status, and the remaining units and run-time hours to complete 
each order. Overload problems in each period are highlighted for your review. You can also review period 
load information only, if desired.

Dispatch List Display
Dispatch List shows workcenter operations, with information about the related order and routing, and 
progress against the routing. The displayed information varies slightly based on the selected parameters. 

• Each line identifies an order's operation at the specified workcenter, where operations are 
sequenced by operation due date.

- For firm, open and released orders, the workcenter operation is a component on the 
order-dependent routing attached to an order. The order is identified in the Order No 
and Ln# fields. The order-dependent routing can be modified using the PICK screen.

- For planned orders, the operation is a component on the routing for the parent item.

• Order-related information includes the following:

- For firm, open and released orders, the order is identified in the Order No and Ln# 
fields.

- For planned orders, the Order No field displays Planned Requirement or Product 
Forecast and nothing is displayed in the Ln# fields.

• The Run Load field indicates remaining run time, and the PD (past due) field displays an 
asterisk when the operation date is past-due, relative to the current system date.

Reports

Dispatch List Reports
To generate the report, choose Print Preview from the File menu.

Report Description
Lists all manufacturing orders comprising a workcenter's load.

Access Method
To generate the report, choose Print Preview from the File menu. 

Report Title

Dispatch List
Lists all manufacturing orders comprising a workcenter’s load.

Dispatch List -- Period Load Only
Lists all manufacturing orders comprising a workcenter’s load for the period only.
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Report Template
For more information on report templates, see "Reporting for SQL Server Systems" in the System 
Help topics.

Available From
Dispatch List

Dispatch List Reports – Period Load Only
Report Description
Lists all manufacturing orders comprising a workcenter's load for the period only.

Access Method
To generate the report, choose Print Preview from the File menu. 

Report Template
For more information on report templates, see "Reporting for SQL Server Systems" in the System 
Help topics.

Available From
Dispatch List

Fields
Avail Qty

Available Quantity of Units indicates the number of units completed at the Prior 
Workcenter available for processing at the specified workcenter operation.

Where Used: Capacity Planning; Dispatch List; Location Index; Schedule Board

Balance Due
Balance Due indicates the number of units which require processing at the specified 
workcenter operation. Initially based on the Order Quantity for the parent item (and the 
quantity-per for the workcenter completions resource item), the Balance Due is decremented 
after reporting units completed.

Where Used: Dispatch List

Capacity
Capacity is the total number of hours available per period for performing work. Capacity is 
used with Item Type = R (resource) items and is typically specified as a daily rate for a 
workcenter using the Item Class #7 field on the Item Master Detail screen. Entry is up to 
9999999999.

Where Used: Capacity Planning; Dispatch List; MPSR; MPSS; Workcenter Master
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Description
Item Description identifies the item in terms of its characteristics. When space is limited, a 
partial description is displayed. Entry is any alphanumeric combination of up to 70 characters.

Where Used: A/P Received Item List; ABCR; Advance Ship Notice Line; APPI; APPV; 
Available Pricing; AVII; AVIT; BILI; BILL; Bill of Material; Bill of Material Detail; Browse Setup 
(item); Capacity Planning; CCAN; CCAT; CMLB; COBK; COCP; COMP; Comparison Bill; 
Comparison of Summarized Bills; Contract Item Detail; Contract Item Detail/Pricing; CORV; 
Cost Estimate by Lot Size; Costed Bill Detail; CSLB; Custom Product Component Detail; 
Customer Item + General; Customer Order; Customer Order Receipt/Reverse; CWIP; 
Demand Peg Detail; Dispatch List; Engineering; FCST; ICCR; IHIR; INVA; Inventory 
Allocation; Inventory History List; Inventory Transaction History Report; INVR; IORD; IPPD; 
ISVI; ITBI; ITCB; ITCI; Item + Alternates; Item + Quantity; Item Availability; Item Availability + 
Quantity; Item Browse; Item Browse Detail; Item History; Item Lot Trace and Serialization 
Detail; Item Master; Item Master Detail; Item Master Planning Detail; Item Responsibility 
Assigned Results; ITMB; ITMC; ITMI; ITPB; ITPI; Job Estimates and Performance Report; 
Lead Time; Lead Time Analysis; Lead Times Assigned Results; LEXP; Line Item Details + 
Item; LMSI; LMST; Location Index; Lot Detail; Lot Inventory Transaction History Report; Lot 
Trace; Lot Trace Issue Detail; Lot Trace Receipt Detail; LOTR; LVAL; Manufacturing Order 
Line Item Detail; Manufacturing Order Receipt/Reverse; Material Exposure; MBIL; MCST; 
MOMI; MOMT; MORI; MORV; MPSR; MPSS; MSMT; Multi-Level Bill; Multi-Level Costed Bill; 
Multi-Level Where Used; MUSE; Open Order Detail; OPSL; Order Completion Status; Order 
Cost Variance Status; Order Detail; Order Line Items; OVAR; Package Content; Packaging 
Detail; Partner Item Detail; PBCI; PBCT; PBII; PICI; PICK; Picklist Detail; POAN; POAS; 
POCI; POCR; POCT; POMI; POMT; PORI; PORR; PORV; POYE; Production; Purchase 
Order Line Item Detail; Purchase Order Line Item Detail (CPMT); Purchase Order Line Items; 
Purchase Order Receipt History; Purchased Component Detail; QSRC; QUOI; QUOT; Router/
Traveler; SDAB; SDAL; Shipment Allocation Detail; Shipments by Line Item; Shipping Detail; 
Shortages by Order; SHPL; Single-Level Configuration Bill of Material Report; SSII; SSIL; 
Standard Costs Assigned Results; Standard Product Detail; Summarized Bill; Supply Peg 
Detail; Transaction Detail; VDII; VDIT; VDSC; VITI; Where Used; WIPR; WUSE

Include MRP Planned Requirements
Include MRP Planned Requirements indicates whether planned orders (Ln# Sta = 1) should 
be included in the display. Options are:

Yes = Include planned orders.
No = Do not include planned orders.

Where Used: Dispatch List; Schedule Board

Ln#
Line Number is the identification of a line item on an order. The Line Number is system-
assigned. Entry is up to 3 numbers.

Where Used: A/P Invoice Matching Detail; A/P PO/Inv Variance by Invoice; A/P Receiving 
Detail; Advance Ship Notice Line; Advance Ship Notice Order Detail; APEX; APID; APPI; 
APPV; APUV; Available for Shipping Allocation Batch; Backflush Issue Reconciliation Report; 
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Bill of Material Accuracy Results; Capacity Planning; CCAN; CINV; COAN; COCD; COCP; 
COMI; COMT; CORV; CPMT; CSTU; Custom Product Component Detail; Custom Product 
Detail; Customer Order; Customer Order + Order Header; Customer Order Line Price 
Adjustment; Customer Order Receipt/Reverse; CWIP; Demand Peg Detail; Dispatch List; 
GASN; IHIR; IMTR; Inventory Transaction History Report; IORD; Item Shortages; JEST; Job 
Estimates and Performance Report; LHIS; LMSI; LMST; Location Index; Lot Detail; Lot 
Inventory Transaction History Report; Lot Trace Issue Detail; Lot Trace Receipt Detail; LOTR; 
LRRP; Manufacturing Order Line Item Detail; Manufacturing Order Receipt/Reverse; Material 
Shortages Detail; MCST; MOAN; MOFR; MOMI; MOMT; MORI; MORV; MSMT; Open Order 
Detail; OPSL; Order Completion Status; Order Cost Variance Status; Order Detail; Order Line 
Items; OVAR; Package Content; Packaging Detail; Packing List; PCMT; PCST; PICI; PICK; 
Picklist Detail; POAN; POAS; POMI; POMT; PORI; PORR; PORV; POSR; POVD; Pricing 
Maintenance + Test Order; Purchase Order Line Item Detail; Purchase Order Line Item Detail 
(CPMT); Purchase Order Line Items; Purchased Component Detail; Router/Traveler; 
Schedule Board; SDAB; Serial Number List; SHIP; Shipment Allocation Detail; Shipment 
Allocation List; Shipments by Line Item; Shipping Allocation Batch; Shortages by Order; 
SHPL; STAD; Standard Product Detail; Supply Peg Detail; Transaction Detail; TRUD; VDSC; 
VPFR; WIPL; WIPR; WIPS

Ln# Sta
Line Number Status indicates the item's current position within the order process. Line 
Number Statuses are:

blank = Order Point Quantity Level Reached. 
PREV and MRP have determined that the order point quantity of the item has been 
reached.

1 = MRP Planned Order. 
MRP has automatically planned an order for the item.

2 = Firm Planned. 
The item's order quantity and scheduled date are fixed and are not automatically 
changed.

3 = Open. 
The item's order quantity and scheduled date are fixed. The order-dependent bill of 
material is attached to the item.

4 = Released. 
The item's order quantity and scheduled date are fixed. The order-dependent bill of 
material is attached to the item. The order and picklist can be printed and receipts/
issues can be made.

5 = Closed. 
All required receipts or issues have been made for the item.

6 = Closed. 
The order closure report has reported this order closure.

7 = Closed. 
The order is ready to be deleted from the active file and retained in order history.

Line Number Status can in most cases only be incremented. You can reopen an order, which 
decrements the Line Number Status from 5 to 4. For purchase orders, Line Number Status 
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= 4 can be changed to 3 if no receipts were completed for that line item and the line is not Ln# 
Typ = S.

Where Used: Capacity Planning; CCAN; Demand Peg Detail; Dispatch List; IHIR; Item 
Shortages; Location Index; Manufacturing Order Line Item Detail; Manufacturing Order 
Receipt/Reverse; Material Shortages Detail; MCST; MOAN; MOMI; MOMT; MORI; MORV; 
MSMT; Open Order Detail; Order Completion Status; Order Cost Variance Status; Order Line 
Items; PCST; PICI; PICK; Picklist Detail; POAN; POAS; POMI; POMT; PORI; PORR; PORV; 
Purchase Order Line Item Detail; Purchase Order Line Item Detail (CPMT); Purchase Order 
Line Items; Purchased Component Detail; Router/Traveler; Schedule Board; Shortages by 
Order; Supply Peg Detail; Transaction Detail; WIPL; WIPR; WIPS

Ln# Typ
Line Number Type determines the use of the item order quantity in planning, manufacturing 
and accounting. Line Number Types available depend on the screen where the transaction is 
completed; these include:

B = By-product. 
Created as part of another order.

M = Manufacturing. 
Dependent demands are automatically created.

R = Rework. 
Dependent demands are not automatically created but are manually added.

U = Tool Return. 
Created as part of another order.

X = Custom Product. 
Make-to-order and engineer-to-order products.

Where Used: Capacity Planning; CCAN; Demand Peg Detail; Dispatch List; IHIR; Item 
Shortages; Location Index; Manufacturing Order Line Item Detail; Manufacturing Order 
Receipt/Reverse; Material Shortages Detail; MCST; MOAN; MOMI; MOMT; MORI; MORV; 
Order Completion Status; Order Cost Variance Status; Order Line Items; OVAR; PICI; PICK; 
Picklist Detail; Router/Traveler; Schedule Board; Shortages by Order; Supply Peg Detail; 
WIPL; WIPR; WIPS

Load
Load is the aggregate number of hours of work per period, typically calculated for a 
workcenter based on the time required to perform workcenter operations with due dates within 
the period.

Where Used: Capacity Planning; Dispatch List
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Oper Date
Operation Due Date is system-calculated for planned orders based on the order start date 
plus the component's lead time offset, where the order start date is based on the order due 
date minus the parent's lead time. After creating an order-dependent routing (e.g., for opened 
or released orders), the Operation Due Date can be modified on the Picklist Detail screen. 
For custom products, the Operation Due Date can also be modified on the CPMT screen.

Where Used: Capacity Planning; Dispatch List; Location Index; Schedule Board

Order No
Order Number is the user-defined identifier for a purchase, manufacturing or customer order. 
Entry is any alphanumeric combination of up to 30 characters.

Where Used: APEX; Backflush Issue Reconciliation Report; Bill of Material Accuracy 
Results; Browse Setup (order); Capacity Planning; CINV; COCP; Dispatch List; EDIX; IHIR; 
IMTR; Inventory Transaction History Report; IORD; Item Shortages; LMSI; LMST; Location 
Index; Lot Detail; Lot Inventory Transaction History Report; Lot Trace Issue Detail; Lot Trace 
Receipt Detail; LOTR; LRRP; MSMT; Order Browse; Order Completion Status; Order Cost 
Variance Status; ORST; OVAR; Router/Traveler; Schedule Board; SDAB; SHIP; Shipment 
Allocation List; Shortages by Order; STAD; TRUD; VDSC

Order Qty
Order Quantity refers to the number of parent items ordered. In the case of dispatch lists 
showing firm, open and released orders, the Order Quantity can refer to the unit completions 
for the workcenter operation if a WC[C] resource item is specified on the order-dependent 
routing. If a WC[C] resource item is not specified, the Order Quantity on the dispatch list 
refers to the number of parent items ordered.

Where Used: Dispatch List; Order Completion Status; Order Cost Variance Status; Router/
Traveler; Shortages by Order

Overload
Overload indicates the difference in hours between Capacity and Load within a selected 
period size, and highlights a potential problem area.

Where Used: Dispatch List

Parent
Parent is a term that describes the structural relationship between an item and its components 
in a bill of material. A Parent item is the higher level item in the parent-component relationship. 
A parent cannot be used in itself. Entry is any alphanumeric combination of up to 30 
characters.
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Where Used: BILI; BILL; Bill of Material; Bill of Material Detail; CMLB; Comparison Bill; 
Comparison of Summarized Bills; Cost Estimate by Lot Size; CSLB; Dispatch List; 
Engineering; Lead Time; Lead Time Analysis; Location Index; Material Exposure; MBIL; Multi-
Level Bill; Multi-Level Costed Bill; Multi-Level Where Used; MUSE; Production; Summarized 
Bill; Where Used; WUSE

PD
Past Due uses an asterisk to indicate if the order is past due based upon the operation date. 
On the Dispatch List report, a past due record is marked with an asterisk after the Run Load 
field.

Where Used: Dispatch List

Period
Period Increment identifies the increment in which the information is to be displayed. Period 
Increments are:

Daily = Increments on a daily basis.
Weekly = Increments on a weekly basis.
Monthly = Increments on a monthly basis.

Where Used: Capacity Planning; Dispatch List

Period Load Only
Period Load Only can be selected to indicate that only the period load information should be 
included in the dispatch list. Default is that all loads are included in the dispatch list.

Where Used: Dispatch List

Prior Workcenter
Prior Workcenter indicates the item’s preceding workcenter, based on the operation 
sequence number.

Where Used: Dispatch List

Pt Use
Point of Use is a key field that, along with the Seqn field, defines the sort sequence of 
components in a bill of material. The Point of Use field accepts any information you choose to 
enter, but the intended use is to identify the "work center" where the component should be 
delivered when assembling the parent, the "find number" of the component referenced on the 
drawing for the parent, or the "component reference designator" of the component on a printed 
circuit board. If the Point of Use field is not applicable in your company, you may enter 0 
(zero). Entry is any alphanumeric combination of up to 5 characters.
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Where Used: BILI; BILL; Bill of Material; Bill of Material Detail; Capacity Planning; 
Comparison Bill; Custom Product Component Detail; Demand Peg Detail; Dispatch List; 
Engineering; Exceptions; Job Estimates and Performance Report; Lead Time; Location Index; 
LRRP; Material Shortages Detail; MBIL; Multi-Level Bill; Multi-Level Where Used; MUSE; 
Order Cost Variance Status; OVAR; PICI; PICK; Picklist Detail; Pricing Maintenance + Test 
Order; Production; Purchase Order Line Item Detail; Purchase Order Line Item Detail (CPMT); 
Router/Traveler; Schedule Board; Single-Level Configuration Bill of Material Report; TRUD; 
Where Used; WUSE

Run Load
Run Load indicates the remaining run time to complete the workcenter operation, and is the 
Bal Due times the per-unit run-time hours on the routing.

Where Used: Capacity Planning; Dispatch List; Location Index; Router/Traveler; Schedule 
Board

Seqn
Sequence Number is a key field that, along with the Pt Use field, defines the sort sequence of 
components in a bill of material. The field accepts any information you choose to enter, but the 
intended purpose is to identify the operation sequence number on the parent’s routing that 
calls out the component. If the Sequence Number is not applicable in your company, you may 
enter 0 (zero). Entry is up to 3 numbers.

Where Used: Backflush Issue Reconciliation Report; BILI; BILL; Bill of Material; Bill of 
Material Detail; Capacity Planning; CINV; COCP; Comparison Bill; CPMT; Custom Product 
Component Detail; CWIP; Demand Peg Detail; Dispatch List; Engineering; Exceptions; Job 
Estimates and Performance Report; Lead Time; Location Index; LRRP; Material Shortages 
Detail; MBIL; MCST; Multi-Level Bill; Multi-Level Where Used; MUSE; OPSL; Order Cost 
Variance Status; OVAR; PCST; PICI; PICK; Picklist Detail; PORI; PORV; Production; 
Purchase Order Line Item Detail; Purchase Order Line Item Detail (CPMT); Purchased 
Component Detail; Router/Traveler; Schedule Board; Single-Level Configuration Bill of 
Material Report; TRUD; Where Used; WIPL; WIPR; WUSE

Set Up
Setup Status indicates whether any time has been reported against the workcenter setup 
operation. The Setup Status options are:

Yes = Time has already been reported against the setup operation.
blank = No workcenter setup item WC[S] exists for this operation.

Where Used: Capacity Planning; Dispatch List; Location Index; Schedule Board; 
Workcenter Master

Start Date
Starting Date is used to request the date to begin the display. Starting Date defaults to the 
system date and must be a valid shop day.
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Where Used: Dispatch List; MPSS

Total Past Due
Total Past Due is the total of all past due records and is listed at the beginning of the first 
current Period Load line. Based on the specified Period length (weekly or monthly), some of 
the past due records may be listed after the Total Past Due line because the records are 
outside of the current Period Load. For example, if the system date is 3/10/2003, records with 
a date before 3/10/2003 are considered past due. If the specified period length is weekly, 
records may exist within the "weekly" bucket and are therefore not considered past due.

Where Used: Dispatch List

Workcenter
Workcenter is the identifier for a specific production facility, consisting of one or more people 
and/or machines, which can be considered as one unit for the purposes of capacity planning, 
scheduling and costing. If the SFRM Module is installed, workcenters are defined on the 
Workcenter Master. If the SFRM Module is not installed, workcenters are established on the 
Item Master as resource items. The workcenter's run, setup and completion records define 
how the workcenter should be used when constructing the bills of material.

When the workcenter is displayed on the Item Master, a five-character prefix is added to the 
workcenter name. Prefixes include:

WC[R] = Run-time hours for workcenter operations
WC[S] = Setup hours for the workcenter operations
WC[C] = Unit completions for run-time operations at the workcenter

Workcenter entry is any alphanumeric combination of up to 10 characters.

Where Used: Capacity Planning; Dispatch List; Location Index; Router/Traveler; Schedule 
Board; Workcenter Master
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ITSH – Item Shortages
Item Shortages identifies items associated with released orders where the Required Quantity is less than 
the Order Quantity (shortages). You can view make, buy or all (make and buy) items, and specify a starting 
item number to view a partial listing. For each item, the quantity short and the total quantity required and 
allocated, as well as stock status and on-order information is listed. Item Shortages can also be used as an 
expediting tool after entering a receipt transaction.

You can view released orders requiring a specified component item by selecting Show Order Detail. Order 
detail includes the quantity required, short quantity and required date for each order. Use this information 
to prioritize use of available inventory, especially when the system notifies you during a receipt transaction 
that a component is needed in production immediately.

Reports

Item Shortages Reports
To generate the report, choose Print Preview from the File menu.

Report Description
Lists all items having shortages.

Access Method
To generate the report, choose Print Preview from the File menu. 

Report Template
For more information on report templates, see "Reporting for SQL Server Systems" in the System 
Help topics.

Available From
Item Shortages

Item Shortages – With Order Detail
Report Description
Lists all items having shortages and includes order detail.

Access Method
To generate the report, choose Print Preview from the File menu. 

Report Template
For more information on report templates, see "Reporting for SQL Server Systems" in the System 
Help topics.

Available From
Item Shortages

Report Title

Item Shortages
Lists all items having shortages.

Item Shortages -- With Order Detail
Lists all items having shortages and includes order detail.
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Fields
Include Make/Buy Items

Include Make/Buy Items field indicates what type of items should be included in the display. 
Options include:

Make items = Includes Make items
Buy items = Includes Buy items (including subcontracted items)
All items = Includes both make and buy items

Where Used: Item Shortages

Item
Item is the unique identifier for a part, whether it be a piece part, tool, raw material, an 
assembly or finished product. All items are set up using the ITMB screen. Within a product 
structure, an item can be a component as well as a parent. Entry is any alphanumeric 
combination of up to 30 characters.

Where Used: A/P Received Item List; ABCR; Advance Ship Notice Line; Allowance/Charge 
Detail (Detail); APPI; APPV; AUDT; Available for Shipping Allocation Batch; AVII; AVIT; Bill of 
Material Accuracy Results; Browse Setup (item); Capacity Planning; CBIL; CCAN; CCAT; 
CIMT; CINV; COAN; COBK; COCD; COMI; COMP; Comparison Bill; Comparison of 
Summarized Bills; COMT; Contract Item Detail; Contract Item Detail/Pricing; Contract 
Summary; CORV; CSTU; Cumulative Detail; Customer Item + General; Customer Order; 
Customer Order Line Price Adjustment; Customer Order Receipt/Reverse; CWIP; Demand 
Peg Detail; Engineering; FCST; GASN; ICCR; IHIR; IMTR; INVA; Inventory Adjustment 
Application; Inventory Allocation; Inventory History List; Inventory Transaction History Report; 
INVR; IORD; IPPD; ISVI; ITBI; ITCB; ITCI; Item + Quantity; Item Availability; Item Availability + 
Quantity; Item Browse; Item Browse Detail; Item History; Item Lot Receipt; Item Lot Trace and 
Serialization Detail; Item Master; Item Master Detail; Item Master Planning Detail; Item 
Responsibility Assigned Results; Item Shortages; ITHC; ITHR; ITMB; ITMC; ITMI; ITPB; ITPI; 
Lead Times Assigned Results; LEXP; LHIS; Line Item Details + Item; LMSI; LMST; Lot Detail; 
Lot Inventory Transaction History Report; Lot Selection; Lot Trace; Lot Trace Issue Detail; Lot 
Trace Receipt Detail; LOTR; LVAL; Manufacturing Order Line Item Detail; Manufacturing 
Order Receipt/Reverse; Material Shortages Detail; MCST; MOAN; MOFR; MOMI; MOMT; 
MORI; MORV; MPIT; MPSR; MPSS; MSMT; Multi-Level Bill; Multi-Level Costed Bill; Multi-
Level Where Used; MUSE; Open Order Detail; Order Completion Status; Order Cost Variance 
Status; Order Detail; OVAR; Package Content; Packaging Detail; Packing List; Partner Item 
Detail; PBCI; PBCT; PBII; PICI; PICK; Picklist Detail; POCI; POCR; POCT; PORI; PORV; 
POYE; Pricing Maintenance + Action Detail; Pricing Maintenance + Action List; Pricing 
Maintenance + Items/Customers; Pricing Maintenance + Test Order; Production; Purchase 
Order Receipt History; Purchased Component Detail; QSRC; QUOI; QUOT; Router/Traveler; 
Schedule Board; SDAB; SDAL; Selection Setup; Serial Number List; Serial Numbers Shipped; 
SHIP; Shipment Allocation Detail; Shipment Allocation List; Shipments by Line Item; Shipping 
Allocation Batch; Shortages by Order; SHPL; SSII; SSIL; Standard Costs Assigned Results; 
Standard Product Detail; Summarized Bill; Supply Peg Detail; Transaction Detail; VDII; VDIT; 
VDSC; VEIT; Vendor/Item Detail; VETI; VITI; VPFR; WIPL; WIPR; WIPS; WUSE
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Ln#
Line Number is the identification of a line item on an order. The Line Number is system-
assigned. Entry is up to 3 numbers.

Where Used: A/P Invoice Matching Detail; A/P PO/Inv Variance by Invoice; A/P Receiving 
Detail; Advance Ship Notice Line; Advance Ship Notice Order Detail; APEX; APID; APPI; 
APPV; APUV; Available for Shipping Allocation Batch; Backflush Issue Reconciliation Report; 
Bill of Material Accuracy Results; Capacity Planning; CCAN; CINV; COAN; COCD; COCP; 
COMI; COMT; CORV; CPMT; CSTU; Custom Product Component Detail; Custom Product 
Detail; Customer Order; Customer Order + Order Header; Customer Order Line Price 
Adjustment; Customer Order Receipt/Reverse; CWIP; Demand Peg Detail; Dispatch List; 
GASN; IHIR; IMTR; Inventory Transaction History Report; IORD; Item Shortages; JEST; Job 
Estimates and Performance Report; LHIS; LMSI; LMST; Location Index; Lot Detail; Lot 
Inventory Transaction History Report; Lot Trace Issue Detail; Lot Trace Receipt Detail; LOTR; 
LRRP; Manufacturing Order Line Item Detail; Manufacturing Order Receipt/Reverse; Material 
Shortages Detail; MCST; MOAN; MOFR; MOMI; MOMT; MORI; MORV; MSMT; Open Order 
Detail; OPSL; Order Completion Status; Order Cost Variance Status; Order Detail; Order Line 
Items; OVAR; Package Content; Packaging Detail; Packing List; PCMT; PCST; PICI; PICK; 
Picklist Detail; POAN; POAS; POMI; POMT; PORI; PORR; PORV; POSR; POVD; Pricing 
Maintenance + Test Order; Purchase Order Line Item Detail; Purchase Order Line Item Detail 
(CPMT); Purchase Order Line Items; Purchased Component Detail; Router/Traveler; 
Schedule Board; SDAB; Serial Number List; SHIP; Shipment Allocation Detail; Shipment 
Allocation List; Shipments by Line Item; Shipping Allocation Batch; Shortages by Order; 
SHPL; STAD; Standard Product Detail; Supply Peg Detail; Transaction Detail; TRUD; VDSC; 
VPFR; WIPL; WIPR; WIPS

Ln# Sta
Line Number Status indicates the item's current position within the order process. Line 
Number Statuses are:

blank = Order Point Quantity Level Reached. 
PREV and MRP have determined that the order point quantity of the item has been 
reached.

1 = MRP Planned Order. 
MRP has automatically planned an order for the item.

2 = Firm Planned. 
The item's order quantity and scheduled date are fixed and are not automatically 
changed.

3 = Open. 
The item's order quantity and scheduled date are fixed. The order-dependent bill of 
material is attached to the item.

4 = Released. 
The item's order quantity and scheduled date are fixed. The order-dependent bill of 
material is attached to the item. The order and picklist can be printed and receipts/
issues can be made.

5 = Closed. 
All required receipts or issues have been made for the item.
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6 = Closed. 
The order closure report has reported this order closure.

7 = Closed. 
The order is ready to be deleted from the active file and retained in order history.

Line Number Status can in most cases only be incremented. You can reopen an order, which 
decrements the Line Number Status from 5 to 4. For purchase orders, Line Number Status 
= 4 can be changed to 3 if no receipts were completed for that line item and the line is not Ln# 
Typ = S.

Where Used: Capacity Planning; CCAN; Demand Peg Detail; Dispatch List; IHIR; Item 
Shortages; Location Index; Manufacturing Order Line Item Detail; Manufacturing Order 
Receipt/Reverse; Material Shortages Detail; MCST; MOAN; MOMI; MOMT; MORI; MORV; 
MSMT; Open Order Detail; Order Completion Status; Order Cost Variance Status; Order Line 
Items; PCST; PICI; PICK; Picklist Detail; POAN; POAS; POMI; POMT; PORI; PORR; PORV; 
Purchase Order Line Item Detail; Purchase Order Line Item Detail (CPMT); Purchase Order 
Line Items; Purchased Component Detail; Router/Traveler; Schedule Board; Shortages by 
Order; Supply Peg Detail; Transaction Detail; WIPL; WIPR; WIPS

Ln# Typ
Line Number Type determines the use of the item order quantity in planning, manufacturing 
and accounting. Line Number Types available depend on the screen where the transaction is 
completed; these include:

B = By-product. 
Created as part of another order.

M = Manufacturing. 
Dependent demands are automatically created.

R = Rework. 
Dependent demands are not automatically created but are manually added.

U = Tool Return. 
Created as part of another order.

X = Custom Product. 
Make-to-order and engineer-to-order products.

Where Used: Capacity Planning; CCAN; Demand Peg Detail; Dispatch List; IHIR; Item 
Shortages; Location Index; Manufacturing Order Line Item Detail; Manufacturing Order 
Receipt/Reverse; Material Shortages Detail; MCST; MOAN; MOMI; MOMT; MORI; MORV; 
Order Completion Status; Order Cost Variance Status; Order Line Items; OVAR; PICI; PICK; 
Picklist Detail; Router/Traveler; Schedule Board; Shortages by Order; Supply Peg Detail; 
WIPL; WIPR; WIPS

MB
Make-Buy Code indicates if a part is normally purchased or manufactured. Make-Buy Code 
also directs appropriate action messages to the Buyr (B or S) or Plnr (M). Make-Buy Codes 
are:
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M = Make. 
Manufactured in-house.

B = Buy. 
Purchased; no parts supplied to vendor.

S = Supplied. 
Purchased; parts supplied to vendor.

Where Used: ABCR; AVII; AVIT; BILI; BILL; Bill of Material; Bill of Material Detail; COMP; 
Costed Bill Detail; CSLB; Demand Peg Detail; Engineering; FCST; IHIR; IORD; IPPD; Item 
Availability; Item Browse Detail; Item History; Item Lot Trace and Serialization Detail; Item 
Master; Item Master Detail; Item Master Planning Detail; Item Responsibility Assigned 
Results; Item Shortages; ITHC; ITHR; ITMB; ITMI; Lead Time Analysis; Lead Times Assigned 
Results; Lot Size Multiple Detail; Lot Trace; LSDA; LVAL; Material Exposure; Material 
Shortages Detail; MBIL; MPSR; MPSS; MSMT; Multi-Level Bill; PBCI; PBCT; Production; 
QUOI; QUOT; SDAB; SDAL; Shortages by Order; Single-Level Configuration Bill of Material 
Report; SSII; Standard Costs Assigned Results; Summarized Bill; Supply Peg Detail

Order No
Order Number is the user-defined identifier for a purchase, manufacturing or customer order. 
Entry is any alphanumeric combination of up to 30 characters.

Where Used: APEX; Backflush Issue Reconciliation Report; Bill of Material Accuracy 
Results; Browse Setup (order); Capacity Planning; CINV; COCP; Dispatch List; EDIX; IHIR; 
IMTR; Inventory Transaction History Report; IORD; Item Shortages; LMSI; LMST; Location 
Index; Lot Detail; Lot Inventory Transaction History Report; Lot Trace Issue Detail; Lot Trace 
Receipt Detail; LOTR; LRRP; MSMT; Order Browse; Order Completion Status; Order Cost 
Variance Status; ORST; OVAR; Router/Traveler; Schedule Board; SDAB; SHIP; Shipment 
Allocation List; Shortages by Order; STAD; TRUD; VDSC

Qty Alloc
Allocations is the number and value of units committed to open and released purchase and 
manufacturing orders (Ln# Sta = 3 or 4) and released customer orders (Ln# Sta = 4).

Where Used: Item Availability; Item Shortages; ITHR; Location Index; Production; 
Shortages by Order; SSII

Qty In Insp
In Inspection indicates the number of units undergoing inspection.

Where Used: Item + Quantity; Item Availability + Quantity; Item Shortages
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Qty In WIP
Internal Work in Process Quantity is the number of units issued to manufacturing orders 
which are still in internal WIP or custom product WIP. Internal Work in Process Quantity is 
decreased by the receipt of the completed work order for the parent assembly into the 
stockroom. When the work order is closed, any overissues are subtracted from Internal Work 
in Process Quantity and underissues are added to Internal Work in Process Quantity.

Where Used: Item + Quantity; Item Availability; Item Availability + Quantity; Item Shortages; 
ITHR; MPSR; MPSS; Production; Shortages by Order; SSII

Qty On Hand
On Hand Quantity is the amount of inventory available for issue. Entry is up to 10 numbers.

Where Used: CINV; Custom Product Detail; Inventory Status; INVR; Item + Quantity; Item 
Availability; Item Availability + Quantity; Item Shortages; LEXP; Line Item Details + Custom 
Product; LMSI; LMST; Location Index; Lot Detail; MPSR; MPSS; Production; Shortages by 
Order; SSII

Qty On Order
On Order Quantity is the total number of items on open or released manufacturing and 
purchase orders (Ln# Sta = 3 or 4).

Where Used: Inventory Status; Item + Quantity; Item Availability; Item Availability + 
Quantity; Item Shortages; Location Index; Material Shortages Detail; Production; Shortages by 
Order; SSII; Summarized Bill

Qty Short
Short Quantity is the difference between the Quantity Required and Quantity Issued for a 
component on a released order.

Where Used: Item Shortages; Shortages by Order

Reqd Date
Required Date is the date the component item is needed for the assembly of the line item, 
taking lead time offset into consideration.

Where Used: Item Shortages; Material Shortages Detail; OPSL; Picklist Detail; Pricing 
Maintenance + Test Order; Router/Traveler; Shortages by Order

Reqd Qty
Required Quantity is the number of component items required for the parent item. Entry is up 
to 10 numbers. Decimal places are allowed.
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Where Used: Capacity Planning; Custom Product Component Detail; Item Shortages; 
Location Index; Material Shortages Detail; Picklist Detail; Purchase Order Line Item Detail 
(CPMT); Router/Traveler; Schedule Board; Shortages by Order

Reqd Qty
Total Required Quantity is the sum of all requirements for an item, looking into the future as 
far as allowed by the shop calendar.

Where Used: Item Shortages

Show Order Detail
Show Order Detail can be selected to indicate that the released manufacturing order detail 
should be included in the item shortages list. Default is that the order detail is not shown.

Where Used: Item Shortages

Starting Item
The Starting field is used to request a list where the specified information appears first on the 
list. Starting entries may consist of a partial entry and if the entry is not in the list, the next 
highest entry appears first on the list. The Starting field can include one or more field 
combinations, each with its own entry requirements.

Where Used: A/P 1099 Distribution; A/P Payment Application Detail; A/P Payment Void 
Detail; A/P Received Item List; A/P Receiving Detail; A/R Payment Application Detail; APAH; 
APDS; APEX; APID; APIE; APII; APIR; APIV; APPA; APPD; APPI; APPO; APTX; ARAH; 
ARCD; AREX; ARIC; ARIH; ARPD; ARPH; ARSR; BAMT; Bank Payment Approval; BILI; 
BILL; BKMT; Browse Setup (customer); Browse Setup (item); Browse Setup (vendor); CACF; 
CCAN; CCAT; CCEX; CCMT; CIMT; CMCF; CMTA; CMTI; CNFA; COAN; COMI; COMT; 
Contract Item Detail/Pricing; CORV; CPMT; CUID; CUII; CUSI; CUST; FCMT; FCST; G/L 
Account Group/No List; G/L Account No List; G/L Batch Detail; G/L Journal Entry List; G/L 
Master Account Recap; G/L Org No List; G/L Org/Acct Group List; G/L Organization Group/No 
List; G/L Report List; G/L Source Code List; GLAG; GLAV; GLBD; GLCA; GLCI; GLDQ; 
GLEX; GLGQ; GLJD; GLJE; GLJI; GLJP; GLJR; GLMA; Global Extended Text Selection; 
GLOS; GLRD; GLRL; GLSC; GLSI; GLSS; ITBI; ITCB; Item Master; Item Shortages; ITMB; 
ITMI; ITPB; ITPI; IVCO; IVIA; IVIE; IVII; IVRV; LMMT; Location Selection Setup; MCST; 
MOAN; MOMI; MOMT; MORI; MORV; MPED; MPIT; MSMT; NMTA; OPSL; Orders on 
Shipment; ORST; Packaging Detail; PASS; PBCI; PBCT; PBMI; PBMT; PCMT; PCST; PICI; 
PICK; POAN; POAS; POCI; POCT; POMI; POMT; PORI; PORV; REDI; RTMT; RVED; SBOL; 
Selection Setup; Serial Number List; Serial Numbers Shipped; SHIP; Shipments by Line Item; 
SHPI; SSII; STAD; SUND; SUNR; SUPD; SUPR; TEXT; TXTA; VAT Summary (APSM 
Module); VATT; VEDI; VEID; VEND; VENI; Workcenter Master

UM
Unit of Measure identifies the standard unit for an item used in the manufacturing process. 
Entry is up to 4 alphanumeric characters.
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Where Used: A/P PO/Inv Variance by Invoice; A/P Receiving Detail; APEX; APPI; APPV; 
APUV; Available for Shipping Allocation Batch; AVII; AVIT; BILI; BILL; Bill of Material; Bill of 
Material Detail; CCAT; CINV; CMLB; COBK; COCP; COMI; COMT; Contract Header Detail; 
Contract Item Detail; Contract Item Detail/Pricing; CORV; Costed Bill Detail; CPMT; CSLB; 
Custom Product Component Detail; Custom Product Detail; Customer Order; Customer Order 
Line Price Adjustment; Customer Order Receipt/Reverse; CWIP; Demand Peg Detail; 
Engineering; FCST; ICCR; IHIR; INVA; Inventory Allocation; INVR; IORD; IPPD; ITBI; ITCB; 
ITCI; Item + Quantity; Item Availability + Quantity; Item Browse Detail; Item History; Item Lot 
Receipt; Item Lot Trace and Serialization Detail; Item Master; Item Master Detail; Item Master 
Planning Detail; Item Responsibility Assigned Results; Item Shortages; ITHC; ITHR; ITMB; 
ITMC; ITMI; ITPB; ITPI; IVPR; IVRR; JEST; Job Estimates and Performance Report; Lead 
Times Assigned Results; LEXP; LHIS; Line Item Details + Item; LMSI; LMST; Location Index; 
Lot Detail; Lot Trace; Lot Trace Issue Detail; Lot Trace Receipt Detail; LOTR; LVAL; 
Manufacturing Order Line Item Detail; Manufacturing Order Receipt/Reverse; Material 
Exposure; MBIL; MCST; MOMI; MOMT; MORI; MORV; MPIT; MPSR; MPSS; MSMT; Multi-
Currency; Multi-Level Bill; Multi-Level Where Used; MUSE; Open Order Detail; OPSL; Order 
Completion Status; Order Cost Variance Status; Order Detail; Order Line Items; OVAR; 
Packaging Detail; Packing List; Partner Item Detail; PBCI; PBCT; PCST; PICI; PICK; Picklist 
Detail; POCI; POCR; POCT; POMI; POMT; PORI; PORR; PORV; POSR; POVD; Pricing 
Maintenance + Action Detail; Pricing Maintenance + Action List; Pricing Maintenance + Test 
Order; Production; Purchase Order Line Item Detail; Purchase Order Line Item Detail (CPMT); 
Purchase Order Line Items; Purchase Order Receipt History; Purchased Component Detail; 
QUOI; QUOT; Router/Traveler; SDAB; SDAL; Shipment Allocation Detail; Shipments by Line 
Item; Shipping Allocation Batch; Shipping Detail; Shortages by Order; SHPL; Single-Level 
Configuration Bill of Material Report; SSII; SSIL; Standard Costs Assigned Results; Standard 
Product Detail; Summarized Bill; Supply Peg Detail; Transaction Detail; VDII; VDIT; VDSC; 
VEIT; Vendor/Item Detail; VETI; VPFR; Where Used; WIPR; Workcenter Master; WUSE
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LOCN – Location Index
Location Index summarizes manufacturing activity related to a parent item, providing an index for 
answering "Where are we in production?" questions at any manufacturing level in the product structure. 

You can specify exclusion criteria by selecting Options from the View menu. Applying exclusions such as 
component type, make/buy type or embedded revision allows you to filter records based on the specified 
criteria.

With the Location Index multi-level bill of material format, you can scroll through component items and 
double-click on a selected item to view manufacturing activity on the Status of Open/Released 
Manufacturing Orders and then the Order Progress Against Routing dialogs.

• Status of Open/Released Manufacturing Orders. Lists the open and released orders for 
manufacturing the selected item. Detail information includes the order status, quantity ordered 
and received for the item, as well as the date started, needed and scheduled. Use this 
information to assess the current status of manufacturing activity for all orders.

• Order Progress Against Routing. Lists the detailed status of each operation in the routing for 
the specified order and sorts the operations by sequence number. Detail information includes 
the workcenter, available quantity, completed quantity, setup status and remaining run load to 
complete for each operation. Manufacturing activity is summarized for a given order and 
therefore can help you diagnose your ability to produce the parent item. Use this information to 
analyze the status of each operation in the order-dependent routing.

Reports

Location Index Reports
To generate the report, choose Print Preview from the File menu.

Report Description
Lists all component location statuses.

Access Method
To generate the report, choose Print Preview from the File menu. 

Report Template
For more information on report templates, see "Reporting for SQL Server Systems" in the System 
Help topics.

Available From
Location Index

Report Title

Location Index
Lists all component location statuses.

Location Index -- Order Progress Against Routing
Lists operations statuses to-date in the routing for a specified order

Location Index -- Status of Open/Released Orders
Lists orders and the current status information.
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Location Index – Order Progress Against Routing
Report Description
Lists operations statuses to-date in the routing for a specified order

Access Method
To generate the report, choose Print Preview from the File menu. 

Report Template
For more information on report templates, see "Reporting for SQL Server Systems" in the System 
Help topics.

Available From
Capacity Planning

Location Index

Location Index – Status of Open/Released Orders
Report Description
Lists orders and the current status information.

Access Method
To generate the report, choose Print Preview from the File menu. 

Report Template
For more information on report templates, see "Reporting for SQL Server Systems" in the System 
Help topics.

Available From
Location Index

Fields
Avail Qty

Available Quantity of Units indicates the number of units completed at the Prior 
Workcenter available for processing at the specified workcenter operation.

Where Used: Capacity Planning; Dispatch List; Location Index; Schedule Board

Com Typ
Component Type distinguishes various types of relationships between a component and its 
parent assembly in a bill of material. The Component Type indicates how a component is 
used in the manufacture of a parent. The Component Types are:

N = Normal. 
Component is consumed in the manufacture of its parent.

P = Phantom. 
Component is used for structure purposes only (e.g., a transient subassembly 
consumed in the manufacture of its parent).

R = Resource or Workcenter. 
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Component is used in the planning process of the manufacture of its parent (e.g., 
labor hours).

X = Reference. 
Component is for information purposes. Reference items are included on the picklist. 
Reference items are not included in the parent's rolled costs and are typically not 
required for issue in the manufacturing of the parent.

D = Document. 
Component is used for information purposes only. It is not included on the picklist.

B = By-product. 
The manufacture of the parent results in the creation of this component.

C = Co-product. 
Component is derived from the manufacture of the parent. The manufacture of the co-
product, in turn, produces the parent.

T = Tool. 
Component is used in the manufacture of the parent.

U = Tool return. 
Component is used in, and returned after, the manufacture of the parent.

M = Module. 
Component represents a group of components for which requirements are generated 
for custom product orders. A module component is used for structure purposes only, 
such as a transient subassembly consumed in the manufacture of its parent. Module 
components explode requirements for the child components; the module component 
itself is never required.

V = Purchased material. 
Component not defined on the Item Master is required for a custom product customer 
order.

W = Outside operation or service. 
Component, such as heat treating or plating, is required for a custom product 
customer order.

Y = Phantom parent. 
Requirements have been exploded to the next level to meet requirements.

Z = Phantom child. 
Component is used in the manufacture of the phantoms parent.

An item's use as a component is limited by its Item Type.  The Component Types available 
are based on the information displayed on the screen and not all types are available on all 
screens.

Where Used: BILI; BILL; Bill of Material; Bill of Material Detail; COCP; Comparison Bill; 
Costed Bill Detail; CPMT; CSLB; Custom Product Component Detail; CWIP; Demand Peg 
Detail; Engineering; Job Estimates and Performance Report; Location Index; Material 
Shortages Detail; MBIL; MCST; Multi-Level Bill; OPSL; Order Cost Variance Status; OVAR; 
PCST; Production; Purchased Component Detail; Single-Level Configuration Bill of Material 
Report; Summarized Bill; WIPL; WIPR
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Complete Qty
Units Completed indicates the number of units reported as complete at a specified 
workcenter operation.

Where Used: Capacity Planning; Location Index; Schedule Board

Component
Component is a term that describes the structural relationship between an item and its parent 
assembly in a bill of material. A Component is used in the manufacture of a parent, and it may 
be a part, raw material or a subassembly. Entry is any alphanumeric combination of up to 30 
characters.

Where Used: Backflush Issue Reconciliation Report; BILI; BILL; Bill of Material; Bill of 
Material Detail; CMLB; COCP; Comparison Bill; Comparison of Summarized Bills; Costed Bill 
Detail; CPMT; CSLB; Custom Product Component Detail; Demand Peg Detail; Engineering; 
Exceptions; Job Estimates and Performance Report; Lead Time; Location Index; Material 
Exposure; Material Shortages Detail; MBIL; MCST; Multi-Level Bill; Multi-Level Costed Bill; 
Multi-Level Where Used; MUSE; OPSL; OVAR; PCST; PICI; PICK; Picklist Detail; Production; 
Router/Traveler; Single-Level Configuration Bill of Material Report; Summarized Bill; Where 
Used; WUSE

Desc
Item Description identifies the item in terms of its characteristics. When space is limited, a 
partial description is displayed. Entry is any alphanumeric combination of up to 70 characters.

Where Used: A/P Received Item List; ABCR; Advance Ship Notice Line; APPI; APPV; 
Available Pricing; AVII; AVIT; BILI; BILL; Bill of Material; Bill of Material Detail; Browse Setup 
(item); Capacity Planning; CCAN; CCAT; CMLB; COBK; COCP; COMP; Comparison Bill; 
Comparison of Summarized Bills; Contract Item Detail; Contract Item Detail/Pricing; CORV; 
Cost Estimate by Lot Size; Costed Bill Detail; CSLB; Custom Product Component Detail; 
Customer Item + General; Customer Order; Customer Order Receipt/Reverse; CWIP; 
Demand Peg Detail; Dispatch List; Engineering; FCST; ICCR; IHIR; INVA; Inventory 
Allocation; Inventory History List; Inventory Transaction History Report; INVR; IORD; IPPD; 
ISVI; ITBI; ITCB; ITCI; Item + Alternates; Item + Quantity; Item Availability; Item Availability + 
Quantity; Item Browse; Item Browse Detail; Item History; Item Lot Trace and Serialization 
Detail; Item Master; Item Master Detail; Item Master Planning Detail; Item Responsibility 
Assigned Results; ITMB; ITMC; ITMI; ITPB; ITPI; Job Estimates and Performance Report; 
Lead Time; Lead Time Analysis; Lead Times Assigned Results; LEXP; Line Item Details + 
Item; LMSI; LMST; Location Index; Lot Detail; Lot Inventory Transaction History Report; Lot 
Trace; Lot Trace Issue Detail; Lot Trace Receipt Detail; LOTR; LVAL; Manufacturing Order 
Line Item Detail; Manufacturing Order Receipt/Reverse; Material Exposure; MBIL; MCST; 
MOMI; MOMT; MORI; MORV; MPSR; MPSS; MSMT; Multi-Level Bill; Multi-Level Costed Bill; 
Multi-Level Where Used; MUSE; Open Order Detail; OPSL; Order Completion Status; Order 
Cost Variance Status; Order Detail; Order Line Items; OVAR; Package Content; Packaging 
Detail; Partner Item Detail; PBCI; PBCT; PBII; PICI; PICK; Picklist Detail; POAN; POAS; 
POCI; POCR; POCT; POMI; POMT; PORI; PORR; PORV; POYE; Production; Purchase 
Order Line Item Detail; Purchase Order Line Item Detail (CPMT); Purchase Order Line Items; 
Purchase Order Receipt History; Purchased Component Detail; QSRC; QUOI; QUOT; Router/
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Traveler; SDAB; SDAL; Shipment Allocation Detail; Shipments by Line Item; Shipping Detail; 
Shortages by Order; SHPL; Single-Level Configuration Bill of Material Report; SSII; SSIL; 
Standard Costs Assigned Results; Standard Product Detail; Summarized Bill; Supply Peg 
Detail; Transaction Detail; VDII; VDIT; VDSC; VITI; Where Used; WIPR; WUSE

Description
Item Description identifies the item in terms of its characteristics. When space is limited, a 
partial description is displayed. Entry is any alphanumeric combination of up to 70 characters.

Where Used: A/P Received Item List; ABCR; Advance Ship Notice Line; APPI; APPV; 
Available Pricing; AVII; AVIT; BILI; BILL; Bill of Material; Bill of Material Detail; Browse Setup 
(item); Capacity Planning; CCAN; CCAT; CMLB; COBK; COCP; COMP; Comparison Bill; 
Comparison of Summarized Bills; Contract Item Detail; Contract Item Detail/Pricing; CORV; 
Cost Estimate by Lot Size; Costed Bill Detail; CSLB; Custom Product Component Detail; 
Customer Item + General; Customer Order; Customer Order Receipt/Reverse; CWIP; 
Demand Peg Detail; Dispatch List; Engineering; FCST; ICCR; IHIR; INVA; Inventory 
Allocation; Inventory History List; Inventory Transaction History Report; INVR; IORD; IPPD; 
ISVI; ITBI; ITCB; ITCI; Item + Alternates; Item + Quantity; Item Availability; Item Availability + 
Quantity; Item Browse; Item Browse Detail; Item History; Item Lot Trace and Serialization 
Detail; Item Master; Item Master Detail; Item Master Planning Detail; Item Responsibility 
Assigned Results; ITMB; ITMC; ITMI; ITPB; ITPI; Job Estimates and Performance Report; 
Lead Time; Lead Time Analysis; Lead Times Assigned Results; LEXP; Line Item Details + 
Item; LMSI; LMST; Location Index; Lot Detail; Lot Inventory Transaction History Report; Lot 
Trace; Lot Trace Issue Detail; Lot Trace Receipt Detail; LOTR; LVAL; Manufacturing Order 
Line Item Detail; Manufacturing Order Receipt/Reverse; Material Exposure; MBIL; MCST; 
MOMI; MOMT; MORI; MORV; MPSR; MPSS; MSMT; Multi-Level Bill; Multi-Level Costed Bill; 
Multi-Level Where Used; MUSE; Open Order Detail; OPSL; Order Completion Status; Order 
Cost Variance Status; Order Detail; Order Line Items; OVAR; Package Content; Packaging 
Detail; Partner Item Detail; PBCI; PBCT; PBII; PICI; PICK; Picklist Detail; POAN; POAS; 
POCI; POCR; POCT; POMI; POMT; PORI; PORR; PORV; POYE; Production; Purchase 
Order Line Item Detail; Purchase Order Line Item Detail (CPMT); Purchase Order Line Items; 
Purchase Order Receipt History; Purchased Component Detail; QSRC; QUOI; QUOT; Router/
Traveler; SDAB; SDAL; Shipment Allocation Detail; Shipments by Line Item; Shipping Detail; 
Shortages by Order; SHPL; Single-Level Configuration Bill of Material Report; SSII; SSIL; 
Standard Costs Assigned Results; Standard Product Detail; Summarized Bill; Supply Peg 
Detail; Transaction Detail; VDII; VDIT; VDSC; VITI; Where Used; WIPR; WUSE

In Effect
In Effectivity is the date that the use of a component becomes effective in a bill of material. 
The default value is today's date or the date you entered when you signed onto the system.

Where Used: BILL; Bill of Material; Bill of Material Detail; Comparison Bill; Comparison of 
Summarized Bills; Costed Bill Detail; Demand Peg Detail; Engineering; Exceptions; Location 
Index; Multi-Level Bill; Multi-Level Costed Bill; Multi-Level Where Used; MUSE; Production; 
Single-Level Configuration Bill of Material Report; Summarized Bill; Where Used; WUSE
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Level
Item Level indicates the position of an item within a product structure. Level is used to show 
the relative position of an item in relationship to its higher-level parent or lower-level 
components. Entry is any alphanumeric combination.

Where Used: CMLB; Location Index; LOTR; MBIL; Multi-Level Bill; Multi-Level Costed Bill; 
Multi-Level Where Used; MUSE

Ln#
Line Number is the identification of a line item on an order. The Line Number is system-
assigned. Entry is up to 3 numbers.

Where Used: A/P Invoice Matching Detail; A/P PO/Inv Variance by Invoice; A/P Receiving 
Detail; Advance Ship Notice Line; Advance Ship Notice Order Detail; APEX; APID; APPI; 
APPV; APUV; Available for Shipping Allocation Batch; Backflush Issue Reconciliation Report; 
Bill of Material Accuracy Results; Capacity Planning; CCAN; CINV; COAN; COCD; COCP; 
COMI; COMT; CORV; CPMT; CSTU; Custom Product Component Detail; Custom Product 
Detail; Customer Order; Customer Order + Order Header; Customer Order Line Price 
Adjustment; Customer Order Receipt/Reverse; CWIP; Demand Peg Detail; Dispatch List; 
GASN; IHIR; IMTR; Inventory Transaction History Report; IORD; Item Shortages; JEST; Job 
Estimates and Performance Report; LHIS; LMSI; LMST; Location Index; Lot Detail; Lot 
Inventory Transaction History Report; Lot Trace Issue Detail; Lot Trace Receipt Detail; LOTR; 
LRRP; Manufacturing Order Line Item Detail; Manufacturing Order Receipt/Reverse; Material 
Shortages Detail; MCST; MOAN; MOFR; MOMI; MOMT; MORI; MORV; MSMT; Open Order 
Detail; OPSL; Order Completion Status; Order Cost Variance Status; Order Detail; Order Line 
Items; OVAR; Package Content; Packaging Detail; Packing List; PCMT; PCST; PICI; PICK; 
Picklist Detail; POAN; POAS; POMI; POMT; PORI; PORR; PORV; POSR; POVD; Pricing 
Maintenance + Test Order; Purchase Order Line Item Detail; Purchase Order Line Item Detail 
(CPMT); Purchase Order Line Items; Purchased Component Detail; Router/Traveler; 
Schedule Board; SDAB; Serial Number List; SHIP; Shipment Allocation Detail; Shipment 
Allocation List; Shipments by Line Item; Shipping Allocation Batch; Shortages by Order; 
SHPL; STAD; Standard Product Detail; Supply Peg Detail; Transaction Detail; TRUD; VDSC; 
VPFR; WIPL; WIPR; WIPS

Ln# Sta
Line Number Status indicates the item's current position within the order process. Line 
Number Statuses are:

blank = Order Point Quantity Level Reached. 
PREV and MRP have determined that the order point quantity of the item has been 
reached.

1 = MRP Planned Order. 
MRP has automatically planned an order for the item.

2 = Firm Planned. 
The item's order quantity and scheduled date are fixed and are not automatically 
changed.

3 = Open. 
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The item's order quantity and scheduled date are fixed. The order-dependent bill of 
material is attached to the item.

4 = Released. 
The item's order quantity and scheduled date are fixed. The order-dependent bill of 
material is attached to the item. The order and picklist can be printed and receipts/
issues can be made.

5 = Closed. 
All required receipts or issues have been made for the item.

6 = Closed. 
The order closure report has reported this order closure.

7 = Closed. 
The order is ready to be deleted from the active file and retained in order history.

Line Number Status can in most cases only be incremented. You can reopen an order, which 
decrements the Line Number Status from 5 to 4. For purchase orders, Line Number Status 
= 4 can be changed to 3 if no receipts were completed for that line item and the line is not Ln# 
Typ = S.

Where Used: Capacity Planning; CCAN; Demand Peg Detail; Dispatch List; IHIR; Item 
Shortages; Location Index; Manufacturing Order Line Item Detail; Manufacturing Order 
Receipt/Reverse; Material Shortages Detail; MCST; MOAN; MOMI; MOMT; MORI; MORV; 
MSMT; Open Order Detail; Order Completion Status; Order Cost Variance Status; Order Line 
Items; PCST; PICI; PICK; Picklist Detail; POAN; POAS; POMI; POMT; PORI; PORR; PORV; 
Purchase Order Line Item Detail; Purchase Order Line Item Detail (CPMT); Purchase Order 
Line Items; Purchased Component Detail; Router/Traveler; Schedule Board; Shortages by 
Order; Supply Peg Detail; Transaction Detail; WIPL; WIPR; WIPS

Ln# Typ
Line Number Type determines the use of the item order quantity in planning, manufacturing 
and accounting. Line Number Types available depend on the screen where the transaction is 
completed; these include:

B = By-product. 
Created as part of another order.

M = Manufacturing. 
Dependent demands are automatically created.

R = Rework. 
Dependent demands are not automatically created but are manually added.

U = Tool Return. 
Created as part of another order.

X = Custom Product. 
Make-to-order and engineer-to-order products.

Where Used: Capacity Planning; CCAN; Demand Peg Detail; Dispatch List; IHIR; Item 
Shortages; Location Index; Manufacturing Order Line Item Detail; Manufacturing Order 
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Receipt/Reverse; Material Shortages Detail; MCST; MOAN; MOMI; MOMT; MORI; MORV; 
Order Completion Status; Order Cost Variance Status; Order Line Items; OVAR; PICI; PICK; 
Picklist Detail; Router/Traveler; Schedule Board; Shortages by Order; Supply Peg Detail; 
WIPL; WIPR; WIPS

Need Date
Need Date is the date the component is needed in the next higher-level assembly. This date is 
calculated by MRP.

Where Used: CORV; Demand Peg Detail; IORD; Location Index; Manufacturing Order Line 
Item Detail; Material Shortages Detail; MCST; MOAN; MOFR; MOMI; MOMT; MORI; MORV; 
MSMT; Order Completion Status; Order Line Items; Router/Traveler; Shortages by Order; 
Supply Peg Detail

Open Qty
Open Quantity is the difference between the quantity ordered and the quantity received. 
Open Quantity is stated as 0 (zero) if more items have been received than ordered.

Where Used: Custom Product Component Detail; Customer Order Receipt/Reverse; IORD; 
Location Index; Manufacturing Order Receipt/Reverse; Material Shortages Detail; MOAN; 
MOFR; Open Order Detail; POAN; POAS; PORI; PORR; PORV; POVD; Purchased 
Component Detail; Supply Peg Detail; VDSC

Oper Date
Operation Due Date is system-calculated for planned orders based on the order start date 
plus the component's lead time offset, where the order start date is based on the order due 
date minus the parent's lead time. After creating an order-dependent routing (e.g., for opened 
or released orders), the Operation Due Date can be modified on the Picklist Detail screen. 
For custom products, the Operation Due Date can also be modified on the CPMT screen.

Where Used: Capacity Planning; Dispatch List; Location Index; Schedule Board

Order No
Order Number is the user-defined identifier for a purchase, manufacturing or customer order. 
Entry is any alphanumeric combination of up to 30 characters.

Where Used: APEX; Backflush Issue Reconciliation Report; Bill of Material Accuracy 
Results; Browse Setup (order); Capacity Planning; CINV; COCP; Dispatch List; EDIX; IHIR; 
IMTR; Inventory Transaction History Report; IORD; Item Shortages; LMSI; LMST; Location 
Index; Lot Detail; Lot Inventory Transaction History Report; Lot Trace Issue Detail; Lot Trace 
Receipt Detail; LOTR; LRRP; MSMT; Order Browse; Order Completion Status; Order Cost 
Variance Status; ORST; OVAR; Router/Traveler; Schedule Board; SDAB; SHIP; Shipment 
Allocation List; Shortages by Order; STAD; TRUD; VDSC
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OS
Order Source / Type identifies the source of the order request. Types are:

C = Customer
M = Manufacturing
P = Purchase

Where Used: Backflush Issue Reconciliation Report; CCAN; CSTU; CWIP; EDIX; IHIR; 
IMTR; IORD; LHIS; LMSI; LMST; Location Index; Lot Detail; Lot Trace Issue Detail; Lot Trace 
Receipt Detail; LOTR; LRRP; Order Browse; ORST; OVAR; PICI; PICK; Picklist Detail; SDAB; 
SHIP; STAD; TRUD; WIPL; WIPR; WIPS

Out Effect
Out Effectivity is the first date that a component is not effective in a bill of material. The 
default value is 12/31/2079.

Where Used: BILL; Bill of Material; Bill of Material Detail; Comparison Bill; Costed Bill 
Detail; Demand Peg Detail; Engineering; Exceptions; Location Index; Multi-Level Bill; Multi-
Level Where Used; MUSE; Production; Single-Level Configuration Bill of Material Report; 
Where Used; WUSE

Parent
Parent is a term that describes the structural relationship between an item and its components 
in a bill of material. A Parent item is the higher level item in the parent-component relationship. 
A parent cannot be used in itself. Entry is any alphanumeric combination of up to 30 
characters.

Where Used: BILI; BILL; Bill of Material; Bill of Material Detail; CMLB; Comparison Bill; 
Comparison of Summarized Bills; Cost Estimate by Lot Size; CSLB; Dispatch List; 
Engineering; Lead Time; Lead Time Analysis; Location Index; Material Exposure; MBIL; Multi-
Level Bill; Multi-Level Costed Bill; Multi-Level Where Used; MUSE; Production; Summarized 
Bill; Where Used; WUSE

Pt Use
Point of Use is a key field that, along with the Seqn field, defines the sort sequence of 
components in a bill of material. The Point of Use field accepts any information you choose to 
enter, but the intended use is to identify the "work center" where the component should be 
delivered when assembling the parent, the "find number" of the component referenced on the 
drawing for the parent, or the "component reference designator" of the component on a printed 
circuit board. If the Point of Use field is not applicable in your company, you may enter 0 
(zero). Entry is any alphanumeric combination of up to 5 characters.

Where Used: BILI; BILL; Bill of Material; Bill of Material Detail; Capacity Planning; 
Comparison Bill; Custom Product Component Detail; Demand Peg Detail; Dispatch List; 
Engineering; Exceptions; Job Estimates and Performance Report; Lead Time; Location Index; 
LRRP; Material Shortages Detail; MBIL; Multi-Level Bill; Multi-Level Where Used; MUSE; 
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Order Cost Variance Status; OVAR; PICI; PICK; Picklist Detail; Pricing Maintenance + Test 
Order; Production; Purchase Order Line Item Detail; Purchase Order Line Item Detail (CPMT); 
Router/Traveler; Schedule Board; Single-Level Configuration Bill of Material Report; TRUD; 
Where Used; WUSE

Qty Alloc
Allocations is the number and value of units committed to open and released purchase and 
manufacturing orders (Ln# Sta = 3 or 4) and released customer orders (Ln# Sta = 4).

Where Used: Item Availability; Item Shortages; ITHR; Location Index; Production; 
Shortages by Order; SSII

Qty Insp+Hold
Insp+On Hold Quantity is the sum of the item's Inspection Quantity and the item's On Hold 
Quantity.

Where Used: Location Index

Qty On Hand
On Hand Quantity is the amount of inventory available for issue. Entry is up to 10 numbers.

Where Used: CINV; Custom Product Detail; Inventory Status; INVR; Item + Quantity; Item 
Availability; Item Availability + Quantity; Item Shortages; LEXP; Line Item Details + Custom 
Product; LMSI; LMST; Location Index; Lot Detail; MPSR; MPSS; Production; Shortages by 
Order; SSII

Qty On Order
On Order Quantity is the total number of items on open or released manufacturing and 
purchase orders (Ln# Sta = 3 or 4).

Where Used: Inventory Status; Item + Quantity; Item Availability; Item Availability + 
Quantity; Item Shortages; Location Index; Material Shortages Detail; Production; Shortages by 
Order; SSII; Summarized Bill

Qty Typ
Quantity Type code defines the nature of the parent- component relationship when placing an 
order for the parent. It affects how the Quantity field is used in calculating component 
requirements. Quantity Types are: 

I = Per Item. 
Quantity per item is the number of components needed to manufacture one parent 
item. For a given order, the gross number of components required equals Quantity 
times order size. 

O = Per Order. 
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Quantity per order is the number of components required per order to manufacture 
one or more parent items. For a given order, the gross number of components 
required equals Quantity.

Where Used: BILI; BILL; Bill of Material; Bill of Material Detail; COCP; Comparison Bill; 
Comparison of Summarized Bills; Costed Bill Detail; CPMT; CSLB; Custom Product 
Component Detail; Demand Peg Detail; Engineering; Job Estimates and Performance Report; 
Location Index; Material Exposure; MBIL; MCST; Multi-Level Bill; Multi-Level Where Used; 
MUSE; OVAR; PCST; Picklist Detail; Production; Purchased Component Detail; Summarized 
Bill; WUSE

Quantity
The Bill Quantity specifies how many or how much of a particular component is required to 
manufacture a parent.

Where Used: Location Index

Reqd Quantity
Required Quantity is the number of component items required for the parent item. Entry is up 
to 10 numbers. Decimal places are allowed.

Where Used: Capacity Planning; Custom Product Component Detail; Item Shortages; 
Location Index; Material Shortages Detail; Picklist Detail; Purchase Order Line Item Detail 
(CPMT); Router/Traveler; Schedule Board; Shortages by Order

Run Load
Run Load indicates the remaining run time to complete the workcenter operation, and is the 
Bal Due times the per-unit run-time hours on the routing.

Where Used: Capacity Planning; Dispatch List; Location Index; Router/Traveler; Schedule 
Board

Sched Date
Scheduled Date is the planned completion date or shipment date for an item.

Where Used: CORV; CSTU; Demand Peg Detail; IORD; Location Index; Manufacturing 
Order Line Item Detail; Material Shortages Detail; MCST; MOAN; MOFR; MOMI; MOMT; 
MORI; MORV; MSMT; Order Completion Status; Order Line Items; Router/Traveler; SDAB; 
Shortages by Order; Supply Peg Detail

Seqn
Sequence Number is a key field that, along with the Pt Use field, defines the sort sequence of 
components in a bill of material. The field accepts any information you choose to enter, but the 
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intended purpose is to identify the operation sequence number on the parent’s routing that 
calls out the component. If the Sequence Number is not applicable in your company, you may 
enter 0 (zero). Entry is up to 3 numbers.

Where Used: Backflush Issue Reconciliation Report; BILI; BILL; Bill of Material; Bill of 
Material Detail; Capacity Planning; CINV; COCP; Comparison Bill; CPMT; Custom Product 
Component Detail; CWIP; Demand Peg Detail; Dispatch List; Engineering; Exceptions; Job 
Estimates and Performance Report; Lead Time; Location Index; LRRP; Material Shortages 
Detail; MBIL; MCST; Multi-Level Bill; Multi-Level Where Used; MUSE; OPSL; Order Cost 
Variance Status; OVAR; PCST; PICI; PICK; Picklist Detail; PORI; PORV; Production; 
Purchase Order Line Item Detail; Purchase Order Line Item Detail (CPMT); Purchased 
Component Detail; Router/Traveler; Schedule Board; Single-Level Configuration Bill of 
Material Report; TRUD; Where Used; WIPL; WIPR; WUSE

Set Up
Setup Status indicates whether any time has been reported against the workcenter setup 
operation. The Setup Status options are:

Yes = Time has already been reported against the setup operation.
blank = No workcenter setup item WC[S] exists for this operation.

Where Used: Capacity Planning; Dispatch List; Location Index; Schedule Board; 
Workcenter Master

Source Id
Source Id identifies the vendor, customer, or source responsible for the receipt or 
disbursement amount. Entry is up to 13 characters.

Where Used: BKCJ; BKRC; CSCP; G/L Distribution (CSHM Module); Location Index; 
Reconciliation Detail; SUND; SUNR; SUPD; SUPR

Source Name
Source Name is the name of the vendor or customer who is responsible for the receipt or 
disbursement amount.

Where Used: BKRC; Location Index; Reconciliation Detail

Start Date
Start Date is the date the order must be started so that the required date is met. Start Date is 
MRP-calculated, based on the lead times established for the item on the Item Master. If the 
Start Date is changed by the user, the new Start Date is used by MRP in future calculations 
for the ordered line item.
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Where Used: Demand Peg Detail; Location Index; Manufacturing Order Line Item Detail; 
MCST; MOMI; MOMT; MORI; MORV; Order Completion Status; PICI; PICK; Picklist Detail; 
Purchase Order Line Item Detail; Router/Traveler; Shortages by Order; Supply Peg Detail

UM
Unit of Measure identifies the standard unit for an item used in the manufacturing process. 
Entry is up to 4 alphanumeric characters.

Where Used: A/P PO/Inv Variance by Invoice; A/P Receiving Detail; APEX; APPI; APPV; 
APUV; Available for Shipping Allocation Batch; AVII; AVIT; BILI; BILL; Bill of Material; Bill of 
Material Detail; CCAT; CINV; CMLB; COBK; COCP; COMI; COMT; Contract Header Detail; 
Contract Item Detail; Contract Item Detail/Pricing; CORV; Costed Bill Detail; CPMT; CSLB; 
Custom Product Component Detail; Custom Product Detail; Customer Order; Customer Order 
Line Price Adjustment; Customer Order Receipt/Reverse; CWIP; Demand Peg Detail; 
Engineering; FCST; ICCR; IHIR; INVA; Inventory Allocation; INVR; IORD; IPPD; ITBI; ITCB; 
ITCI; Item + Quantity; Item Availability + Quantity; Item Browse Detail; Item History; Item Lot 
Receipt; Item Lot Trace and Serialization Detail; Item Master; Item Master Detail; Item Master 
Planning Detail; Item Responsibility Assigned Results; Item Shortages; ITHC; ITHR; ITMB; 
ITMC; ITMI; ITPB; ITPI; IVPR; IVRR; JEST; Job Estimates and Performance Report; Lead 
Times Assigned Results; LEXP; LHIS; Line Item Details + Item; LMSI; LMST; Location Index; 
Lot Detail; Lot Trace; Lot Trace Issue Detail; Lot Trace Receipt Detail; LOTR; LVAL; 
Manufacturing Order Line Item Detail; Manufacturing Order Receipt/Reverse; Material 
Exposure; MBIL; MCST; MOMI; MOMT; MORI; MORV; MPIT; MPSR; MPSS; MSMT; Multi-
Currency; Multi-Level Bill; Multi-Level Where Used; MUSE; Open Order Detail; OPSL; Order 
Completion Status; Order Cost Variance Status; Order Detail; Order Line Items; OVAR; 
Packaging Detail; Packing List; Partner Item Detail; PBCI; PBCT; PCST; PICI; PICK; Picklist 
Detail; POCI; POCR; POCT; POMI; POMT; PORI; PORR; PORV; POSR; POVD; Pricing 
Maintenance + Action Detail; Pricing Maintenance + Action List; Pricing Maintenance + Test 
Order; Production; Purchase Order Line Item Detail; Purchase Order Line Item Detail (CPMT); 
Purchase Order Line Items; Purchase Order Receipt History; Purchased Component Detail; 
QUOI; QUOT; Router/Traveler; SDAB; SDAL; Shipment Allocation Detail; Shipments by Line 
Item; Shipping Allocation Batch; Shipping Detail; Shortages by Order; SHPL; Single-Level 
Configuration Bill of Material Report; SSII; SSIL; Standard Costs Assigned Results; Standard 
Product Detail; Summarized Bill; Supply Peg Detail; Transaction Detail; VDII; VDIT; VDSC; 
VEIT; Vendor/Item Detail; VETI; VPFR; Where Used; WIPR; Workcenter Master; WUSE

Workcenter
Workcenter is the identifier for a specific production facility, consisting of one or more people 
and/or machines, which can be considered as one unit for the purposes of capacity planning, 
scheduling and costing. If the SFRM Module is installed, workcenters are defined on the 
Workcenter Master. If the SFRM Module is not installed, workcenters are established on the 
Item Master as resource items. The workcenter's run, setup and completion records define 
how the workcenter should be used when constructing the bills of material.

When the workcenter is displayed on the Item Master, a five-character prefix is added to the 
workcenter name. Prefixes include:

WC[R] = Run-time hours for workcenter operations
WC[S] = Setup hours for the workcenter operations
WC[C] = Unit completions for run-time operations at the workcenter

Workcenter entry is any alphanumeric combination of up to 10 characters.
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Where Used: Capacity Planning; Dispatch List; Location Index; Router/Traveler; Schedule 
Board; Workcenter Master
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LTAN – Lead Time Analysis
Lead Time Analysis displays a Gantt chart analysis of lead times for an item’s multi-level product structure 
in effect as of a user-specified date. By varying resolution between weekly and daily time increments, you 
get a global view or a detailed view of lead times. You can simulate changes to operation duration and 
start dates, material lead times and lead time offsets. After simulating changes, you can analyze the critical 
path. You can interactively walk the critical path adjusting lead times and lead time offsets while monitoring 
the impact of simulated changes on the cumulative lead time of the parent. 

Gantt Chart Features
Lead Time Analysis displays parent and component item information in a multi-level graphical 
hierarchy on the left side and the related lead time information in a Gantt chart on the right side. 
The Gantt Chart has several display features:

• Daily time increments are displayed by the horizontal axis. Chart scaling is displayed along the 
top of the chart.

• Each component is displayed by one line:

• The ending point of a line represents when the component is needed. This date is based on 
lead times of higher-level items and lead time offsets to determine when a component's parent 
item should be started.

- For resource components such as workcenter operations, the lead time reflects 
average operation duration for all operations performed at the workcenter.

- The critical path of components to manufacture the parent item is displayed with red 
lines by default. When more than one critical path exists, only the last one (nearest the 
bottom of the Gantt chart) is displayed in red. Critical paths are marked with an 
asterisk ( * ) in the graphical hierarchy.

- The normal, highlighted and critical path line colors can be customized by selecting 
Options from the View menu.

• The cumulative lead time for the parent item, based on the critical path of components, is 
displayed in the Cum LT field.

Reports

Lead Time Analysis Reports

Line Type Description

Solid single buy item

Solid double make item with a normal component type (CT = N)

Dashed double a make item with a phantom component type (CT = P)

Line length Component's lead time
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To generate the report, choose Print Preview from the File menu.

Lead Time Analysis – Critical Path Gantt Chart
Report Description
Lists the critical path gantt chart without any exclusions.

Access Method
To generate the report, choose Print Preview from the File menu. 

Report Template
For more information on report templates, see "Reporting for SQL Server Systems" in the System 
Help topics.

Available From
Lead Time Analysis

Lead Time Analysis – Full Gantt Chart
Report Description
Lists the full gantt chart without any exclusions.

Access Method
To generate the report, choose Print Preview from the File menu. 

Report Template
For more information on report templates, see "Reporting for SQL Server Systems" in the System 
Help topics.

Available From
Lead Time Analysis

Fields
As of

The Bill as of Date is used to request a product structure in effect as of a specified date for 
the purposes of displaying or analyzing the bill/routing for the parent item.

Where Used: Cost Estimate by Lot Size; Lead Time Analysis

Description
Item Description identifies the item in terms of its characteristics. When space is limited, a 
partial description is displayed. Entry is any alphanumeric combination of up to 70 characters.

Report Title

Lead Time Analysis -- Critical Path Gantt Chart
Lists the critical path gantt chart without any exclusions.

Lead Time Analysis -- Full Gantt Chart
Lists the full gantt chart without any exclusions.
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Where Used: A/P Received Item List; ABCR; Advance Ship Notice Line; APPI; APPV; 
Available Pricing; AVII; AVIT; BILI; BILL; Bill of Material; Bill of Material Detail; Browse Setup 
(item); Capacity Planning; CCAN; CCAT; CMLB; COBK; COCP; COMP; Comparison Bill; 
Comparison of Summarized Bills; Contract Item Detail; Contract Item Detail/Pricing; CORV; 
Cost Estimate by Lot Size; Costed Bill Detail; CSLB; Custom Product Component Detail; 
Customer Item + General; Customer Order; Customer Order Receipt/Reverse; CWIP; 
Demand Peg Detail; Dispatch List; Engineering; FCST; ICCR; IHIR; INVA; Inventory 
Allocation; Inventory History List; Inventory Transaction History Report; INVR; IORD; IPPD; 
ISVI; ITBI; ITCB; ITCI; Item + Alternates; Item + Quantity; Item Availability; Item Availability + 
Quantity; Item Browse; Item Browse Detail; Item History; Item Lot Trace and Serialization 
Detail; Item Master; Item Master Detail; Item Master Planning Detail; Item Responsibility 
Assigned Results; ITMB; ITMC; ITMI; ITPB; ITPI; Job Estimates and Performance Report; 
Lead Time; Lead Time Analysis; Lead Times Assigned Results; LEXP; Line Item Details + 
Item; LMSI; LMST; Location Index; Lot Detail; Lot Inventory Transaction History Report; Lot 
Trace; Lot Trace Issue Detail; Lot Trace Receipt Detail; LOTR; LVAL; Manufacturing Order 
Line Item Detail; Manufacturing Order Receipt/Reverse; Material Exposure; MBIL; MCST; 
MOMI; MOMT; MORI; MORV; MPSR; MPSS; MSMT; Multi-Level Bill; Multi-Level Costed Bill; 
Multi-Level Where Used; MUSE; Open Order Detail; OPSL; Order Completion Status; Order 
Cost Variance Status; Order Detail; Order Line Items; OVAR; Package Content; Packaging 
Detail; Partner Item Detail; PBCI; PBCT; PBII; PICI; PICK; Picklist Detail; POAN; POAS; 
POCI; POCR; POCT; POMI; POMT; PORI; PORR; PORV; POYE; Production; Purchase 
Order Line Item Detail; Purchase Order Line Item Detail (CPMT); Purchase Order Line Items; 
Purchase Order Receipt History; Purchased Component Detail; QSRC; QUOI; QUOT; Router/
Traveler; SDAB; SDAL; Shipment Allocation Detail; Shipments by Line Item; Shipping Detail; 
Shortages by Order; SHPL; Single-Level Configuration Bill of Material Report; SSII; SSIL; 
Standard Costs Assigned Results; Standard Product Detail; Summarized Bill; Supply Peg 
Detail; Transaction Detail; VDII; VDIT; VDSC; VITI; Where Used; WIPR; WUSE

Lead Time
Lead Time Days is the number of days into the production of the parent item.

Where Used: Lead Time Analysis; Material Exposure

Lead Time Offset
Lead Time Offset is the number of days after the order start date that a component is needed 
in the manufacturing process. Entry is up to 3 numbers. Default value is 0.

Where Used: BILL; Bill of Material Detail; Demand Peg Detail; Lead Time; Lead Time 
Analysis; Material Exposure; MBIL; Multi-Level Bill; Multi-Level Where Used; Production; 
Single-Level Configuration Bill of Material Report

MB
Make-Buy Code indicates if a part is normally purchased or manufactured. Make-Buy Code 
also directs appropriate action messages to the Buyr (B or S) or Plnr (M). Make-Buy Codes 
are:

M = Make. 
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Manufactured in-house.

B = Buy. 
Purchased; no parts supplied to vendor.

S = Supplied. 
Purchased; parts supplied to vendor.

Where Used: ABCR; AVII; AVIT; BILI; BILL; Bill of Material; Bill of Material Detail; COMP; 
Costed Bill Detail; CSLB; Demand Peg Detail; Engineering; FCST; IHIR; IORD; IPPD; Item 
Availability; Item Browse Detail; Item History; Item Lot Trace and Serialization Detail; Item 
Master; Item Master Detail; Item Master Planning Detail; Item Responsibility Assigned 
Results; Item Shortages; ITHC; ITHR; ITMB; ITMI; Lead Time Analysis; Lead Times Assigned 
Results; Lot Size Multiple Detail; Lot Trace; LSDA; LVAL; Material Exposure; Material 
Shortages Detail; MBIL; MPSR; MPSS; MSMT; Multi-Level Bill; PBCI; PBCT; Production; 
QUOI; QUOT; SDAB; SDAL; Shortages by Order; Single-Level Configuration Bill of Material 
Report; SSII; Standard Costs Assigned Results; Summarized Bill; Supply Peg Detail

Parent
Parent is a term that describes the structural relationship between an item and its components 
in a bill of material. A Parent item is the higher level item in the parent-component relationship. 
A parent cannot be used in itself. Entry is any alphanumeric combination of up to 30 
characters.

Where Used: BILI; BILL; Bill of Material; Bill of Material Detail; CMLB; Comparison Bill; 
Comparison of Summarized Bills; Cost Estimate by Lot Size; CSLB; Dispatch List; 
Engineering; Lead Time; Lead Time Analysis; Location Index; Material Exposure; MBIL; Multi-
Level Bill; Multi-Level Costed Bill; Multi-Level Where Used; MUSE; Production; Summarized 
Bill; Where Used; WUSE

Total Lead Time
Total Lead Time is the sum of Run LT, Fixed LT and Insp LT as expressed in shop days.

Where Used: Bill of Material; Lead Time; Lead Time Analysis; Multi-Level Bill; Multi-Level 
Where Used; Summarized Bill; Where Used
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OCMP – Order Completion Status
Order Completion Status helps answer inquiries about the status of released and closed orders. You can 
specify which order types to include in the list, and you can select to sort results by either item or order. 
Order Completion Status allows you to quickly find information about the quantity ordered versus quantity 
received, and the date scheduled versus date needed.

Reports

Order Completion Status Reports
To generate the report, choose Print Preview from the File menu.

Report Description
Lists all orders and current status information.

Access Method
To generate the report, choose Print Preview from the File menu. 

Report Template
For more information on report templates, see "Reporting for SQL Server Systems" in the System 
Help topics.

Available From
Order Completion Status

Fields
Actual Cost

Actual Costs are the material, labor, overhead and outside costs incurred to manufacture the 
item to date. Actual Costs are based on the standard cost at the time components are issued. 
The Actual Costs value is the same as the Order Cost value on the MCST (Manufacturing 
Order Cost Analysis) and PCST (Purchase Order S-Line Cost Analysis) screens.

Where Used: JEST; Job Estimates and Performance Report; Order Completion Status; 
Order Cost Variance Status; OVAR

Description
Item Description identifies the item in terms of its characteristics. When space is limited, a 
partial description is displayed. Entry is any alphanumeric combination of up to 70 characters.

Report Title

Order Completion Status
Lists all orders and current status information.
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Where Used: A/P Received Item List; ABCR; Advance Ship Notice Line; APPI; APPV; 
Available Pricing; AVII; AVIT; BILI; BILL; Bill of Material; Bill of Material Detail; Browse Setup 
(item); Capacity Planning; CCAN; CCAT; CMLB; COBK; COCP; COMP; Comparison Bill; 
Comparison of Summarized Bills; Contract Item Detail; Contract Item Detail/Pricing; CORV; 
Cost Estimate by Lot Size; Costed Bill Detail; CSLB; Custom Product Component Detail; 
Customer Item + General; Customer Order; Customer Order Receipt/Reverse; CWIP; 
Demand Peg Detail; Dispatch List; Engineering; FCST; ICCR; IHIR; INVA; Inventory 
Allocation; Inventory History List; Inventory Transaction History Report; INVR; IORD; IPPD; 
ISVI; ITBI; ITCB; ITCI; Item + Alternates; Item + Quantity; Item Availability; Item Availability + 
Quantity; Item Browse; Item Browse Detail; Item History; Item Lot Trace and Serialization 
Detail; Item Master; Item Master Detail; Item Master Planning Detail; Item Responsibility 
Assigned Results; ITMB; ITMC; ITMI; ITPB; ITPI; Job Estimates and Performance Report; 
Lead Time; Lead Time Analysis; Lead Times Assigned Results; LEXP; Line Item Details + 
Item; LMSI; LMST; Location Index; Lot Detail; Lot Inventory Transaction History Report; Lot 
Trace; Lot Trace Issue Detail; Lot Trace Receipt Detail; LOTR; LVAL; Manufacturing Order 
Line Item Detail; Manufacturing Order Receipt/Reverse; Material Exposure; MBIL; MCST; 
MOMI; MOMT; MORI; MORV; MPSR; MPSS; MSMT; Multi-Level Bill; Multi-Level Costed Bill; 
Multi-Level Where Used; MUSE; Open Order Detail; OPSL; Order Completion Status; Order 
Cost Variance Status; Order Detail; Order Line Items; OVAR; Package Content; Packaging 
Detail; Partner Item Detail; PBCI; PBCT; PBII; PICI; PICK; Picklist Detail; POAN; POAS; 
POCI; POCR; POCT; POMI; POMT; PORI; PORR; PORV; POYE; Production; Purchase 
Order Line Item Detail; Purchase Order Line Item Detail (CPMT); Purchase Order Line Items; 
Purchase Order Receipt History; Purchased Component Detail; QSRC; QUOI; QUOT; Router/
Traveler; SDAB; SDAL; Shipment Allocation Detail; Shipments by Line Item; Shipping Detail; 
Shortages by Order; SHPL; Single-Level Configuration Bill of Material Report; SSII; SSIL; 
Standard Costs Assigned Results; Standard Product Detail; Summarized Bill; Supply Peg 
Detail; Transaction Detail; VDII; VDIT; VDSC; VITI; Where Used; WIPR; WUSE

Include Order Status
Include Order Status indicates what type of orders, based on the Ln# Sta, should be 
included in the display. The Include Order Status options are:

4 − Released = Released orders.
5 − Closed = All required receipts or shipments have been made.
6 − Closed = Order closure report has reported this order closure.

Where Used: Order Completion Status; Order Cost Variance Status

Include Order Types
Include Order Types indicates what type of orders should be included in the display. 

Order Cost Variance Status options include:

• Manufacturing to include only manufacturing orders

• PO Supply Line to include only purchase order supply line orders

• Manufacturing and PO Supply Line to include both manufacturing and purchase 
order supply line orders

Order Completion Status options include:

• Manufacturing to include only manufacturing orders
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• Custom Products to include only custom product orders

• Manufacturing and Custom Products to include both manufacturing and custom 
product orders

Where Used: Order Completion Status; Order Cost Variance Status

Item
Item is the unique identifier for a part, whether it be a piece part, tool, raw material, an 
assembly or finished product. All items are set up using the ITMB screen. Within a product 
structure, an item can be a component as well as a parent. Entry is any alphanumeric 
combination of up to 30 characters.

Where Used: A/P Received Item List; ABCR; Advance Ship Notice Line; Allowance/Charge 
Detail (Detail); APPI; APPV; AUDT; Available for Shipping Allocation Batch; AVII; AVIT; Bill of 
Material Accuracy Results; Browse Setup (item); Capacity Planning; CBIL; CCAN; CCAT; 
CIMT; CINV; COAN; COBK; COCD; COMI; COMP; Comparison Bill; Comparison of 
Summarized Bills; COMT; Contract Item Detail; Contract Item Detail/Pricing; Contract 
Summary; CORV; CSTU; Cumulative Detail; Customer Item + General; Customer Order; 
Customer Order Line Price Adjustment; Customer Order Receipt/Reverse; CWIP; Demand 
Peg Detail; Engineering; FCST; GASN; ICCR; IHIR; IMTR; INVA; Inventory Adjustment 
Application; Inventory Allocation; Inventory History List; Inventory Transaction History Report; 
INVR; IORD; IPPD; ISVI; ITBI; ITCB; ITCI; Item + Quantity; Item Availability; Item Availability + 
Quantity; Item Browse; Item Browse Detail; Item History; Item Lot Receipt; Item Lot Trace and 
Serialization Detail; Item Master; Item Master Detail; Item Master Planning Detail; Item 
Responsibility Assigned Results; Item Shortages; ITHC; ITHR; ITMB; ITMC; ITMI; ITPB; ITPI; 
Lead Times Assigned Results; LEXP; LHIS; Line Item Details + Item; LMSI; LMST; Lot Detail; 
Lot Inventory Transaction History Report; Lot Selection; Lot Trace; Lot Trace Issue Detail; Lot 
Trace Receipt Detail; LOTR; LVAL; Manufacturing Order Line Item Detail; Manufacturing 
Order Receipt/Reverse; Material Shortages Detail; MCST; MOAN; MOFR; MOMI; MOMT; 
MORI; MORV; MPIT; MPSR; MPSS; MSMT; Multi-Level Bill; Multi-Level Costed Bill; Multi-
Level Where Used; MUSE; Open Order Detail; Order Completion Status; Order Cost Variance 
Status; Order Detail; OVAR; Package Content; Packaging Detail; Packing List; Partner Item 
Detail; PBCI; PBCT; PBII; PICI; PICK; Picklist Detail; POCI; POCR; POCT; PORI; PORV; 
POYE; Pricing Maintenance + Action Detail; Pricing Maintenance + Action List; Pricing 
Maintenance + Items/Customers; Pricing Maintenance + Test Order; Production; Purchase 
Order Receipt History; Purchased Component Detail; QSRC; QUOI; QUOT; Router/Traveler; 
Schedule Board; SDAB; SDAL; Selection Setup; Serial Number List; Serial Numbers Shipped; 
SHIP; Shipment Allocation Detail; Shipment Allocation List; Shipments by Line Item; Shipping 
Allocation Batch; Shortages by Order; SHPL; SSII; SSIL; Standard Costs Assigned Results; 
Standard Product Detail; Summarized Bill; Supply Peg Detail; Transaction Detail; VDII; VDIT; 
VDSC; VEIT; Vendor/Item Detail; VETI; VITI; VPFR; WIPL; WIPR; WIPS; WUSE

Ln#
Line Number is the identification of a line item on an order. The Line Number is system-
assigned. Entry is up to 3 numbers.

Where Used: A/P Invoice Matching Detail; A/P PO/Inv Variance by Invoice; A/P Receiving 
Detail; Advance Ship Notice Line; Advance Ship Notice Order Detail; APEX; APID; APPI; 
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APPV; APUV; Available for Shipping Allocation Batch; Backflush Issue Reconciliation Report; 
Bill of Material Accuracy Results; Capacity Planning; CCAN; CINV; COAN; COCD; COCP; 
COMI; COMT; CORV; CPMT; CSTU; Custom Product Component Detail; Custom Product 
Detail; Customer Order; Customer Order + Order Header; Customer Order Line Price 
Adjustment; Customer Order Receipt/Reverse; CWIP; Demand Peg Detail; Dispatch List; 
GASN; IHIR; IMTR; Inventory Transaction History Report; IORD; Item Shortages; JEST; Job 
Estimates and Performance Report; LHIS; LMSI; LMST; Location Index; Lot Detail; Lot 
Inventory Transaction History Report; Lot Trace Issue Detail; Lot Trace Receipt Detail; LOTR; 
LRRP; Manufacturing Order Line Item Detail; Manufacturing Order Receipt/Reverse; Material 
Shortages Detail; MCST; MOAN; MOFR; MOMI; MOMT; MORI; MORV; MSMT; Open Order 
Detail; OPSL; Order Completion Status; Order Cost Variance Status; Order Detail; Order Line 
Items; OVAR; Package Content; Packaging Detail; Packing List; PCMT; PCST; PICI; PICK; 
Picklist Detail; POAN; POAS; POMI; POMT; PORI; PORR; PORV; POSR; POVD; Pricing 
Maintenance + Test Order; Purchase Order Line Item Detail; Purchase Order Line Item Detail 
(CPMT); Purchase Order Line Items; Purchased Component Detail; Router/Traveler; 
Schedule Board; SDAB; Serial Number List; SHIP; Shipment Allocation Detail; Shipment 
Allocation List; Shipments by Line Item; Shipping Allocation Batch; Shortages by Order; 
SHPL; STAD; Standard Product Detail; Supply Peg Detail; Transaction Detail; TRUD; VDSC; 
VPFR; WIPL; WIPR; WIPS

Ln# Sta
Line Number Status indicates the item's current position within the order process. Line 
Number Statuses are:

blank = Order Point Quantity Level Reached. 
PREV and MRP have determined that the order point quantity of the item has been 
reached.

1 = MRP Planned Order. 
MRP has automatically planned an order for the item.

2 = Firm Planned. 
The item's order quantity and scheduled date are fixed and are not automatically 
changed.

3 = Open. 
The item's order quantity and scheduled date are fixed. The order-dependent bill of 
material is attached to the item.

4 = Released. 
The item's order quantity and scheduled date are fixed. The order-dependent bill of 
material is attached to the item. The order and picklist can be printed and receipts/
issues can be made.

5 = Closed. 
All required receipts or issues have been made for the item.

6 = Closed. 
The order closure report has reported this order closure.

7 = Closed. 
The order is ready to be deleted from the active file and retained in order history.

Line Number Status can in most cases only be incremented. You can reopen an order, which 
decrements the Line Number Status from 5 to 4. For purchase orders, Line Number Status 
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= 4 can be changed to 3 if no receipts were completed for that line item and the line is not Ln# 
Typ = S.

Where Used: Capacity Planning; CCAN; Demand Peg Detail; Dispatch List; IHIR; Item 
Shortages; Location Index; Manufacturing Order Line Item Detail; Manufacturing Order 
Receipt/Reverse; Material Shortages Detail; MCST; MOAN; MOMI; MOMT; MORI; MORV; 
MSMT; Open Order Detail; Order Completion Status; Order Cost Variance Status; Order Line 
Items; PCST; PICI; PICK; Picklist Detail; POAN; POAS; POMI; POMT; PORI; PORR; PORV; 
Purchase Order Line Item Detail; Purchase Order Line Item Detail (CPMT); Purchase Order 
Line Items; Purchased Component Detail; Router/Traveler; Schedule Board; Shortages by 
Order; Supply Peg Detail; Transaction Detail; WIPL; WIPR; WIPS

Ln# Typ
Line Number Type determines the use of the item order quantity in planning, manufacturing 
and accounting. Line Number Types available depend on the screen where the transaction is 
completed; these include:

B = By-product. 
Created as part of another order.

M = Manufacturing. 
Dependent demands are automatically created.

R = Rework. 
Dependent demands are not automatically created but are manually added.

U = Tool Return. 
Created as part of another order.

X = Custom Product. 
Make-to-order and engineer-to-order products.

Where Used: Capacity Planning; CCAN; Demand Peg Detail; Dispatch List; IHIR; Item 
Shortages; Location Index; Manufacturing Order Line Item Detail; Manufacturing Order 
Receipt/Reverse; Material Shortages Detail; MCST; MOAN; MOMI; MOMT; MORI; MORV; 
Order Completion Status; Order Cost Variance Status; Order Line Items; OVAR; PICI; PICK; 
Picklist Detail; Router/Traveler; Schedule Board; Shortages by Order; Supply Peg Detail; 
WIPL; WIPR; WIPS

Need Date
Need Date is the date the component is needed in the next higher-level assembly. This date is 
calculated by MRP.

Where Used: CORV; Demand Peg Detail; IORD; Location Index; Manufacturing Order Line 
Item Detail; Material Shortages Detail; MCST; MOAN; MOFR; MOMI; MOMT; MORI; MORV; 
MSMT; Order Completion Status; Order Line Items; Router/Traveler; Shortages by Order; 
Supply Peg Detail
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Order No
Order Number is the user-defined identifier for a purchase, manufacturing or customer order. 
Entry is any alphanumeric combination of up to 30 characters.

Where Used: APEX; Backflush Issue Reconciliation Report; Bill of Material Accuracy 
Results; Browse Setup (order); Capacity Planning; CINV; COCP; Dispatch List; EDIX; IHIR; 
IMTR; Inventory Transaction History Report; IORD; Item Shortages; LMSI; LMST; Location 
Index; Lot Detail; Lot Inventory Transaction History Report; Lot Trace Issue Detail; Lot Trace 
Receipt Detail; LOTR; LRRP; MSMT; Order Browse; Order Completion Status; Order Cost 
Variance Status; ORST; OVAR; Router/Traveler; Schedule Board; SDAB; SHIP; Shipment 
Allocation List; Shortages by Order; STAD; TRUD; VDSC

Order Qty
Order Quantity refers to the number of parent items ordered. In the case of dispatch lists 
showing firm, open and released orders, the Order Quantity can refer to the unit completions 
for the workcenter operation if a WC[C] resource item is specified on the order-dependent 
routing. If a WC[C] resource item is not specified, the Order Quantity on the dispatch list 
refers to the number of parent items ordered.

Where Used: Dispatch List; Order Completion Status; Order Cost Variance Status; Router/
Traveler; Shortages by Order

Rcvd Quantity
Quantity Received is the number of units received for an item on an order. Entry is up to 10 
numbers. Default value is 0.

Where Used: A/P Invoice Matching Detail; A/P PO/Inv Variance by Invoice; A/P Receiving 
Detail; APEX; APPI; APPV; APUV; CINV; CSTU; Custom Product Component Detail; Custom 
Product Detail; Customer Order Receipt/Reverse; CWIP; Inventory History List; IORD; Item 
History; ITHR; Line Item Details + Custom Product; Manufacturing Order Receipt/Reverse; 
MCST; Order Completion Status; OVAR; PCST; PORI; PORV; Purchase Order Line Item 
Detail; Purchase Order Line Item Detail (CPMT); Shortages by Order; VDSC; WIPR; WIPS

Sched Date
Scheduled Date is the planned completion date or shipment date for an item.

Where Used: CORV; CSTU; Demand Peg Detail; IORD; Location Index; Manufacturing 
Order Line Item Detail; Material Shortages Detail; MCST; MOAN; MOFR; MOMI; MOMT; 
MORI; MORV; MSMT; Order Completion Status; Order Line Items; Router/Traveler; SDAB; 
Shortages by Order; Supply Peg Detail

Sort Results By
Sort Results By indicates a choice of sort sequence for displayed information. Options 
include:
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Item = Sorts by item identifier.
Order = Sorts by order number.
Variance = Sorts by cost variance amount.

Where Used: Order Completion Status; Order Cost Variance Status

Start Date
Start Date is the date the order must be started so that the required date is met. Start Date is 
MRP-calculated, based on the lead times established for the item on the Item Master. If the 
Start Date is changed by the user, the new Start Date is used by MRP in future calculations 
for the ordered line item.

Where Used: Demand Peg Detail; Location Index; Manufacturing Order Line Item Detail; 
MCST; MOMI; MOMT; MORI; MORV; Order Completion Status; PICI; PICK; Picklist Detail; 
Purchase Order Line Item Detail; Router/Traveler; Shortages by Order; Supply Peg Detail

UM
Unit of Measure identifies the standard unit for an item used in the manufacturing process. 
Entry is up to 4 alphanumeric characters.

Where Used: A/P PO/Inv Variance by Invoice; A/P Receiving Detail; APEX; APPI; APPV; 
APUV; Available for Shipping Allocation Batch; AVII; AVIT; BILI; BILL; Bill of Material; Bill of 
Material Detail; CCAT; CINV; CMLB; COBK; COCP; COMI; COMT; Contract Header Detail; 
Contract Item Detail; Contract Item Detail/Pricing; CORV; Costed Bill Detail; CPMT; CSLB; 
Custom Product Component Detail; Custom Product Detail; Customer Order; Customer Order 
Line Price Adjustment; Customer Order Receipt/Reverse; CWIP; Demand Peg Detail; 
Engineering; FCST; ICCR; IHIR; INVA; Inventory Allocation; INVR; IORD; IPPD; ITBI; ITCB; 
ITCI; Item + Quantity; Item Availability + Quantity; Item Browse Detail; Item History; Item Lot 
Receipt; Item Lot Trace and Serialization Detail; Item Master; Item Master Detail; Item Master 
Planning Detail; Item Responsibility Assigned Results; Item Shortages; ITHC; ITHR; ITMB; 
ITMC; ITMI; ITPB; ITPI; IVPR; IVRR; JEST; Job Estimates and Performance Report; Lead 
Times Assigned Results; LEXP; LHIS; Line Item Details + Item; LMSI; LMST; Location Index; 
Lot Detail; Lot Trace; Lot Trace Issue Detail; Lot Trace Receipt Detail; LOTR; LVAL; 
Manufacturing Order Line Item Detail; Manufacturing Order Receipt/Reverse; Material 
Exposure; MBIL; MCST; MOMI; MOMT; MORI; MORV; MPIT; MPSR; MPSS; MSMT; Multi-
Currency; Multi-Level Bill; Multi-Level Where Used; MUSE; Open Order Detail; OPSL; Order 
Completion Status; Order Cost Variance Status; Order Detail; Order Line Items; OVAR; 
Packaging Detail; Packing List; Partner Item Detail; PBCI; PBCT; PCST; PICI; PICK; Picklist 
Detail; POCI; POCR; POCT; POMI; POMT; PORI; PORR; PORV; POSR; POVD; Pricing 
Maintenance + Action Detail; Pricing Maintenance + Action List; Pricing Maintenance + Test 
Order; Production; Purchase Order Line Item Detail; Purchase Order Line Item Detail (CPMT); 
Purchase Order Line Items; Purchase Order Receipt History; Purchased Component Detail; 
QUOI; QUOT; Router/Traveler; SDAB; SDAL; Shipment Allocation Detail; Shipments by Line 
Item; Shipping Allocation Batch; Shipping Detail; Shortages by Order; SHPL; Single-Level 
Configuration Bill of Material Report; SSII; SSIL; Standard Costs Assigned Results; Standard 
Product Detail; Summarized Bill; Supply Peg Detail; Transaction Detail; VDII; VDIT; VDSC; 
VEIT; Vendor/Item Detail; VETI; VPFR; Where Used; WIPR; Workcenter Master; WUSE
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OCST – Order Cost Variance Status
Order Cost Variance Status helps answer inquiries about costs incurred for released, completed, and 
closed orders. You can specify which order types to include in the list, and you can select to sort results by 
item, order or cost difference amount. Order Cost Variance Status allows you to compare planned costs 
(based on the order-dependent bill/routing) and actual costs incurred to-date, enabling you to focus further 
analysis on problem orders. However, the OCST screen only displays orders that have a Cost Type = 0.

You can view the component costs in the order-dependent bill/routing by selecting to expand certain 
orders. You can use this information to diagnose the source of differences for released and closed orders 
and focus corrective action on specific components that significantly contribute to the difference.

Reports

Order Cost Variance Status Reports
To generate the report, choose Print Preview from the File menu.

Order Cost Variance Detail
Report Description
Lists only the expanded orders and their subordinate component cost records.

Access Method
To generate the report, choose Print Preview from the File menu. 

Report Template
For more information on report templates, see "Reporting for SQL Server Systems" in the System 
Help topics.

Available From
Order Cost Variance Status

Order Cost Variance Status
Report Description
Lists all orders and related cost information to-date, including component costs for expanded 
orders.

Access Method
To generate the report, choose Print Preview from the File menu. 

Report Title

Order Cost Variance Detail
Lists only the expanded orders and their subordinate component cost records.

Order Cost Variance Status
Lists all orders and related cost information to-date, including component costs 
for expanded orders.

Order Cost Variance Summary
Lists all "Included" orders and related cost information to-date using the selected 
sort; subordinate component cost records are not listed.
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Report Template
For more information on report templates, see "Reporting for SQL Server Systems" in the System 
Help topics.

Available From
Order Cost Variance Status

Order Cost Variance Summary
Report Description
Lists all "Included" orders and related cost information to-date using the selected sort; subordinate 
component cost records are not listed.

Access Method
To generate the report, choose Print Preview from the File menu. 

Report Template
For more information on report templates, see "Reporting for SQL Server Systems" in the System 
Help topics

Available From
Order Cost Variance Status

Fields
Actual Cost

Actual Costs are the material, labor, overhead and outside costs incurred to manufacture the 
item to date. Actual Costs are based on the standard cost at the time components are issued. 
The Actual Costs value is the same as the Order Cost value on the MCST (Manufacturing 
Order Cost Analysis) and PCST (Purchase Order S-Line Cost Analysis) screens.

Where Used: JEST; Job Estimates and Performance Report; Order Completion Status; 
Order Cost Variance Status; OVAR

Com Typ
Component Type distinguishes various types of relationships between a component and its 
parent assembly in a bill of material. The Component Type indicates how a component is 
used in the manufacture of a parent. The Component Types are:

N = Normal. 
Component is consumed in the manufacture of its parent.

P = Phantom. 
Component is used for structure purposes only (e.g., a transient subassembly 
consumed in the manufacture of its parent).

R = Resource or Workcenter. 
Component is used in the planning process of the manufacture of its parent (e.g., 
labor hours).

X = Reference. 
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Component is for information purposes. Reference items are included on the picklist. 
Reference items are not included in the parent's rolled costs and are typically not 
required for issue in the manufacturing of the parent.

D = Document. 
Component is used for information purposes only. It is not included on the picklist.

B = By-product. 
The manufacture of the parent results in the creation of this component.

C = Co-product. 
Component is derived from the manufacture of the parent. The manufacture of the co-
product, in turn, produces the parent.

T = Tool. 
Component is used in the manufacture of the parent.

U = Tool return. 
Component is used in, and returned after, the manufacture of the parent.

M = Module. 
Component represents a group of components for which requirements are generated 
for custom product orders. A module component is used for structure purposes only, 
such as a transient subassembly consumed in the manufacture of its parent. Module 
components explode requirements for the child components; the module component 
itself is never required.

V = Purchased material. 
Component not defined on the Item Master is required for a custom product customer 
order.

W = Outside operation or service. 
Component, such as heat treating or plating, is required for a custom product 
customer order.

Y = Phantom parent. 
Requirements have been exploded to the next level to meet requirements.

Z = Phantom child. 
Component is used in the manufacture of the phantoms parent.

An item's use as a component is limited by its Item Type.  The Component Types available 
are based on the information displayed on the screen and not all types are available on all 
screens.

Where Used: BILI; BILL; Bill of Material; Bill of Material Detail; COCP; Comparison Bill; 
Costed Bill Detail; CPMT; CSLB; Custom Product Component Detail; CWIP; Demand Peg 
Detail; Engineering; Job Estimates and Performance Report; Location Index; Material 
Shortages Detail; MBIL; MCST; Multi-Level Bill; OPSL; Order Cost Variance Status; OVAR; 
PCST; Production; Purchased Component Detail; Single-Level Configuration Bill of Material 
Report; Summarized Bill; WIPL; WIPR

Description
Item Description identifies the item in terms of its characteristics. When space is limited, a 
partial description is displayed. Entry is any alphanumeric combination of up to 70 characters.
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Where Used: A/P Received Item List; ABCR; Advance Ship Notice Line; APPI; APPV; 
Available Pricing; AVII; AVIT; BILI; BILL; Bill of Material; Bill of Material Detail; Browse Setup 
(item); Capacity Planning; CCAN; CCAT; CMLB; COBK; COCP; COMP; Comparison Bill; 
Comparison of Summarized Bills; Contract Item Detail; Contract Item Detail/Pricing; CORV; 
Cost Estimate by Lot Size; Costed Bill Detail; CSLB; Custom Product Component Detail; 
Customer Item + General; Customer Order; Customer Order Receipt/Reverse; CWIP; 
Demand Peg Detail; Dispatch List; Engineering; FCST; ICCR; IHIR; INVA; Inventory 
Allocation; Inventory History List; Inventory Transaction History Report; INVR; IORD; IPPD; 
ISVI; ITBI; ITCB; ITCI; Item + Alternates; Item + Quantity; Item Availability; Item Availability + 
Quantity; Item Browse; Item Browse Detail; Item History; Item Lot Trace and Serialization 
Detail; Item Master; Item Master Detail; Item Master Planning Detail; Item Responsibility 
Assigned Results; ITMB; ITMC; ITMI; ITPB; ITPI; Job Estimates and Performance Report; 
Lead Time; Lead Time Analysis; Lead Times Assigned Results; LEXP; Line Item Details + 
Item; LMSI; LMST; Location Index; Lot Detail; Lot Inventory Transaction History Report; Lot 
Trace; Lot Trace Issue Detail; Lot Trace Receipt Detail; LOTR; LVAL; Manufacturing Order 
Line Item Detail; Manufacturing Order Receipt/Reverse; Material Exposure; MBIL; MCST; 
MOMI; MOMT; MORI; MORV; MPSR; MPSS; MSMT; Multi-Level Bill; Multi-Level Costed Bill; 
Multi-Level Where Used; MUSE; Open Order Detail; OPSL; Order Completion Status; Order 
Cost Variance Status; Order Detail; Order Line Items; OVAR; Package Content; Packaging 
Detail; Partner Item Detail; PBCI; PBCT; PBII; PICI; PICK; Picklist Detail; POAN; POAS; 
POCI; POCR; POCT; POMI; POMT; PORI; PORR; PORV; POYE; Production; Purchase 
Order Line Item Detail; Purchase Order Line Item Detail (CPMT); Purchase Order Line Items; 
Purchase Order Receipt History; Purchased Component Detail; QSRC; QUOI; QUOT; Router/
Traveler; SDAB; SDAL; Shipment Allocation Detail; Shipments by Line Item; Shipping Detail; 
Shortages by Order; SHPL; Single-Level Configuration Bill of Material Report; SSII; SSIL; 
Standard Costs Assigned Results; Standard Product Detail; Summarized Bill; Supply Peg 
Detail; Transaction Detail; VDII; VDIT; VDSC; VITI; Where Used; WIPR; WUSE

Difference
Difference to-date is the difference between Planned Costs and Actual Costs incurred to-
date for an order or a workcenter operation.

Where Used: Order Cost Variance Status

Include Order Status
Include Order Status indicates what type of orders, based on the Ln# Sta, should be 
included in the display. The Include Order Status options are:

4 − Released = Released orders.
5 − Closed = All required receipts or shipments have been made.
6 − Closed = Order closure report has reported this order closure.

Where Used: Order Completion Status; Order Cost Variance Status

Include Order Types
Include Order Types indicates what type of orders should be included in the display. 
Shop Floor Reporting 86



Fourth Shift Release 8.00 OCST – Order Cost Variance Status
Order Cost Variance Status options include:

• Manufacturing to include only manufacturing orders

• PO Supply Line to include only purchase order supply line orders

• Manufacturing and PO Supply Line to include both manufacturing and purchase 
order supply line orders

Order Completion Status options include:

• Manufacturing to include only manufacturing orders

• Custom Products to include only custom product orders

• Manufacturing and Custom Products to include both manufacturing and custom 
product orders

Where Used: Order Completion Status; Order Cost Variance Status

Item
Item is the unique identifier for a part, whether it be a piece part, tool, raw material, an 
assembly or finished product. All items are set up using the ITMB screen. Within a product 
structure, an item can be a component as well as a parent. Entry is any alphanumeric 
combination of up to 30 characters.

Where Used: A/P Received Item List; ABCR; Advance Ship Notice Line; Allowance/Charge 
Detail (Detail); APPI; APPV; AUDT; Available for Shipping Allocation Batch; AVII; AVIT; Bill of 
Material Accuracy Results; Browse Setup (item); Capacity Planning; CBIL; CCAN; CCAT; 
CIMT; CINV; COAN; COBK; COCD; COMI; COMP; Comparison Bill; Comparison of 
Summarized Bills; COMT; Contract Item Detail; Contract Item Detail/Pricing; Contract 
Summary; CORV; CSTU; Cumulative Detail; Customer Item + General; Customer Order; 
Customer Order Line Price Adjustment; Customer Order Receipt/Reverse; CWIP; Demand 
Peg Detail; Engineering; FCST; GASN; ICCR; IHIR; IMTR; INVA; Inventory Adjustment 
Application; Inventory Allocation; Inventory History List; Inventory Transaction History Report; 
INVR; IORD; IPPD; ISVI; ITBI; ITCB; ITCI; Item + Quantity; Item Availability; Item Availability + 
Quantity; Item Browse; Item Browse Detail; Item History; Item Lot Receipt; Item Lot Trace and 
Serialization Detail; Item Master; Item Master Detail; Item Master Planning Detail; Item 
Responsibility Assigned Results; Item Shortages; ITHC; ITHR; ITMB; ITMC; ITMI; ITPB; ITPI; 
Lead Times Assigned Results; LEXP; LHIS; Line Item Details + Item; LMSI; LMST; Lot Detail; 
Lot Inventory Transaction History Report; Lot Selection; Lot Trace; Lot Trace Issue Detail; Lot 
Trace Receipt Detail; LOTR; LVAL; Manufacturing Order Line Item Detail; Manufacturing 
Order Receipt/Reverse; Material Shortages Detail; MCST; MOAN; MOFR; MOMI; MOMT; 
MORI; MORV; MPIT; MPSR; MPSS; MSMT; Multi-Level Bill; Multi-Level Costed Bill; Multi-
Level Where Used; MUSE; Open Order Detail; Order Completion Status; Order Cost Variance 
Status; Order Detail; OVAR; Package Content; Packaging Detail; Packing List; Partner Item 
Detail; PBCI; PBCT; PBII; PICI; PICK; Picklist Detail; POCI; POCR; POCT; PORI; PORV; 
POYE; Pricing Maintenance + Action Detail; Pricing Maintenance + Action List; Pricing 
Maintenance + Items/Customers; Pricing Maintenance + Test Order; Production; Purchase 
Order Receipt History; Purchased Component Detail; QSRC; QUOI; QUOT; Router/Traveler; 
Schedule Board; SDAB; SDAL; Selection Setup; Serial Number List; Serial Numbers Shipped; 
SHIP; Shipment Allocation Detail; Shipment Allocation List; Shipments by Line Item; Shipping 
Allocation Batch; Shortages by Order; SHPL; SSII; SSIL; Standard Costs Assigned Results; 
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Standard Product Detail; Summarized Bill; Supply Peg Detail; Transaction Detail; VDII; VDIT; 
VDSC; VEIT; Vendor/Item Detail; VETI; VITI; VPFR; WIPL; WIPR; WIPS; WUSE

Ln#
Line Number is the identification of a line item on an order. The Line Number is system-
assigned. Entry is up to 3 numbers.

Where Used: A/P Invoice Matching Detail; A/P PO/Inv Variance by Invoice; A/P Receiving 
Detail; Advance Ship Notice Line; Advance Ship Notice Order Detail; APEX; APID; APPI; 
APPV; APUV; Available for Shipping Allocation Batch; Backflush Issue Reconciliation Report; 
Bill of Material Accuracy Results; Capacity Planning; CCAN; CINV; COAN; COCD; COCP; 
COMI; COMT; CORV; CPMT; CSTU; Custom Product Component Detail; Custom Product 
Detail; Customer Order; Customer Order + Order Header; Customer Order Line Price 
Adjustment; Customer Order Receipt/Reverse; CWIP; Demand Peg Detail; Dispatch List; 
GASN; IHIR; IMTR; Inventory Transaction History Report; IORD; Item Shortages; JEST; Job 
Estimates and Performance Report; LHIS; LMSI; LMST; Location Index; Lot Detail; Lot 
Inventory Transaction History Report; Lot Trace Issue Detail; Lot Trace Receipt Detail; LOTR; 
LRRP; Manufacturing Order Line Item Detail; Manufacturing Order Receipt/Reverse; Material 
Shortages Detail; MCST; MOAN; MOFR; MOMI; MOMT; MORI; MORV; MSMT; Open Order 
Detail; OPSL; Order Completion Status; Order Cost Variance Status; Order Detail; Order Line 
Items; OVAR; Package Content; Packaging Detail; Packing List; PCMT; PCST; PICI; PICK; 
Picklist Detail; POAN; POAS; POMI; POMT; PORI; PORR; PORV; POSR; POVD; Pricing 
Maintenance + Test Order; Purchase Order Line Item Detail; Purchase Order Line Item Detail 
(CPMT); Purchase Order Line Items; Purchased Component Detail; Router/Traveler; 
Schedule Board; SDAB; Serial Number List; SHIP; Shipment Allocation Detail; Shipment 
Allocation List; Shipments by Line Item; Shipping Allocation Batch; Shortages by Order; 
SHPL; STAD; Standard Product Detail; Supply Peg Detail; Transaction Detail; TRUD; VDSC; 
VPFR; WIPL; WIPR; WIPS

Ln# Sta
Line Number Status indicates the item's current position within the order process. Line 
Number Statuses are:

blank = Order Point Quantity Level Reached. 
PREV and MRP have determined that the order point quantity of the item has been 
reached.

1 = MRP Planned Order. 
MRP has automatically planned an order for the item.

2 = Firm Planned. 
The item's order quantity and scheduled date are fixed and are not automatically 
changed.

3 = Open. 
The item's order quantity and scheduled date are fixed. The order-dependent bill of 
material is attached to the item.

4 = Released. 
The item's order quantity and scheduled date are fixed. The order-dependent bill of 
material is attached to the item. The order and picklist can be printed and receipts/
issues can be made.
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5 = Closed. 
All required receipts or issues have been made for the item.

6 = Closed. 
The order closure report has reported this order closure.

7 = Closed. 
The order is ready to be deleted from the active file and retained in order history.

Line Number Status can in most cases only be incremented. You can reopen an order, which 
decrements the Line Number Status from 5 to 4. For purchase orders, Line Number Status 
= 4 can be changed to 3 if no receipts were completed for that line item and the line is not Ln# 
Typ = S.

Where Used: Capacity Planning; CCAN; Demand Peg Detail; Dispatch List; IHIR; Item 
Shortages; Location Index; Manufacturing Order Line Item Detail; Manufacturing Order 
Receipt/Reverse; Material Shortages Detail; MCST; MOAN; MOMI; MOMT; MORI; MORV; 
MSMT; Open Order Detail; Order Completion Status; Order Cost Variance Status; Order Line 
Items; PCST; PICI; PICK; Picklist Detail; POAN; POAS; POMI; POMT; PORI; PORR; PORV; 
Purchase Order Line Item Detail; Purchase Order Line Item Detail (CPMT); Purchase Order 
Line Items; Purchased Component Detail; Router/Traveler; Schedule Board; Shortages by 
Order; Supply Peg Detail; Transaction Detail; WIPL; WIPR; WIPS

Ln# Typ
Line Number Type determines the use of the item order quantity in planning, manufacturing 
and accounting. Line Number Types available depend on the screen where the transaction is 
completed; these include:

B = By-product. 
Created as part of another order.

M = Manufacturing. 
Dependent demands are automatically created.

R = Rework. 
Dependent demands are not automatically created but are manually added.

U = Tool Return. 
Created as part of another order.

X = Custom Product. 
Make-to-order and engineer-to-order products.

Where Used: Capacity Planning; CCAN; Demand Peg Detail; Dispatch List; IHIR; Item 
Shortages; Location Index; Manufacturing Order Line Item Detail; Manufacturing Order 
Receipt/Reverse; Material Shortages Detail; MCST; MOAN; MOMI; MOMT; MORI; MORV; 
Order Completion Status; Order Cost Variance Status; Order Line Items; OVAR; PICI; PICK; 
Picklist Detail; Router/Traveler; Schedule Board; Shortages by Order; Supply Peg Detail; 
WIPL; WIPR; WIPS
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Order No
Order Number is the user-defined identifier for a purchase, manufacturing or customer order. 
Entry is any alphanumeric combination of up to 30 characters.

Where Used: APEX; Backflush Issue Reconciliation Report; Bill of Material Accuracy 
Results; Browse Setup (order); Capacity Planning; CINV; COCP; Dispatch List; EDIX; IHIR; 
IMTR; Inventory Transaction History Report; IORD; Item Shortages; LMSI; LMST; Location 
Index; Lot Detail; Lot Inventory Transaction History Report; Lot Trace Issue Detail; Lot Trace 
Receipt Detail; LOTR; LRRP; MSMT; Order Browse; Order Completion Status; Order Cost 
Variance Status; ORST; OVAR; Router/Traveler; Schedule Board; SDAB; SHIP; Shipment 
Allocation List; Shortages by Order; STAD; TRUD; VDSC

Order Qty
Order Quantity refers to the number of parent items ordered. In the case of dispatch lists 
showing firm, open and released orders, the Order Quantity can refer to the unit completions 
for the workcenter operation if a WC[C] resource item is specified on the order-dependent 
routing. If a WC[C] resource item is not specified, the Order Quantity on the dispatch list 
refers to the number of parent items ordered.

Where Used: Dispatch List; Order Completion Status; Order Cost Variance Status; Router/
Traveler; Shortages by Order

Planned Cost
Planned Costs are the material, labor, overhead and outside costs expected to be incurred to 
manufacture the item based on the order-dependent bill and routing. In comparison, Standard 
Costs are based on the standard bill and routing for the item.

Where Used: JEST; Job Estimates and Performance Report; Order Cost Variance Status

Pt Use
Point of Use is a key field that, along with the Seqn field, defines the sort sequence of 
components in a bill of material. The Point of Use field accepts any information you choose to 
enter, but the intended use is to identify the "work center" where the component should be 
delivered when assembling the parent, the "find number" of the component referenced on the 
drawing for the parent, or the "component reference designator" of the component on a printed 
circuit board. If the Point of Use field is not applicable in your company, you may enter 0 
(zero). Entry is any alphanumeric combination of up to 5 characters.

Where Used: BILI; BILL; Bill of Material; Bill of Material Detail; Capacity Planning; 
Comparison Bill; Custom Product Component Detail; Demand Peg Detail; Dispatch List; 
Engineering; Exceptions; Job Estimates and Performance Report; Lead Time; Location Index; 
LRRP; Material Shortages Detail; MBIL; Multi-Level Bill; Multi-Level Where Used; MUSE; 
Order Cost Variance Status; OVAR; PICI; PICK; Picklist Detail; Pricing Maintenance + Test 
Order; Production; Purchase Order Line Item Detail; Purchase Order Line Item Detail (CPMT); 
Router/Traveler; Schedule Board; Single-Level Configuration Bill of Material Report; TRUD; 
Where Used; WUSE
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Qty Rcvd/Issued
Quantity Received or Issued is the number of units received for a parent item or issued to a 
component for an order.

Where Used: Order Cost Variance Status

Received Cost
Received Cost is the value of the parent at the time it is received. The Received Cost value 
is the same as the Order Total value on the MCST (Manufacturing Order Cost Analysis) and 
PCST (Purchase Order S-Line Cost Analysis) screens. Entry is up to 10 numbers.

Where Used: CWIP; Order Cost Variance Status; WIPR

Seqn
Sequence Number is a key field that, along with the Pt Use field, defines the sort sequence of 
components in a bill of material. The field accepts any information you choose to enter, but the 
intended purpose is to identify the operation sequence number on the parent’s routing that 
calls out the component. If the Sequence Number is not applicable in your company, you may 
enter 0 (zero). Entry is up to 3 numbers.

Where Used: Backflush Issue Reconciliation Report; BILI; BILL; Bill of Material; Bill of 
Material Detail; Capacity Planning; CINV; COCP; Comparison Bill; CPMT; Custom Product 
Component Detail; CWIP; Demand Peg Detail; Dispatch List; Engineering; Exceptions; Job 
Estimates and Performance Report; Lead Time; Location Index; LRRP; Material Shortages 
Detail; MBIL; MCST; Multi-Level Bill; Multi-Level Where Used; MUSE; OPSL; Order Cost 
Variance Status; OVAR; PCST; PICI; PICK; Picklist Detail; PORI; PORV; Production; 
Purchase Order Line Item Detail; Purchase Order Line Item Detail (CPMT); Purchased 
Component Detail; Router/Traveler; Schedule Board; Single-Level Configuration Bill of 
Material Report; TRUD; Where Used; WIPL; WIPR; WUSE

Sort Results By
Sort Results By indicates a choice of sort sequence for displayed information. Options 
include:

Item = Sorts by item identifier.
Order = Sorts by order number.
Variance = Sorts by cost variance amount.

Where Used: Order Completion Status; Order Cost Variance Status

Total Roll Cost
Total Rolled Cost represents the total cost to manufacture an item. It is the sum of the item’s 
rolled costs for material, labor, fixed overhead, variable overhead and Costs Added at This 
Level. Total rolled costs are calculated by cost type.
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Where Used: ABCR; CMLB; COMP; Costed Bill Detail; CSLB; INVR; ITCI; ITMC; Order 
Cost Variance Status; SSII

UM
Unit of Measure identifies the standard unit for an item used in the manufacturing process. 
Entry is up to 4 alphanumeric characters.

Where Used: A/P PO/Inv Variance by Invoice; A/P Receiving Detail; APEX; APPI; APPV; 
APUV; Available for Shipping Allocation Batch; AVII; AVIT; BILI; BILL; Bill of Material; Bill of 
Material Detail; CCAT; CINV; CMLB; COBK; COCP; COMI; COMT; Contract Header Detail; 
Contract Item Detail; Contract Item Detail/Pricing; CORV; Costed Bill Detail; CPMT; CSLB; 
Custom Product Component Detail; Custom Product Detail; Customer Order; Customer Order 
Line Price Adjustment; Customer Order Receipt/Reverse; CWIP; Demand Peg Detail; 
Engineering; FCST; ICCR; IHIR; INVA; Inventory Allocation; INVR; IORD; IPPD; ITBI; ITCB; 
ITCI; Item + Quantity; Item Availability + Quantity; Item Browse Detail; Item History; Item Lot 
Receipt; Item Lot Trace and Serialization Detail; Item Master; Item Master Detail; Item Master 
Planning Detail; Item Responsibility Assigned Results; Item Shortages; ITHC; ITHR; ITMB; 
ITMC; ITMI; ITPB; ITPI; IVPR; IVRR; JEST; Job Estimates and Performance Report; Lead 
Times Assigned Results; LEXP; LHIS; Line Item Details + Item; LMSI; LMST; Location Index; 
Lot Detail; Lot Trace; Lot Trace Issue Detail; Lot Trace Receipt Detail; LOTR; LVAL; 
Manufacturing Order Line Item Detail; Manufacturing Order Receipt/Reverse; Material 
Exposure; MBIL; MCST; MOMI; MOMT; MORI; MORV; MPIT; MPSR; MPSS; MSMT; Multi-
Currency; Multi-Level Bill; Multi-Level Where Used; MUSE; Open Order Detail; OPSL; Order 
Completion Status; Order Cost Variance Status; Order Detail; Order Line Items; OVAR; 
Packaging Detail; Packing List; Partner Item Detail; PBCI; PBCT; PCST; PICI; PICK; Picklist 
Detail; POCI; POCR; POCT; POMI; POMT; PORI; PORR; PORV; POSR; POVD; Pricing 
Maintenance + Action Detail; Pricing Maintenance + Action List; Pricing Maintenance + Test 
Order; Production; Purchase Order Line Item Detail; Purchase Order Line Item Detail (CPMT); 
Purchase Order Line Items; Purchase Order Receipt History; Purchased Component Detail; 
QUOI; QUOT; Router/Traveler; SDAB; SDAL; Shipment Allocation Detail; Shipments by Line 
Item; Shipping Allocation Batch; Shipping Detail; Shortages by Order; SHPL; Single-Level 
Configuration Bill of Material Report; SSII; SSIL; Standard Costs Assigned Results; Standard 
Product Detail; Summarized Bill; Supply Peg Detail; Transaction Detail; VDII; VDIT; VDSC; 
VEIT; Vendor/Item Detail; VETI; VPFR; Where Used; WIPR; Workcenter Master; WUSE
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ROUT – Router/Traveler
Router/Traveler lists each operation, and the associated setup and run load, in the routing for the specified 
order. You can select to view the material list, outside services, routing or tools pertaining to the order. 
Router/Traveler allows you to preview routing information prior to printing the shop paperwork.

You can record labor and resource utilization by selecting a specific operation and entering information 
into the Workcenter Labor Reporting dialog. Labor activity information can be entered at the end of each 
shift or at the end of each day.

Reports

Router/Traveler Reports
To generate the report, choose Print Preview from the File menu.

Router / Traveler – All Types
Report Description
Lists the routing, outside services, tools and material pick list components for an order.

Access Method
To generate the report, choose Print Preview from the File menu. 

Report Template
For more information on report templates, see "Reporting for SQL Server Systems" in the System 
Help topics.

Available From
Router/Traveler

Router / Traveler – Material List
Report Description
Lists the material pick list components (Component Types = N, M, P, V, Y, Z) for an order.

Report Title

Router / Traveler -- All Types
Lists the routing, outside services, tools and material pick list components for an 
order.

Router / Traveler -- Material List
Lists the material pick list components (Component Types = N, M, P, V, Y, Z) for 
an order.

Router / Traveler -- Outside Services List
Lists the outside services pick list components (Component Type = W) for a cus-
tom product order.

Router / Traveler -- Routing List
Lists the routing pick list components (WC[R]) for an order.

Router / Traveler -- Tools List
Lists the tools pick list components (Component Type = T) for an order.
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Access Method
To generate the report, choose Print Preview from the File menu. 

Report Template
For more information on report templates, see "Reporting for SQL Server Systems" in the System 
Help topics.

Available From
Router/Traveler

Router / Traveler – Outside Services List
Report Description
Lists the outside services pick list components (Component Type = W) for a custom product order.

Access Method
To generate the report, choose Print Preview from the File menu. 

Report Template
For more information on report templates, see "Reporting for SQL Server Systems" in the System 
Help topics.

Available From
Router/Traveler

Router / Traveler – Routing List
Report Description
Lists the routing pick list components (WC[R]) for an order.

Access Method
To generate the report, choose Print Preview from the File menu. 

Report Template
For more information on report templates, see "Reporting for SQL Server Systems" in the System 
Help topics.

Available From
Router/Traveler

Router / Traveler – Tools List
Report Description
Lists the tools pick list components (Component Type = T) for an order.

Access Method
To generate the report, choose Print Preview from the File menu. 

Report Template
For more information on report templates, see "Reporting for SQL Server Systems" in the System 
Help topics.

Available From
Router/Traveler
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Fields
Avail Qty

Available Quantity is the number of items that can be issued to orders. Available Quantity 
for the item is the sum of:

[On-Hand + (In-Inspection * Yield)] - (Total Allocations for this 
item - Required Quantity for this order)

Where Used: Material Shortages Detail; Order Detail; Router/Traveler

Completion Text
Text Description are the unique words that have been entered for the resource or component 
for descriptive purposes.

Where Used: Router/Traveler

Component
Component is a term that describes the structural relationship between an item and its parent 
assembly in a bill of material. A Component is used in the manufacture of a parent, and it may 
be a part, raw material or a subassembly. Entry is any alphanumeric combination of up to 30 
characters.

Where Used: Backflush Issue Reconciliation Report; BILI; BILL; Bill of Material; Bill of 
Material Detail; CMLB; COCP; Comparison Bill; Comparison of Summarized Bills; Costed Bill 
Detail; CPMT; CSLB; Custom Product Component Detail; Demand Peg Detail; Engineering; 
Exceptions; Job Estimates and Performance Report; Lead Time; Location Index; Material 
Exposure; Material Shortages Detail; MBIL; MCST; Multi-Level Bill; Multi-Level Costed Bill; 
Multi-Level Where Used; MUSE; OPSL; OVAR; PCST; PICI; PICK; Picklist Detail; Production; 
Router/Traveler; Single-Level Configuration Bill of Material Report; Summarized Bill; Where 
Used; WUSE

Component Text
Text Description are the unique words that have been entered for the resource or component 
for descriptive purposes.

Where Used: Router/Traveler

Description
Description (outside service) identifies the outside operation or service, such as heat 
treating or plating, in terms of its characteristics.

Where Used: Router/Traveler
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Description
Item Description identifies the item in terms of its characteristics. When space is limited, a 
partial description is displayed. Entry is any alphanumeric combination of up to 70 characters.

Where Used: A/P Received Item List; ABCR; Advance Ship Notice Line; APPI; APPV; 
Available Pricing; AVII; AVIT; BILI; BILL; Bill of Material; Bill of Material Detail; Browse Setup 
(item); Capacity Planning; CCAN; CCAT; CMLB; COBK; COCP; COMP; Comparison Bill; 
Comparison of Summarized Bills; Contract Item Detail; Contract Item Detail/Pricing; CORV; 
Cost Estimate by Lot Size; Costed Bill Detail; CSLB; Custom Product Component Detail; 
Customer Item + General; Customer Order; Customer Order Receipt/Reverse; CWIP; 
Demand Peg Detail; Dispatch List; Engineering; FCST; ICCR; IHIR; INVA; Inventory 
Allocation; Inventory History List; Inventory Transaction History Report; INVR; IORD; IPPD; 
ISVI; ITBI; ITCB; ITCI; Item + Alternates; Item + Quantity; Item Availability; Item Availability + 
Quantity; Item Browse; Item Browse Detail; Item History; Item Lot Trace and Serialization 
Detail; Item Master; Item Master Detail; Item Master Planning Detail; Item Responsibility 
Assigned Results; ITMB; ITMC; ITMI; ITPB; ITPI; Job Estimates and Performance Report; 
Lead Time; Lead Time Analysis; Lead Times Assigned Results; LEXP; Line Item Details + 
Item; LMSI; LMST; Location Index; Lot Detail; Lot Inventory Transaction History Report; Lot 
Trace; Lot Trace Issue Detail; Lot Trace Receipt Detail; LOTR; LVAL; Manufacturing Order 
Line Item Detail; Manufacturing Order Receipt/Reverse; Material Exposure; MBIL; MCST; 
MOMI; MOMT; MORI; MORV; MPSR; MPSS; MSMT; Multi-Level Bill; Multi-Level Costed Bill; 
Multi-Level Where Used; MUSE; Open Order Detail; OPSL; Order Completion Status; Order 
Cost Variance Status; Order Detail; Order Line Items; OVAR; Package Content; Packaging 
Detail; Partner Item Detail; PBCI; PBCT; PBII; PICI; PICK; Picklist Detail; POAN; POAS; 
POCI; POCR; POCT; POMI; POMT; PORI; PORR; PORV; POYE; Production; Purchase 
Order Line Item Detail; Purchase Order Line Item Detail (CPMT); Purchase Order Line Items; 
Purchase Order Receipt History; Purchased Component Detail; QSRC; QUOI; QUOT; Router/
Traveler; SDAB; SDAL; Shipment Allocation Detail; Shipments by Line Item; Shipping Detail; 
Shortages by Order; SHPL; Single-Level Configuration Bill of Material Report; SSII; SSIL; 
Standard Costs Assigned Results; Standard Product Detail; Summarized Bill; Supply Peg 
Detail; Transaction Detail; VDII; VDIT; VDSC; VITI; Where Used; WIPR; WUSE

Drwg
Drawing number identifies an engineering document that provides design specifications for 
an item. Entry is any alphanumeric combination of up to 30 characters.

Where Used: AVII; AVIT; BILI; BILL; Bill of Material; Bill of Material Detail; Engineering; Item 
Browse Detail; Item Master; Item Master Detail; MBIL; Multi-Level Bill; Multi-Level Where 
Used; Production; QUOI; QUOT; Router/Traveler; Shortages by Order; Single-Level 
Configuration Bill of Material Report; Summarized Bill; Where Used

Gateway WC
Gateway Workcenter identifies the starting point for a manufactured item. The gateway 
workcenter is defined on the Location Master as the Bin identifier and must have a Stk 
identifier of WC.

Where Used: Browse Setup (order); CCAN; Demand Peg Detail; Item Browse Detail; Item 
Master Planning Detail; Lot Trace Issue Detail; Lot Trace Receipt Detail; Manufacturing Order 
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Line Item Detail; Manufacturing Order Receipt/Reverse; Material Shortages Detail; MCST; 
MOAN; MOFR; MOMI; MOMT; MORI; MORV; MSMT; Order Browse; ORST; PICI; PICK; 
Picklist Detail; Production; Router/Traveler; Shortages by Order; Supply Peg Detail

Item
Item is the unique identifier for a part, whether it be a piece part, tool, raw material, an 
assembly or finished product. All items are set up using the ITMB screen. Within a product 
structure, an item can be a component as well as a parent. Entry is any alphanumeric 
combination of up to 30 characters.

Where Used: A/P Received Item List; ABCR; Advance Ship Notice Line; Allowance/Charge 
Detail (Detail); APPI; APPV; AUDT; Available for Shipping Allocation Batch; AVII; AVIT; Bill of 
Material Accuracy Results; Browse Setup (item); Capacity Planning; CBIL; CCAN; CCAT; 
CIMT; CINV; COAN; COBK; COCD; COMI; COMP; Comparison Bill; Comparison of 
Summarized Bills; COMT; Contract Item Detail; Contract Item Detail/Pricing; Contract 
Summary; CORV; CSTU; Cumulative Detail; Customer Item + General; Customer Order; 
Customer Order Line Price Adjustment; Customer Order Receipt/Reverse; CWIP; Demand 
Peg Detail; Engineering; FCST; GASN; ICCR; IHIR; IMTR; INVA; Inventory Adjustment 
Application; Inventory Allocation; Inventory History List; Inventory Transaction History Report; 
INVR; IORD; IPPD; ISVI; ITBI; ITCB; ITCI; Item + Quantity; Item Availability; Item Availability + 
Quantity; Item Browse; Item Browse Detail; Item History; Item Lot Receipt; Item Lot Trace and 
Serialization Detail; Item Master; Item Master Detail; Item Master Planning Detail; Item 
Responsibility Assigned Results; Item Shortages; ITHC; ITHR; ITMB; ITMC; ITMI; ITPB; ITPI; 
Lead Times Assigned Results; LEXP; LHIS; Line Item Details + Item; LMSI; LMST; Lot Detail; 
Lot Inventory Transaction History Report; Lot Selection; Lot Trace; Lot Trace Issue Detail; Lot 
Trace Receipt Detail; LOTR; LVAL; Manufacturing Order Line Item Detail; Manufacturing 
Order Receipt/Reverse; Material Shortages Detail; MCST; MOAN; MOFR; MOMI; MOMT; 
MORI; MORV; MPIT; MPSR; MPSS; MSMT; Multi-Level Bill; Multi-Level Costed Bill; Multi-
Level Where Used; MUSE; Open Order Detail; Order Completion Status; Order Cost Variance 
Status; Order Detail; OVAR; Package Content; Packaging Detail; Packing List; Partner Item 
Detail; PBCI; PBCT; PBII; PICI; PICK; Picklist Detail; POCI; POCR; POCT; PORI; PORV; 
POYE; Pricing Maintenance + Action Detail; Pricing Maintenance + Action List; Pricing 
Maintenance + Items/Customers; Pricing Maintenance + Test Order; Production; Purchase 
Order Receipt History; Purchased Component Detail; QSRC; QUOI; QUOT; Router/Traveler; 
Schedule Board; SDAB; SDAL; Selection Setup; Serial Number List; Serial Numbers Shipped; 
SHIP; Shipment Allocation Detail; Shipment Allocation List; Shipments by Line Item; Shipping 
Allocation Batch; Shortages by Order; SHPL; SSII; SSIL; Standard Costs Assigned Results; 
Standard Product Detail; Summarized Bill; Supply Peg Detail; Transaction Detail; VDII; VDIT; 
VDSC; VEIT; Vendor/Item Detail; VETI; VITI; VPFR; WIPL; WIPR; WIPS; WUSE

Ln#
Line Number is the identification of a line item on an order. The Line Number is system-
assigned. Entry is up to 3 numbers.

Where Used: A/P Invoice Matching Detail; A/P PO/Inv Variance by Invoice; A/P Receiving 
Detail; Advance Ship Notice Line; Advance Ship Notice Order Detail; APEX; APID; APPI; 
APPV; APUV; Available for Shipping Allocation Batch; Backflush Issue Reconciliation Report; 
Bill of Material Accuracy Results; Capacity Planning; CCAN; CINV; COAN; COCD; COCP; 
COMI; COMT; CORV; CPMT; CSTU; Custom Product Component Detail; Custom Product 
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Detail; Customer Order; Customer Order + Order Header; Customer Order Line Price 
Adjustment; Customer Order Receipt/Reverse; CWIP; Demand Peg Detail; Dispatch List; 
GASN; IHIR; IMTR; Inventory Transaction History Report; IORD; Item Shortages; JEST; Job 
Estimates and Performance Report; LHIS; LMSI; LMST; Location Index; Lot Detail; Lot 
Inventory Transaction History Report; Lot Trace Issue Detail; Lot Trace Receipt Detail; LOTR; 
LRRP; Manufacturing Order Line Item Detail; Manufacturing Order Receipt/Reverse; Material 
Shortages Detail; MCST; MOAN; MOFR; MOMI; MOMT; MORI; MORV; MSMT; Open Order 
Detail; OPSL; Order Completion Status; Order Cost Variance Status; Order Detail; Order Line 
Items; OVAR; Package Content; Packaging Detail; Packing List; PCMT; PCST; PICI; PICK; 
Picklist Detail; POAN; POAS; POMI; POMT; PORI; PORR; PORV; POSR; POVD; Pricing 
Maintenance + Test Order; Purchase Order Line Item Detail; Purchase Order Line Item Detail 
(CPMT); Purchase Order Line Items; Purchased Component Detail; Router/Traveler; 
Schedule Board; SDAB; Serial Number List; SHIP; Shipment Allocation Detail; Shipment 
Allocation List; Shipments by Line Item; Shipping Allocation Batch; Shortages by Order; 
SHPL; STAD; Standard Product Detail; Supply Peg Detail; Transaction Detail; TRUD; VDSC; 
VPFR; WIPL; WIPR; WIPS

Ln# Sta
Line Number Status indicates the item's current position within the order process. Line 
Number Statuses are:

blank = Order Point Quantity Level Reached. 
PREV and MRP have determined that the order point quantity of the item has been 
reached.

1 = MRP Planned Order. 
MRP has automatically planned an order for the item.

2 = Firm Planned. 
The item's order quantity and scheduled date are fixed and are not automatically 
changed.

3 = Open. 
The item's order quantity and scheduled date are fixed. The order-dependent bill of 
material is attached to the item.

4 = Released. 
The item's order quantity and scheduled date are fixed. The order-dependent bill of 
material is attached to the item. The order and picklist can be printed and receipts/
issues can be made.

5 = Closed. 
All required receipts or issues have been made for the item.

6 = Closed. 
The order closure report has reported this order closure.

7 = Closed. 
The order is ready to be deleted from the active file and retained in order history.

Line Number Status can in most cases only be incremented. You can reopen an order, which 
decrements the Line Number Status from 5 to 4. For purchase orders, Line Number Status 
= 4 can be changed to 3 if no receipts were completed for that line item and the line is not Ln# 
Typ = S.
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Where Used: Capacity Planning; CCAN; Demand Peg Detail; Dispatch List; IHIR; Item 
Shortages; Location Index; Manufacturing Order Line Item Detail; Manufacturing Order 
Receipt/Reverse; Material Shortages Detail; MCST; MOAN; MOMI; MOMT; MORI; MORV; 
MSMT; Open Order Detail; Order Completion Status; Order Cost Variance Status; Order Line 
Items; PCST; PICI; PICK; Picklist Detail; POAN; POAS; POMI; POMT; PORI; PORR; PORV; 
Purchase Order Line Item Detail; Purchase Order Line Item Detail (CPMT); Purchase Order 
Line Items; Purchased Component Detail; Router/Traveler; Schedule Board; Shortages by 
Order; Supply Peg Detail; Transaction Detail; WIPL; WIPR; WIPS

Ln# Typ
Line Number Type determines the use of the item order quantity in planning, manufacturing 
and accounting. Line Number Types available depend on the screen where the transaction is 
completed; these include:

B = By-product. 
Created as part of another order.

M = Manufacturing. 
Dependent demands are automatically created.

R = Rework. 
Dependent demands are not automatically created but are manually added.

U = Tool Return. 
Created as part of another order.

X = Custom Product. 
Make-to-order and engineer-to-order products.

Where Used: Capacity Planning; CCAN; Demand Peg Detail; Dispatch List; IHIR; Item 
Shortages; Location Index; Manufacturing Order Line Item Detail; Manufacturing Order 
Receipt/Reverse; Material Shortages Detail; MCST; MOAN; MOMI; MOMT; MORI; MORV; 
Order Completion Status; Order Cost Variance Status; Order Line Items; OVAR; PICI; PICK; 
Picklist Detail; Router/Traveler; Schedule Board; Shortages by Order; Supply Peg Detail; 
WIPL; WIPR; WIPS

Need Date
Need Date is the date the component is needed in the next higher-level assembly. This date is 
calculated by MRP.

Where Used: CORV; Demand Peg Detail; IORD; Location Index; Manufacturing Order Line 
Item Detail; Material Shortages Detail; MCST; MOAN; MOFR; MOMI; MOMT; MORI; MORV; 
MSMT; Order Completion Status; Order Line Items; Router/Traveler; Shortages by Order; 
Supply Peg Detail

Option
Option indicates the choice of display format. Options are:

Material = Material list
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Where Used: Router/Traveler

Order No
Order Number is the user-defined identifier for a purchase, manufacturing or customer order. 
Entry is any alphanumeric combination of up to 30 characters.

Where Used: APEX; Backflush Issue Reconciliation Report; Bill of Material Accuracy 
Results; Browse Setup (order); Capacity Planning; CINV; COCP; Dispatch List; EDIX; IHIR; 
IMTR; Inventory Transaction History Report; IORD; Item Shortages; LMSI; LMST; Location 
Index; Lot Detail; Lot Inventory Transaction History Report; Lot Trace Issue Detail; Lot Trace 
Receipt Detail; LOTR; LRRP; MSMT; Order Browse; Order Completion Status; Order Cost 
Variance Status; ORST; OVAR; Router/Traveler; Schedule Board; SDAB; SHIP; Shipment 
Allocation List; Shortages by Order; STAD; TRUD; VDSC

Order Qty
Order Quantity refers to the number of parent items ordered. In the case of dispatch lists 
showing firm, open and released orders, the Order Quantity can refer to the unit completions 
for the workcenter operation if a WC[C] resource item is specified on the order-dependent 
routing. If a WC[C] resource item is not specified, the Order Quantity on the dispatch list 
refers to the number of parent items ordered.

Where Used: Dispatch List; Order Completion Status; Order Cost Variance Status; Router/
Traveler; Shortages by Order

Order Rev Date
Order Revision Date is the date of the last change made to the order. The Order Revision 
Date is changed to the system date when the order is revised and helps to clarify 
communication.

Where Used: Order Browse; ORST; Router/Traveler; Shortages by Order

Order Status
Order Status indicates the order's current position within the order process. Order Status is 
automatically displayed for an order, based on the line number status of the line items 
attached to the order. The order status is the highest status of any of the active line items. 
When all line items are closed, the order changes to complete or closed. Order Statuses are:

1 = Preliminary. 

Outside Services = Outside Services list

Routing = Routing list

Tools = Tool list
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The order header is identified and basic information is entered.

2 = Firm Planned. 
All active line items have a Ln# Sta = 2 (firm planned).

3 = Open. 
The highest Ln# Sta of all active line items is 3 (open).

4 = Released. 
Paperwork is produced and receipts or issues can be made for at least one of the line 
items. The highest active Ln# Sta = 4 (released).

5, 6, 7 = Complete or Closed. 
All required receipts, shipments or issues have been made for all the line items. 
Adding a line item to a completed order changes the Order Status to REL. All order 
line items are closed (Ln# Sta = 5, 6 or 7).

9 = Credit Hold. 
The customer's credit limit has been exceeded or the order is placed on hold for 
another reason. The item is treated as an open order.

Where Used: COMI; COMT; Contract Purchase Orders; CORV; CPMT; Custom Product 
Component Detail; Custom Product Detail; Customer Order + Order Header; Customer Order 
Header Detail; Customer Order Receipt/Reverse; EDIX; IORD; JEST; Job Estimates and 
Performance Report; Manufacturing Order Line Item Detail; Manufacturing Order Receipt/
Reverse; MCST; MOMI; MOMT; MORI; MORV; OPSL; Order Browse; ORST; PCST; PICI; 
PICK; Picklist Detail; POMI; POMT; PORI; PORV; Purchase Order Header Detail; Purchase 
Order Line Item Detail (CPMT); Router/Traveler; Shortages by Order; Standard Product 
Detail; WIPR

Outside Svc
Outside Service is the identifier for the outside operation or service, such as heat treating or 
plating, required for a custom product order.

Where Used: Router/Traveler

Plnr
Planner code is used to identify the person responsible for planning the production or usage 
of an item. The suggested entry is the planner's initials. Entry is any alphanumeric 
combination of up to 3 characters.

Where Used: ABCR; AVII; AVIT; BILI; BILL; Bill of Material; Bill of Material Detail; Buyer/
Planner Code Maintenance; Custom Product Detail; CWIP; Demand Peg Detail; IORD; IPPD; 
Item Browse Detail; Item Master; Item Master Planning Detail; Item Responsibility Assigned 
Results; ITHC; Lead Times Assigned Results; Line Item Details + Custom Product; 
Manufacturing Order Line Item Detail; Manufacturing Order Receipt/Reverse; Material 
Shortages Detail; MBIL; MCST; MOAN; MOMI; MOMT; MORI; MORV; MPSR; MSCF; MSMT; 
Multi-Level Bill; Multi-Level Where Used; ORST; OVAR; PICI; PICK; Picklist Detail; 
Production; Purchase Order Line Item Detail; QUOI; QUOT; Router/Traveler; SDAB; 
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Shortages by Order; Single-Level Configuration Bill of Material Report; SSII; Standard Costs 
Assigned Results; Summarized Bill; Where Used; WIPR; Workcenter Master

Pt Use
Point of Use is a key field that, along with the Seqn field, defines the sort sequence of 
components in a bill of material. The Point of Use field accepts any information you choose to 
enter, but the intended use is to identify the "work center" where the component should be 
delivered when assembling the parent, the "find number" of the component referenced on the 
drawing for the parent, or the "component reference designator" of the component on a printed 
circuit board. If the Point of Use field is not applicable in your company, you may enter 0 
(zero). Entry is any alphanumeric combination of up to 5 characters.

Where Used: BILI; BILL; Bill of Material; Bill of Material Detail; Capacity Planning; 
Comparison Bill; Custom Product Component Detail; Demand Peg Detail; Dispatch List; 
Engineering; Exceptions; Job Estimates and Performance Report; Lead Time; Location Index; 
LRRP; Material Shortages Detail; MBIL; Multi-Level Bill; Multi-Level Where Used; MUSE; 
Order Cost Variance Status; OVAR; PICI; PICK; Picklist Detail; Pricing Maintenance + Test 
Order; Production; Purchase Order Line Item Detail; Purchase Order Line Item Detail (CPMT); 
Router/Traveler; Schedule Board; Single-Level Configuration Bill of Material Report; TRUD; 
Where Used; WUSE

Reqd Date
Required Date is the date the component item is needed for the assembly of the line item, 
taking lead time offset into consideration.

Where Used: Item Shortages; Material Shortages Detail; OPSL; Picklist Detail; Pricing 
Maintenance + Test Order; Router/Traveler; Shortages by Order

Reqd Qty
Required Quantity is the number of component items required for the parent item. Entry is up 
to 10 numbers. Decimal places are allowed.

Where Used: Capacity Planning; Custom Product Component Detail; Item Shortages; 
Location Index; Material Shortages Detail; Picklist Detail; Purchase Order Line Item Detail 
(CPMT); Router/Traveler; Schedule Board; Shortages by Order

Rev
Revision Level identifies a level of documentation which specifies the item's design. It should 
be incremented for each change in the item's design specifications. Entry is any alphanumeric 
combination of up to 2 characters.

Where Used: AVII; AVIT; BILI; BILL; Bill of Material; Bill of Material Detail; Costed Bill Detail; 
Demand Peg Detail; Engineering; FCST; ICCR; IORD; IPPD; Item Browse Detail; Item 
History; Item Lot Trace and Serialization Detail; Item Master; Item Master Detail; Item Master 
Planning Detail; ITMB; ITMI; LMSI; LMST; Lot Detail; Lot Trace; MBIL; MPSR; MPSS; MSMT; 
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Multi-Level Bill; Multi-Level Where Used; PBCI; PBCT; Production; QUOI; QUOT; Router/
Traveler; SDAB; SDAL; Shortages by Order; Single-Level Configuration Bill of Material 
Report; Summarized Bill; Supply Peg Detail; Where Used

Run Load
Run Load indicates the remaining run time to complete the workcenter operation, and is the 
Bal Due times the per-unit run-time hours on the routing.

Where Used: Capacity Planning; Dispatch List; Location Index; Router/Traveler; Schedule 
Board

Run Text
Text Description are the unique words that have been entered for the resource or component 
for descriptive purposes.

Where Used: Router/Traveler

Sched Date
Scheduled Date is the planned completion date or shipment date for an item.

Where Used: CORV; CSTU; Demand Peg Detail; IORD; Location Index; Manufacturing 
Order Line Item Detail; Material Shortages Detail; MCST; MOAN; MOFR; MOMI; MOMT; 
MORI; MORV; MSMT; Order Completion Status; Order Line Items; Router/Traveler; SDAB; 
Shortages by Order; Supply Peg Detail

Seqn
Sequence Number is a key field that, along with the Pt Use field, defines the sort sequence of 
components in a bill of material. The field accepts any information you choose to enter, but the 
intended purpose is to identify the operation sequence number on the parent’s routing that 
calls out the component. If the Sequence Number is not applicable in your company, you may 
enter 0 (zero). Entry is up to 3 numbers.

Where Used: Backflush Issue Reconciliation Report; BILI; BILL; Bill of Material; Bill of 
Material Detail; Capacity Planning; CINV; COCP; Comparison Bill; CPMT; Custom Product 
Component Detail; CWIP; Demand Peg Detail; Dispatch List; Engineering; Exceptions; Job 
Estimates and Performance Report; Lead Time; Location Index; LRRP; Material Shortages 
Detail; MBIL; MCST; Multi-Level Bill; Multi-Level Where Used; MUSE; OPSL; Order Cost 
Variance Status; OVAR; PCST; PICI; PICK; Picklist Detail; PORI; PORV; Production; 
Purchase Order Line Item Detail; Purchase Order Line Item Detail (CPMT); Purchased 
Component Detail; Router/Traveler; Schedule Board; Single-Level Configuration Bill of 
Material Report; TRUD; Where Used; WIPL; WIPR; WUSE

Set Up
Setup Hours indicates the remaining setup time to complete the workcenter operation.
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Where Used: Router/Traveler

Setup Text
Text Description are the unique words that have been entered for the resource or component 
for descriptive purposes.

Where Used: Router/Traveler

Start Date
Start Date is the date the order must be started so that the required date is met. Start Date is 
MRP-calculated, based on the lead times established for the item on the Item Master. If the 
Start Date is changed by the user, the new Start Date is used by MRP in future calculations 
for the ordered line item.

Where Used: Demand Peg Detail; Location Index; Manufacturing Order Line Item Detail; 
MCST; MOMI; MOMT; MORI; MORV; Order Completion Status; PICI; PICK; Picklist Detail; 
Purchase Order Line Item Detail; Router/Traveler; Shortages by Order; Supply Peg Detail

UM
Unit of Measure identifies the standard unit for an item used in the manufacturing process. 
Entry is up to 4 alphanumeric characters.

Where Used: A/P PO/Inv Variance by Invoice; A/P Receiving Detail; APEX; APPI; APPV; 
APUV; Available for Shipping Allocation Batch; AVII; AVIT; BILI; BILL; Bill of Material; Bill of 
Material Detail; CCAT; CINV; CMLB; COBK; COCP; COMI; COMT; Contract Header Detail; 
Contract Item Detail; Contract Item Detail/Pricing; CORV; Costed Bill Detail; CPMT; CSLB; 
Custom Product Component Detail; Custom Product Detail; Customer Order; Customer Order 
Line Price Adjustment; Customer Order Receipt/Reverse; CWIP; Demand Peg Detail; 
Engineering; FCST; ICCR; IHIR; INVA; Inventory Allocation; INVR; IORD; IPPD; ITBI; ITCB; 
ITCI; Item + Quantity; Item Availability + Quantity; Item Browse Detail; Item History; Item Lot 
Receipt; Item Lot Trace and Serialization Detail; Item Master; Item Master Detail; Item Master 
Planning Detail; Item Responsibility Assigned Results; Item Shortages; ITHC; ITHR; ITMB; 
ITMC; ITMI; ITPB; ITPI; IVPR; IVRR; JEST; Job Estimates and Performance Report; Lead 
Times Assigned Results; LEXP; LHIS; Line Item Details + Item; LMSI; LMST; Location Index; 
Lot Detail; Lot Trace; Lot Trace Issue Detail; Lot Trace Receipt Detail; LOTR; LVAL; 
Manufacturing Order Line Item Detail; Manufacturing Order Receipt/Reverse; Material 
Exposure; MBIL; MCST; MOMI; MOMT; MORI; MORV; MPIT; MPSR; MPSS; MSMT; Multi-
Currency; Multi-Level Bill; Multi-Level Where Used; MUSE; Open Order Detail; OPSL; Order 
Completion Status; Order Cost Variance Status; Order Detail; Order Line Items; OVAR; 
Packaging Detail; Packing List; Partner Item Detail; PBCI; PBCT; PCST; PICI; PICK; Picklist 
Detail; POCI; POCR; POCT; POMI; POMT; PORI; PORR; PORV; POSR; POVD; Pricing 
Maintenance + Action Detail; Pricing Maintenance + Action List; Pricing Maintenance + Test 
Order; Production; Purchase Order Line Item Detail; Purchase Order Line Item Detail (CPMT); 
Purchase Order Line Items; Purchase Order Receipt History; Purchased Component Detail; 
QUOI; QUOT; Router/Traveler; SDAB; SDAL; Shipment Allocation Detail; Shipments by Line 
Item; Shipping Allocation Batch; Shipping Detail; Shortages by Order; SHPL; Single-Level 
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Configuration Bill of Material Report; SSII; SSIL; Standard Costs Assigned Results; Standard 
Product Detail; Summarized Bill; Supply Peg Detail; Transaction Detail; VDII; VDIT; VDSC; 
VEIT; Vendor/Item Detail; VETI; VPFR; Where Used; WIPR; Workcenter Master; WUSE

Workcenter
Workcenter is the identifier for a specific production facility, consisting of one or more people 
and/or machines, which can be considered as one unit for the purposes of capacity planning, 
scheduling and costing. If the SFRM Module is installed, workcenters are defined on the 
Workcenter Master. If the SFRM Module is not installed, workcenters are established on the 
Item Master as resource items. The workcenter's run, setup and completion records define 
how the workcenter should be used when constructing the bills of material.

When the workcenter is displayed on the Item Master, a five-character prefix is added to the 
workcenter name. Prefixes include:

WC[R] = Run-time hours for workcenter operations
WC[S] = Setup hours for the workcenter operations
WC[C] = Unit completions for run-time operations at the workcenter

Workcenter entry is any alphanumeric combination of up to 10 characters.

Where Used: Capacity Planning; Dispatch List; Location Index; Router/Traveler; Schedule 
Board; Workcenter Master

Workcenter Description
Workcenter Description is the description of the workcenter for a manufactured item. Entry is 
any alphanumeric combination of up to 29 characters.

Where Used: CWIP; Manufacturing Order Line Item Detail; Manufacturing Order Receipt/
Reverse; MCST; MOMI; MOMT; MORI; MORV; Order Browse; ORST; PICI; PICK; Picklist 
Detail; Router/Traveler; WIPR; Workcenter Master
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SCBD – Schedule Board
Schedule Board enables the scheduler to coordinate manufacturing activities and perform manual 
scheduling. With user-defined views to highlight scheduler responsibilities, the Schedule Board displays 
the load for selected work centers and selected orders.

• Selected work centers.  The upper panels of the Schedule Board list the selected work 
centers, and displays a Gantt chart of operations loaded on each work center. The Gantt chart 
uses daily increments for a user-specified time horizon, and uses color codes to indicate which 
days are overloaded or underutilized. You can drill-down to the orders comprising the work 
center load for a given day. 

• Selected orders.  The lower panels of the Schedule Board list the selected orders and 
(optionally) the routing operations for an order. It displays a Gantt chart of the order duration, 
and the dates for each operation. To manually schedule an order, you can modify operation 
due dates (using the Routing Detail dialog to specify operation dates) and order duration 
(using the Order Detail dialog to specify start and end dates). You can also modify operation 
dates and order duration using mouse drag-and-drop features.

• User-defined views.  You can save a view of selected work centers and orders using a user-
specified view name. Views can be designated as local or global views. You can refresh the 
data in a view to display the latest scheduling information.

Schedule Board relies on the communication of data maintained and used by other modules in the Fourth 
Shift system. Changes made to the schedule board update the Fourth Shift database and therefore affect 
other modules. 

Fields
Avail Qty

Available Quantity of Units indicates the number of units completed at the Prior 
Workcenter available for processing at the specified workcenter operation.

Where Used: Capacity Planning; Dispatch List; Location Index; Schedule Board

Complete Qty
Units Completed indicates the number of units reported as complete at a specified 
workcenter operation.

Where Used: Capacity Planning; Location Index; Schedule Board

Include MRP Planned Requirements
Include MRP Planned Requirements indicates whether planned orders (Ln# Sta = 1) should 
be included in the display. Options are:

Yes = Include planned orders.
No = Do not include planned orders.
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Where Used: Dispatch List; Schedule Board

Item
Item is the unique identifier for a part, whether it be a piece part, tool, raw material, an 
assembly or finished product. All items are set up using the ITMB screen. Within a product 
structure, an item can be a component as well as a parent. Entry is any alphanumeric 
combination of up to 30 characters.

Where Used: A/P Received Item List; ABCR; Advance Ship Notice Line; Allowance/Charge 
Detail (Detail); APPI; APPV; AUDT; Available for Shipping Allocation Batch; AVII; AVIT; Bill of 
Material Accuracy Results; Browse Setup (item); Capacity Planning; CBIL; CCAN; CCAT; 
CIMT; CINV; COAN; COBK; COCD; COMI; COMP; Comparison Bill; Comparison of 
Summarized Bills; COMT; Contract Item Detail; Contract Item Detail/Pricing; Contract 
Summary; CORV; CSTU; Cumulative Detail; Customer Item + General; Customer Order; 
Customer Order Line Price Adjustment; Customer Order Receipt/Reverse; CWIP; Demand 
Peg Detail; Engineering; FCST; GASN; ICCR; IHIR; IMTR; INVA; Inventory Adjustment 
Application; Inventory Allocation; Inventory History List; Inventory Transaction History Report; 
INVR; IORD; IPPD; ISVI; ITBI; ITCB; ITCI; Item + Quantity; Item Availability; Item Availability + 
Quantity; Item Browse; Item Browse Detail; Item History; Item Lot Receipt; Item Lot Trace and 
Serialization Detail; Item Master; Item Master Detail; Item Master Planning Detail; Item 
Responsibility Assigned Results; Item Shortages; ITHC; ITHR; ITMB; ITMC; ITMI; ITPB; ITPI; 
Lead Times Assigned Results; LEXP; LHIS; Line Item Details + Item; LMSI; LMST; Lot Detail; 
Lot Inventory Transaction History Report; Lot Selection; Lot Trace; Lot Trace Issue Detail; Lot 
Trace Receipt Detail; LOTR; LVAL; Manufacturing Order Line Item Detail; Manufacturing 
Order Receipt/Reverse; Material Shortages Detail; MCST; MOAN; MOFR; MOMI; MOMT; 
MORI; MORV; MPIT; MPSR; MPSS; MSMT; Multi-Level Bill; Multi-Level Costed Bill; Multi-
Level Where Used; MUSE; Open Order Detail; Order Completion Status; Order Cost Variance 
Status; Order Detail; OVAR; Package Content; Packaging Detail; Packing List; Partner Item 
Detail; PBCI; PBCT; PBII; PICI; PICK; Picklist Detail; POCI; POCR; POCT; PORI; PORV; 
POYE; Pricing Maintenance + Action Detail; Pricing Maintenance + Action List; Pricing 
Maintenance + Items/Customers; Pricing Maintenance + Test Order; Production; Purchase 
Order Receipt History; Purchased Component Detail; QSRC; QUOI; QUOT; Router/Traveler; 
Schedule Board; SDAB; SDAL; Selection Setup; Serial Number List; Serial Numbers Shipped; 
SHIP; Shipment Allocation Detail; Shipment Allocation List; Shipments by Line Item; Shipping 
Allocation Batch; Shortages by Order; SHPL; SSII; SSIL; Standard Costs Assigned Results; 
Standard Product Detail; Summarized Bill; Supply Peg Detail; Transaction Detail; VDII; VDIT; 
VDSC; VEIT; Vendor/Item Detail; VETI; VITI; VPFR; WIPL; WIPR; WIPS; WUSE

Ln#
Line Number is the identification of a line item on an order. The Line Number is system-
assigned. Entry is up to 3 numbers.

Where Used: A/P Invoice Matching Detail; A/P PO/Inv Variance by Invoice; A/P Receiving 
Detail; Advance Ship Notice Line; Advance Ship Notice Order Detail; APEX; APID; APPI; 
APPV; APUV; Available for Shipping Allocation Batch; Backflush Issue Reconciliation Report; 
Bill of Material Accuracy Results; Capacity Planning; CCAN; CINV; COAN; COCD; COCP; 
COMI; COMT; CORV; CPMT; CSTU; Custom Product Component Detail; Custom Product 
Detail; Customer Order; Customer Order + Order Header; Customer Order Line Price 
Adjustment; Customer Order Receipt/Reverse; CWIP; Demand Peg Detail; Dispatch List; 
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GASN; IHIR; IMTR; Inventory Transaction History Report; IORD; Item Shortages; JEST; Job 
Estimates and Performance Report; LHIS; LMSI; LMST; Location Index; Lot Detail; Lot 
Inventory Transaction History Report; Lot Trace Issue Detail; Lot Trace Receipt Detail; LOTR; 
LRRP; Manufacturing Order Line Item Detail; Manufacturing Order Receipt/Reverse; Material 
Shortages Detail; MCST; MOAN; MOFR; MOMI; MOMT; MORI; MORV; MSMT; Open Order 
Detail; OPSL; Order Completion Status; Order Cost Variance Status; Order Detail; Order Line 
Items; OVAR; Package Content; Packaging Detail; Packing List; PCMT; PCST; PICI; PICK; 
Picklist Detail; POAN; POAS; POMI; POMT; PORI; PORR; PORV; POSR; POVD; Pricing 
Maintenance + Test Order; Purchase Order Line Item Detail; Purchase Order Line Item Detail 
(CPMT); Purchase Order Line Items; Purchased Component Detail; Router/Traveler; 
Schedule Board; SDAB; Serial Number List; SHIP; Shipment Allocation Detail; Shipment 
Allocation List; Shipments by Line Item; Shipping Allocation Batch; Shortages by Order; 
SHPL; STAD; Standard Product Detail; Supply Peg Detail; Transaction Detail; TRUD; VDSC; 
VPFR; WIPL; WIPR; WIPS

Ln# Sta
Line Number Status indicates the item's current position within the order process. Line 
Number Statuses are:

blank = Order Point Quantity Level Reached. 
PREV and MRP have determined that the order point quantity of the item has been 
reached.

1 = MRP Planned Order. 
MRP has automatically planned an order for the item.

2 = Firm Planned. 
The item's order quantity and scheduled date are fixed and are not automatically 
changed.

3 = Open. 
The item's order quantity and scheduled date are fixed. The order-dependent bill of 
material is attached to the item.

4 = Released. 
The item's order quantity and scheduled date are fixed. The order-dependent bill of 
material is attached to the item. The order and picklist can be printed and receipts/
issues can be made.

5 = Closed. 
All required receipts or issues have been made for the item.

6 = Closed. 
The order closure report has reported this order closure.

7 = Closed. 
The order is ready to be deleted from the active file and retained in order history.

Line Number Status can in most cases only be incremented. You can reopen an order, which 
decrements the Line Number Status from 5 to 4. For purchase orders, Line Number Status 
= 4 can be changed to 3 if no receipts were completed for that line item and the line is not Ln# 
Typ = S.
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Where Used: Capacity Planning; CCAN; Demand Peg Detail; Dispatch List; IHIR; Item 
Shortages; Location Index; Manufacturing Order Line Item Detail; Manufacturing Order 
Receipt/Reverse; Material Shortages Detail; MCST; MOAN; MOMI; MOMT; MORI; MORV; 
MSMT; Open Order Detail; Order Completion Status; Order Cost Variance Status; Order Line 
Items; PCST; PICI; PICK; Picklist Detail; POAN; POAS; POMI; POMT; PORI; PORR; PORV; 
Purchase Order Line Item Detail; Purchase Order Line Item Detail (CPMT); Purchase Order 
Line Items; Purchased Component Detail; Router/Traveler; Schedule Board; Shortages by 
Order; Supply Peg Detail; Transaction Detail; WIPL; WIPR; WIPS

Ln# Typ
Line Number Type determines the use of the item order quantity in planning, manufacturing 
and accounting. Line Number Types available depend on the screen where the transaction is 
completed; these include:

B = By-product. 
Created as part of another order.

M = Manufacturing. 
Dependent demands are automatically created.

R = Rework. 
Dependent demands are not automatically created but are manually added.

U = Tool Return. 
Created as part of another order.

X = Custom Product. 
Make-to-order and engineer-to-order products.

Where Used: Capacity Planning; CCAN; Demand Peg Detail; Dispatch List; IHIR; Item 
Shortages; Location Index; Manufacturing Order Line Item Detail; Manufacturing Order 
Receipt/Reverse; Material Shortages Detail; MCST; MOAN; MOMI; MOMT; MORI; MORV; 
Order Completion Status; Order Cost Variance Status; Order Line Items; OVAR; PICI; PICK; 
Picklist Detail; Router/Traveler; Schedule Board; Shortages by Order; Supply Peg Detail; 
WIPL; WIPR; WIPS

Number of Days
Number of Days identifies how many days are displayed on the schedule board. Entry is 
between 1 and 365 days.

Where Used: Schedule Board

Oper Date
Operation Due Date is system-calculated for planned orders based on the order start date 
plus the component's lead time offset, where the order start date is based on the order due 
date minus the parent's lead time. After creating an order-dependent routing (e.g., for opened 
or released orders), the Operation Due Date can be modified on the Picklist Detail screen. 
For custom products, the Operation Due Date can also be modified on the CPMT screen.
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Where Used: Capacity Planning; Dispatch List; Location Index; Schedule Board

Order No
Order Number is the user-defined identifier for a purchase, manufacturing or customer order. 
Entry is any alphanumeric combination of up to 30 characters.

Where Used: APEX; Backflush Issue Reconciliation Report; Bill of Material Accuracy 
Results; Browse Setup (order); Capacity Planning; CINV; COCP; Dispatch List; EDIX; IHIR; 
IMTR; Inventory Transaction History Report; IORD; Item Shortages; LMSI; LMST; Location 
Index; Lot Detail; Lot Inventory Transaction History Report; Lot Trace Issue Detail; Lot Trace 
Receipt Detail; LOTR; LRRP; MSMT; Order Browse; Order Completion Status; Order Cost 
Variance Status; ORST; OVAR; Router/Traveler; Schedule Board; SDAB; SHIP; Shipment 
Allocation List; Shortages by Order; STAD; TRUD; VDSC

Pt Use
Point of Use is a key field that, along with the Seqn field, defines the sort sequence of 
components in a bill of material. The Point of Use field accepts any information you choose to 
enter, but the intended use is to identify the "work center" where the component should be 
delivered when assembling the parent, the "find number" of the component referenced on the 
drawing for the parent, or the "component reference designator" of the component on a printed 
circuit board. If the Point of Use field is not applicable in your company, you may enter 0 
(zero). Entry is any alphanumeric combination of up to 5 characters.

Where Used: BILI; BILL; Bill of Material; Bill of Material Detail; Capacity Planning; 
Comparison Bill; Custom Product Component Detail; Demand Peg Detail; Dispatch List; 
Engineering; Exceptions; Job Estimates and Performance Report; Lead Time; Location Index; 
LRRP; Material Shortages Detail; MBIL; Multi-Level Bill; Multi-Level Where Used; MUSE; 
Order Cost Variance Status; OVAR; PICI; PICK; Picklist Detail; Pricing Maintenance + Test 
Order; Production; Purchase Order Line Item Detail; Purchase Order Line Item Detail (CPMT); 
Router/Traveler; Schedule Board; Single-Level Configuration Bill of Material Report; TRUD; 
Where Used; WUSE

Reqd Quantity
Required Quantity is the number of component items required for the parent item. Entry is up 
to 10 numbers. Decimal places are allowed.

Where Used: Capacity Planning; Custom Product Component Detail; Item Shortages; 
Location Index; Material Shortages Detail; Picklist Detail; Purchase Order Line Item Detail 
(CPMT); Router/Traveler; Schedule Board; Shortages by Order

Run Load
Run Load indicates the remaining run time to complete the workcenter operation, and is the 
Bal Due times the per-unit run-time hours on the routing.
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Where Used: Capacity Planning; Dispatch List; Location Index; Router/Traveler; Schedule 
Board

Seqn
Sequence Number is a key field that, along with the Pt Use field, defines the sort sequence of 
components in a bill of material. The field accepts any information you choose to enter, but the 
intended purpose is to identify the operation sequence number on the parent’s routing that 
calls out the component. If the Sequence Number is not applicable in your company, you may 
enter 0 (zero). Entry is up to 3 numbers.

Where Used: Backflush Issue Reconciliation Report; BILI; BILL; Bill of Material; Bill of 
Material Detail; Capacity Planning; CINV; COCP; Comparison Bill; CPMT; Custom Product 
Component Detail; CWIP; Demand Peg Detail; Dispatch List; Engineering; Exceptions; Job 
Estimates and Performance Report; Lead Time; Location Index; LRRP; Material Shortages 
Detail; MBIL; MCST; Multi-Level Bill; Multi-Level Where Used; MUSE; OPSL; Order Cost 
Variance Status; OVAR; PCST; PICI; PICK; Picklist Detail; PORI; PORV; Production; 
Purchase Order Line Item Detail; Purchase Order Line Item Detail (CPMT); Purchased 
Component Detail; Router/Traveler; Schedule Board; Single-Level Configuration Bill of 
Material Report; TRUD; Where Used; WIPL; WIPR; WUSE

Set Up
Setup Status indicates whether any time has been reported against the workcenter setup 
operation. The Setup Status options are:

Yes = Time has already been reported against the setup operation.
blank = No workcenter setup item WC[S] exists for this operation.

Where Used: Capacity Planning; Dispatch List; Location Index; Schedule Board; 
Workcenter Master

Start Date
Start Date specifies the first period that should be displayed when requesting an analysis, 
such as the first column of stacked bar charts on the Capacity Planning screen.

Where Used: Capacity Planning; Schedule Board

Workcenter
Workcenter is the identifier for a specific production facility, consisting of one or more people 
and/or machines, which can be considered as one unit for the purposes of capacity planning, 
scheduling and costing. If the SFRM Module is installed, workcenters are defined on the 
Workcenter Master. If the SFRM Module is not installed, workcenters are established on the 
Item Master as resource items. The workcenter's run, setup and completion records define 
how the workcenter should be used when constructing the bills of material.

When the workcenter is displayed on the Item Master, a five-character prefix is added to the 
workcenter name. Prefixes include:

WC[R] = Run-time hours for workcenter operations
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WC[S] = Setup hours for the workcenter operations
WC[C] = Unit completions for run-time operations at the workcenter

Workcenter entry is any alphanumeric combination of up to 10 characters.

Where Used: Capacity Planning; Dispatch List; Location Index; Router/Traveler; Schedule 
Board; Workcenter Master

Workcenter Load
Operation Due Date is system-calculated for planned orders based on the order start date 
plus the component's lead time offset, where the order start date is based on the order due 
date minus the parent's lead time. After creating an order-dependent routing (e.g., for opened 
or released orders), the Operation Due Date can be modified on the Picklist Detail screen. 
For custom products, the Operation Due Date can also be modified on the CPMT screen.

Where Used: Capacity Planning; Dispatch List; Location Index; Schedule Board
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SHOR – Shortages by Order
Shortages by Order allows you to view material shortages for a specified order. For each item, the quantity 
not yet issued and the total allocations, as well as stock status and on-order information is displayed. Use 
this information as an expediting tool, since the system generates recommended action messages on the 
Buyer and Planner Action screen to expedite these shortages to meet the manufacturing plan.

You can double-click on any item (that is required on other orders) to open the Other Orders Requiring 
Item dialog to help resolve order allocation priorities and expedite order completion. The open and 
released orders requiring the specified component item are displayed, along with the quantity required and 
issued for the component, the short quantity and the required date for each order.

Reports

Shortages by Order Reports
To generate the report, choose Print Preview from the File menu.

Report Description
Lists all components not yet picked for an order.

Access Method
To generate the report, choose Print Preview from the File menu. 

Report Template
This report is not a template-based report.

Available From
Shortages by Order

Shortages by Order – Other Orders Requiring Item
Report Description
Lists all components not yet picked for an order as well as other orders waiting for the item.

Access Method
To generate the report, choose Print Preview from the File menu. 

Report Template
This report is not a template-based report.

Available From
Shortages by Order

Report Title

Shortages by Order
Lists all components not yet picked for an order.

Shortages by Order -- Other Orders Requiring Item
Lists all components not yet picked for an order as well as other orders waiting 
for the item.
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Fields
Description

Item Description identifies the item in terms of its characteristics. When space is limited, a 
partial description is displayed. Entry is any alphanumeric combination of up to 70 characters.

Where Used: A/P Received Item List; ABCR; Advance Ship Notice Line; APPI; APPV; 
Available Pricing; AVII; AVIT; BILI; BILL; Bill of Material; Bill of Material Detail; Browse Setup 
(item); Capacity Planning; CCAN; CCAT; CMLB; COBK; COCP; COMP; Comparison Bill; 
Comparison of Summarized Bills; Contract Item Detail; Contract Item Detail/Pricing; CORV; 
Cost Estimate by Lot Size; Costed Bill Detail; CSLB; Custom Product Component Detail; 
Customer Item + General; Customer Order; Customer Order Receipt/Reverse; CWIP; 
Demand Peg Detail; Dispatch List; Engineering; FCST; ICCR; IHIR; INVA; Inventory 
Allocation; Inventory History List; Inventory Transaction History Report; INVR; IORD; IPPD; 
ISVI; ITBI; ITCB; ITCI; Item + Alternates; Item + Quantity; Item Availability; Item Availability + 
Quantity; Item Browse; Item Browse Detail; Item History; Item Lot Trace and Serialization 
Detail; Item Master; Item Master Detail; Item Master Planning Detail; Item Responsibility 
Assigned Results; ITMB; ITMC; ITMI; ITPB; ITPI; Job Estimates and Performance Report; 
Lead Time; Lead Time Analysis; Lead Times Assigned Results; LEXP; Line Item Details + 
Item; LMSI; LMST; Location Index; Lot Detail; Lot Inventory Transaction History Report; Lot 
Trace; Lot Trace Issue Detail; Lot Trace Receipt Detail; LOTR; LVAL; Manufacturing Order 
Line Item Detail; Manufacturing Order Receipt/Reverse; Material Exposure; MBIL; MCST; 
MOMI; MOMT; MORI; MORV; MPSR; MPSS; MSMT; Multi-Level Bill; Multi-Level Costed Bill; 
Multi-Level Where Used; MUSE; Open Order Detail; OPSL; Order Completion Status; Order 
Cost Variance Status; Order Detail; Order Line Items; OVAR; Package Content; Packaging 
Detail; Partner Item Detail; PBCI; PBCT; PBII; PICI; PICK; Picklist Detail; POAN; POAS; 
POCI; POCR; POCT; POMI; POMT; PORI; PORR; PORV; POYE; Production; Purchase 
Order Line Item Detail; Purchase Order Line Item Detail (CPMT); Purchase Order Line Items; 
Purchase Order Receipt History; Purchased Component Detail; QSRC; QUOI; QUOT; Router/
Traveler; SDAB; SDAL; Shipment Allocation Detail; Shipments by Line Item; Shipping Detail; 
Shortages by Order; SHPL; Single-Level Configuration Bill of Material Report; SSII; SSIL; 
Standard Costs Assigned Results; Standard Product Detail; Summarized Bill; Supply Peg 
Detail; Transaction Detail; VDII; VDIT; VDSC; VITI; Where Used; WIPR; WUSE

Drwg
Drawing number identifies an engineering document that provides design specifications for 
an item. Entry is any alphanumeric combination of up to 30 characters.

Where Used: AVII; AVIT; BILI; BILL; Bill of Material; Bill of Material Detail; Engineering; Item 
Browse Detail; Item Master; Item Master Detail; MBIL; Multi-Level Bill; Multi-Level Where 
Used; Production; QUOI; QUOT; Router/Traveler; Shortages by Order; Single-Level 
Configuration Bill of Material Report; Summarized Bill; Where Used

Gateway WC
Gateway Workcenter identifies the starting point for a manufactured item. The gateway 
workcenter is defined on the Location Master as the Bin identifier and must have a Stk 
identifier of WC.
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Where Used: Browse Setup (order); CCAN; Demand Peg Detail; Item Browse Detail; Item 
Master Planning Detail; Lot Trace Issue Detail; Lot Trace Receipt Detail; Manufacturing Order 
Line Item Detail; Manufacturing Order Receipt/Reverse; Material Shortages Detail; MCST; 
MOAN; MOFR; MOMI; MOMT; MORI; MORV; MSMT; Order Browse; ORST; PICI; PICK; 
Picklist Detail; Production; Router/Traveler; Shortages by Order; Supply Peg Detail

Issued Quantity
Issue Quantity is the number of items issued. Entry is up to 10 numbers. Default value is 0.

Where Used: Backflush Issue Reconciliation Report; Custom Product Component Detail; 
Custom Product Detail; CWIP; Demand Peg Detail; Inventory History List; Item History; ITHR; 
Line Item Details + Custom Product; MCST; Order Detail; OVAR; PCST; PICI; PICK; Picklist 
Detail; Purchase Order Line Item Detail (CPMT); Shortages by Order; WIPL; WIPR

Item
Item is the unique identifier for a part, whether it be a piece part, tool, raw material, an 
assembly or finished product. All items are set up using the ITMB screen. Within a product 
structure, an item can be a component as well as a parent. Entry is any alphanumeric 
combination of up to 30 characters.

Where Used: A/P Received Item List; ABCR; Advance Ship Notice Line; Allowance/Charge 
Detail (Detail); APPI; APPV; AUDT; Available for Shipping Allocation Batch; AVII; AVIT; Bill of 
Material Accuracy Results; Browse Setup (item); Capacity Planning; CBIL; CCAN; CCAT; 
CIMT; CINV; COAN; COBK; COCD; COMI; COMP; Comparison Bill; Comparison of 
Summarized Bills; COMT; Contract Item Detail; Contract Item Detail/Pricing; Contract 
Summary; CORV; CSTU; Cumulative Detail; Customer Item + General; Customer Order; 
Customer Order Line Price Adjustment; Customer Order Receipt/Reverse; CWIP; Demand 
Peg Detail; Engineering; FCST; GASN; ICCR; IHIR; IMTR; INVA; Inventory Adjustment 
Application; Inventory Allocation; Inventory History List; Inventory Transaction History Report; 
INVR; IORD; IPPD; ISVI; ITBI; ITCB; ITCI; Item + Quantity; Item Availability; Item Availability + 
Quantity; Item Browse; Item Browse Detail; Item History; Item Lot Receipt; Item Lot Trace and 
Serialization Detail; Item Master; Item Master Detail; Item Master Planning Detail; Item 
Responsibility Assigned Results; Item Shortages; ITHC; ITHR; ITMB; ITMC; ITMI; ITPB; ITPI; 
Lead Times Assigned Results; LEXP; LHIS; Line Item Details + Item; LMSI; LMST; Lot Detail; 
Lot Inventory Transaction History Report; Lot Selection; Lot Trace; Lot Trace Issue Detail; Lot 
Trace Receipt Detail; LOTR; LVAL; Manufacturing Order Line Item Detail; Manufacturing 
Order Receipt/Reverse; Material Shortages Detail; MCST; MOAN; MOFR; MOMI; MOMT; 
MORI; MORV; MPIT; MPSR; MPSS; MSMT; Multi-Level Bill; Multi-Level Costed Bill; Multi-
Level Where Used; MUSE; Open Order Detail; Order Completion Status; Order Cost Variance 
Status; Order Detail; OVAR; Package Content; Packaging Detail; Packing List; Partner Item 
Detail; PBCI; PBCT; PBII; PICI; PICK; Picklist Detail; POCI; POCR; POCT; PORI; PORV; 
POYE; Pricing Maintenance + Action Detail; Pricing Maintenance + Action List; Pricing 
Maintenance + Items/Customers; Pricing Maintenance + Test Order; Production; Purchase 
Order Receipt History; Purchased Component Detail; QSRC; QUOI; QUOT; Router/Traveler; 
Schedule Board; SDAB; SDAL; Selection Setup; Serial Number List; Serial Numbers Shipped; 
SHIP; Shipment Allocation Detail; Shipment Allocation List; Shipments by Line Item; Shipping 
Allocation Batch; Shortages by Order; SHPL; SSII; SSIL; Standard Costs Assigned Results; 
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Standard Product Detail; Summarized Bill; Supply Peg Detail; Transaction Detail; VDII; VDIT; 
VDSC; VEIT; Vendor/Item Detail; VETI; VITI; VPFR; WIPL; WIPR; WIPS; WUSE

Ln#
Line Number is the identification of a line item on an order. The Line Number is system-
assigned. Entry is up to 3 numbers.

Where Used: A/P Invoice Matching Detail; A/P PO/Inv Variance by Invoice; A/P Receiving 
Detail; Advance Ship Notice Line; Advance Ship Notice Order Detail; APEX; APID; APPI; 
APPV; APUV; Available for Shipping Allocation Batch; Backflush Issue Reconciliation Report; 
Bill of Material Accuracy Results; Capacity Planning; CCAN; CINV; COAN; COCD; COCP; 
COMI; COMT; CORV; CPMT; CSTU; Custom Product Component Detail; Custom Product 
Detail; Customer Order; Customer Order + Order Header; Customer Order Line Price 
Adjustment; Customer Order Receipt/Reverse; CWIP; Demand Peg Detail; Dispatch List; 
GASN; IHIR; IMTR; Inventory Transaction History Report; IORD; Item Shortages; JEST; Job 
Estimates and Performance Report; LHIS; LMSI; LMST; Location Index; Lot Detail; Lot 
Inventory Transaction History Report; Lot Trace Issue Detail; Lot Trace Receipt Detail; LOTR; 
LRRP; Manufacturing Order Line Item Detail; Manufacturing Order Receipt/Reverse; Material 
Shortages Detail; MCST; MOAN; MOFR; MOMI; MOMT; MORI; MORV; MSMT; Open Order 
Detail; OPSL; Order Completion Status; Order Cost Variance Status; Order Detail; Order Line 
Items; OVAR; Package Content; Packaging Detail; Packing List; PCMT; PCST; PICI; PICK; 
Picklist Detail; POAN; POAS; POMI; POMT; PORI; PORR; PORV; POSR; POVD; Pricing 
Maintenance + Test Order; Purchase Order Line Item Detail; Purchase Order Line Item Detail 
(CPMT); Purchase Order Line Items; Purchased Component Detail; Router/Traveler; 
Schedule Board; SDAB; Serial Number List; SHIP; Shipment Allocation Detail; Shipment 
Allocation List; Shipments by Line Item; Shipping Allocation Batch; Shortages by Order; 
SHPL; STAD; Standard Product Detail; Supply Peg Detail; Transaction Detail; TRUD; VDSC; 
VPFR; WIPL; WIPR; WIPS

Ln# Sta
Line Number Status indicates the item's current position within the order process. Line 
Number Statuses are:

blank = Order Point Quantity Level Reached. 
PREV and MRP have determined that the order point quantity of the item has been 
reached.

1 = MRP Planned Order. 
MRP has automatically planned an order for the item.

2 = Firm Planned. 
The item's order quantity and scheduled date are fixed and are not automatically 
changed.

3 = Open. 
The item's order quantity and scheduled date are fixed. The order-dependent bill of 
material is attached to the item.

4 = Released. 
The item's order quantity and scheduled date are fixed. The order-dependent bill of 
material is attached to the item. The order and picklist can be printed and receipts/
issues can be made.
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5 = Closed. 
All required receipts or issues have been made for the item.

6 = Closed. 
The order closure report has reported this order closure.

7 = Closed. 
The order is ready to be deleted from the active file and retained in order history.

Line Number Status can in most cases only be incremented. You can reopen an order, which 
decrements the Line Number Status from 5 to 4. For purchase orders, Line Number Status 
= 4 can be changed to 3 if no receipts were completed for that line item and the line is not Ln# 
Typ = S.

Where Used: Capacity Planning; CCAN; Demand Peg Detail; Dispatch List; IHIR; Item 
Shortages; Location Index; Manufacturing Order Line Item Detail; Manufacturing Order 
Receipt/Reverse; Material Shortages Detail; MCST; MOAN; MOMI; MOMT; MORI; MORV; 
MSMT; Open Order Detail; Order Completion Status; Order Cost Variance Status; Order Line 
Items; PCST; PICI; PICK; Picklist Detail; POAN; POAS; POMI; POMT; PORI; PORR; PORV; 
Purchase Order Line Item Detail; Purchase Order Line Item Detail (CPMT); Purchase Order 
Line Items; Purchased Component Detail; Router/Traveler; Schedule Board; Shortages by 
Order; Supply Peg Detail; Transaction Detail; WIPL; WIPR; WIPS

Ln# Typ
Line Number Type determines the use of the item order quantity in planning, manufacturing 
and accounting. Line Number Types available depend on the screen where the transaction is 
completed; these include:

B = By-product. 
Created as part of another order.

M = Manufacturing. 
Dependent demands are automatically created.

R = Rework. 
Dependent demands are not automatically created but are manually added.

U = Tool Return. 
Created as part of another order.

X = Custom Product. 
Make-to-order and engineer-to-order products.

Where Used: Capacity Planning; CCAN; Demand Peg Detail; Dispatch List; IHIR; Item 
Shortages; Location Index; Manufacturing Order Line Item Detail; Manufacturing Order 
Receipt/Reverse; Material Shortages Detail; MCST; MOAN; MOMI; MOMT; MORI; MORV; 
Order Completion Status; Order Cost Variance Status; Order Line Items; OVAR; PICI; PICK; 
Picklist Detail; Router/Traveler; Schedule Board; Shortages by Order; Supply Peg Detail; 
WIPL; WIPR; WIPS
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MB
Make-Buy Code indicates if a part is normally purchased or manufactured. Make-Buy Code 
also directs appropriate action messages to the Buyr (B or S) or Plnr (M). Make-Buy Codes 
are:

M = Make. 
Manufactured in-house.

B = Buy. 
Purchased; no parts supplied to vendor.

S = Supplied. 
Purchased; parts supplied to vendor.

Where Used: ABCR; AVII; AVIT; BILI; BILL; Bill of Material; Bill of Material Detail; COMP; 
Costed Bill Detail; CSLB; Demand Peg Detail; Engineering; FCST; IHIR; IORD; IPPD; Item 
Availability; Item Browse Detail; Item History; Item Lot Trace and Serialization Detail; Item 
Master; Item Master Detail; Item Master Planning Detail; Item Responsibility Assigned 
Results; Item Shortages; ITHC; ITHR; ITMB; ITMI; Lead Time Analysis; Lead Times Assigned 
Results; Lot Size Multiple Detail; Lot Trace; LSDA; LVAL; Material Exposure; Material 
Shortages Detail; MBIL; MPSR; MPSS; MSMT; Multi-Level Bill; PBCI; PBCT; Production; 
QUOI; QUOT; SDAB; SDAL; Shortages by Order; Single-Level Configuration Bill of Material 
Report; SSII; Standard Costs Assigned Results; Summarized Bill; Supply Peg Detail

Need Date
Need Date is the date the component is needed in the next higher-level assembly. This date is 
calculated by MRP.

Where Used: CORV; Demand Peg Detail; IORD; Location Index; Manufacturing Order Line 
Item Detail; Material Shortages Detail; MCST; MOAN; MOFR; MOMI; MOMT; MORI; MORV; 
MSMT; Order Completion Status; Order Line Items; Router/Traveler; Shortages by Order; 
Supply Peg Detail

Order No
Order Number is the user-defined identifier for a purchase, manufacturing or customer order. 
Entry is any alphanumeric combination of up to 30 characters.

Where Used: APEX; Backflush Issue Reconciliation Report; Bill of Material Accuracy 
Results; Browse Setup (order); Capacity Planning; CINV; COCP; Dispatch List; EDIX; IHIR; 
IMTR; Inventory Transaction History Report; IORD; Item Shortages; LMSI; LMST; Location 
Index; Lot Detail; Lot Inventory Transaction History Report; Lot Trace Issue Detail; Lot Trace 
Receipt Detail; LOTR; LRRP; MSMT; Order Browse; Order Completion Status; Order Cost 
Variance Status; ORST; OVAR; Router/Traveler; Schedule Board; SDAB; SHIP; Shipment 
Allocation List; Shortages by Order; STAD; TRUD; VDSC
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Order Qty
Order Quantity refers to the number of parent items ordered. In the case of dispatch lists 
showing firm, open and released orders, the Order Quantity can refer to the unit completions 
for the workcenter operation if a WC[C] resource item is specified on the order-dependent 
routing. If a WC[C] resource item is not specified, the Order Quantity on the dispatch list 
refers to the number of parent items ordered.

Where Used: Dispatch List; Order Completion Status; Order Cost Variance Status; Router/
Traveler; Shortages by Order

Order Rev Date
Order Revision Date is the date of the last change made to the order. The Order Revision 
Date is changed to the system date when the order is revised and helps to clarify 
communication.

Where Used: Order Browse; ORST; Router/Traveler; Shortages by Order

Order Status
Order Status indicates the order's current position within the order process. Order Status is 
automatically displayed for an order, based on the line number status of the line items 
attached to the order. The order status is the highest status of any of the active line items. 
When all line items are closed, the order changes to complete or closed. Order Statuses are:

1 = Preliminary. 
The order header is identified and basic information is entered.

2 = Firm Planned. 
All active line items have a Ln# Sta = 2 (firm planned).

3 = Open. 
The highest Ln# Sta of all active line items is 3 (open).

4 = Released. 
Paperwork is produced and receipts or issues can be made for at least one of the line 
items. The highest active Ln# Sta = 4 (released).

5, 6, 7 = Complete or Closed. 
All required receipts, shipments or issues have been made for all the line items. 
Adding a line item to a completed order changes the Order Status to REL. All order 
line items are closed (Ln# Sta = 5, 6 or 7).

9 = Credit Hold. 
The customer's credit limit has been exceeded or the order is placed on hold for 
another reason. The item is treated as an open order.

Where Used: COMI; COMT; Contract Purchase Orders; CORV; CPMT; Custom Product 
Component Detail; Custom Product Detail; Customer Order + Order Header; Customer Order 
Header Detail; Customer Order Receipt/Reverse; EDIX; IORD; JEST; Job Estimates and 
Performance Report; Manufacturing Order Line Item Detail; Manufacturing Order Receipt/
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Reverse; MCST; MOMI; MOMT; MORI; MORV; OPSL; Order Browse; ORST; PCST; PICI; 
PICK; Picklist Detail; POMI; POMT; PORI; PORV; Purchase Order Header Detail; Purchase 
Order Line Item Detail (CPMT); Router/Traveler; Shortages by Order; Standard Product 
Detail; WIPR

Plnr
Planner code is used to identify the person responsible for planning the production or usage 
of an item. The suggested entry is the planner's initials. Entry is any alphanumeric 
combination of up to 3 characters.

Where Used: ABCR; AVII; AVIT; BILI; BILL; Bill of Material; Bill of Material Detail; Buyer/
Planner Code Maintenance; Custom Product Detail; CWIP; Demand Peg Detail; IORD; IPPD; 
Item Browse Detail; Item Master; Item Master Planning Detail; Item Responsibility Assigned 
Results; ITHC; Lead Times Assigned Results; Line Item Details + Custom Product; 
Manufacturing Order Line Item Detail; Manufacturing Order Receipt/Reverse; Material 
Shortages Detail; MBIL; MCST; MOAN; MOMI; MOMT; MORI; MORV; MPSR; MSCF; MSMT; 
Multi-Level Bill; Multi-Level Where Used; ORST; OVAR; PICI; PICK; Picklist Detail; 
Production; Purchase Order Line Item Detail; QUOI; QUOT; Router/Traveler; SDAB; 
Shortages by Order; Single-Level Configuration Bill of Material Report; SSII; Standard Costs 
Assigned Results; Summarized Bill; Where Used; WIPR; Workcenter Master

Qty Alloc
Allocations is the number and value of units committed to open and released purchase and 
manufacturing orders (Ln# Sta = 3 or 4) and released customer orders (Ln# Sta = 4).

Where Used: Item Availability; Item Shortages; ITHR; Location Index; Production; 
Shortages by Order; SSII

Qty In Insp
Inspection Quantity is the number of units that have been received against purchase orders 
or manufacturing orders where the acceptance or rejection has not been reported. The 
Inspection Quantity is considered in calculating available units.

Where Used: Inventory Status; INVR; Item Availability; LEXP; LMSI; LMST; Lot Detail; 
MPSR; MPSS; Production; Shortages by Order; SSII

Qty In WIP
Internal Work in Process Quantity is the number of units issued to manufacturing orders 
which are still in internal WIP or custom product WIP. Internal Work in Process Quantity is 
decreased by the receipt of the completed work order for the parent assembly into the 
stockroom. When the work order is closed, any overissues are subtracted from Internal Work 
in Process Quantity and underissues are added to Internal Work in Process Quantity.

Where Used: Item + Quantity; Item Availability; Item Availability + Quantity; Item Shortages; 
ITHR; MPSR; MPSS; Production; Shortages by Order; SSII
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Qty On Hand
On Hand Quantity is the amount of inventory available for issue. Entry is up to 10 numbers.

Where Used: CINV; Custom Product Detail; Inventory Status; INVR; Item + Quantity; Item 
Availability; Item Availability + Quantity; Item Shortages; LEXP; Line Item Details + Custom 
Product; LMSI; LMST; Location Index; Lot Detail; MPSR; MPSS; Production; Shortages by 
Order; SSII

Qty On Hold
On Order Quantity is the total number of items on open or released manufacturing and 
purchase orders (Ln# Sta = 3 or 4).

Where Used: Inventory Status; Item + Quantity; Item Availability; Item Availability + 
Quantity; Item Shortages; Location Index; Material Shortages Detail; Production; Shortages by 
Order; SSII; Summarized Bill

Qty Rcvd
Quantity Received is the number of units received for an item on an order. Entry is up to 10 
numbers. Default value is 0.

Where Used: A/P Invoice Matching Detail; A/P PO/Inv Variance by Invoice; A/P Receiving 
Detail; APEX; APPI; APPV; APUV; CINV; CSTU; Custom Product Component Detail; Custom 
Product Detail; Customer Order Receipt/Reverse; CWIP; Inventory History List; IORD; Item 
History; ITHR; Line Item Details + Custom Product; Manufacturing Order Receipt/Reverse; 
MCST; Order Completion Status; OVAR; PCST; PORI; PORV; Purchase Order Line Item 
Detail; Purchase Order Line Item Detail (CPMT); Shortages by Order; VDSC; WIPR; WIPS

Qty Short
Short Quantity is the difference between the Quantity Required and Quantity Issued for a 
component on a released order.

Where Used: Item Shortages; Shortages by Order

Quantity On Order
On Order Quantity is the total number of items on open or released manufacturing and 
purchase orders (Ln# Sta = 3 or 4).

Where Used: Inventory Status; Item + Quantity; Item Availability; Item Availability + 
Quantity; Item Shortages; Location Index; Material Shortages Detail; Production; Shortages by 
Order; SSII; Summarized Bill
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Reqd Date
Required Date is the date the component item is needed for the assembly of the line item, 
taking lead time offset into consideration.

Where Used: Item Shortages; Material Shortages Detail; OPSL; Picklist Detail; Pricing 
Maintenance + Test Order; Router/Traveler; Shortages by Order

Reqd Quantity
Required Quantity is the number of component items required for the parent item. Entry is up 
to 10 numbers. Decimal places are allowed.

Where Used: Capacity Planning; Custom Product Component Detail; Item Shortages; 
Location Index; Material Shortages Detail; Picklist Detail; Purchase Order Line Item Detail 
(CPMT); Router/Traveler; Schedule Board; Shortages by Order

Rev
Revision Level identifies a level of documentation which specifies the item's design. It should 
be incremented for each change in the item's design specifications. Entry is any alphanumeric 
combination of up to 2 characters.

Where Used: AVII; AVIT; BILI; BILL; Bill of Material; Bill of Material Detail; Costed Bill Detail; 
Demand Peg Detail; Engineering; FCST; ICCR; IORD; IPPD; Item Browse Detail; Item 
History; Item Lot Trace and Serialization Detail; Item Master; Item Master Detail; Item Master 
Planning Detail; ITMB; ITMI; LMSI; LMST; Lot Detail; Lot Trace; MBIL; MPSR; MPSS; MSMT; 
Multi-Level Bill; Multi-Level Where Used; PBCI; PBCT; Production; QUOI; QUOT; Router/
Traveler; SDAB; SDAL; Shortages by Order; Single-Level Configuration Bill of Material 
Report; Summarized Bill; Supply Peg Detail; Where Used

Sched Date
Scheduled Date is the planned completion date or shipment date for an item.

Where Used: CORV; CSTU; Demand Peg Detail; IORD; Location Index; Manufacturing 
Order Line Item Detail; Material Shortages Detail; MCST; MOAN; MOFR; MOMI; MOMT; 
MORI; MORV; MSMT; Order Completion Status; Order Line Items; Router/Traveler; SDAB; 
Shortages by Order; Supply Peg Detail

Start Date
Start Date is the date the order must be started so that the required date is met. Start Date is 
MRP-calculated, based on the lead times established for the item on the Item Master. If the 
Start Date is changed by the user, the new Start Date is used by MRP in future calculations 
for the ordered line item.
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Where Used: Demand Peg Detail; Location Index; Manufacturing Order Line Item Detail; 
MCST; MOMI; MOMT; MORI; MORV; Order Completion Status; PICI; PICK; Picklist Detail; 
Purchase Order Line Item Detail; Router/Traveler; Shortages by Order; Supply Peg Detail

UM
Unit of Measure identifies the standard unit for an item used in the manufacturing process. 
Entry is up to 4 alphanumeric characters.

Where Used: A/P PO/Inv Variance by Invoice; A/P Receiving Detail; APEX; APPI; APPV; 
APUV; Available for Shipping Allocation Batch; AVII; AVIT; BILI; BILL; Bill of Material; Bill of 
Material Detail; CCAT; CINV; CMLB; COBK; COCP; COMI; COMT; Contract Header Detail; 
Contract Item Detail; Contract Item Detail/Pricing; CORV; Costed Bill Detail; CPMT; CSLB; 
Custom Product Component Detail; Custom Product Detail; Customer Order; Customer Order 
Line Price Adjustment; Customer Order Receipt/Reverse; CWIP; Demand Peg Detail; 
Engineering; FCST; ICCR; IHIR; INVA; Inventory Allocation; INVR; IORD; IPPD; ITBI; ITCB; 
ITCI; Item + Quantity; Item Availability + Quantity; Item Browse Detail; Item History; Item Lot 
Receipt; Item Lot Trace and Serialization Detail; Item Master; Item Master Detail; Item Master 
Planning Detail; Item Responsibility Assigned Results; Item Shortages; ITHC; ITHR; ITMB; 
ITMC; ITMI; ITPB; ITPI; IVPR; IVRR; JEST; Job Estimates and Performance Report; Lead 
Times Assigned Results; LEXP; LHIS; Line Item Details + Item; LMSI; LMST; Location Index; 
Lot Detail; Lot Trace; Lot Trace Issue Detail; Lot Trace Receipt Detail; LOTR; LVAL; 
Manufacturing Order Line Item Detail; Manufacturing Order Receipt/Reverse; Material 
Exposure; MBIL; MCST; MOMI; MOMT; MORI; MORV; MPIT; MPSR; MPSS; MSMT; Multi-
Currency; Multi-Level Bill; Multi-Level Where Used; MUSE; Open Order Detail; OPSL; Order 
Completion Status; Order Cost Variance Status; Order Detail; Order Line Items; OVAR; 
Packaging Detail; Packing List; Partner Item Detail; PBCI; PBCT; PCST; PICI; PICK; Picklist 
Detail; POCI; POCR; POCT; POMI; POMT; PORI; PORR; PORV; POSR; POVD; Pricing 
Maintenance + Action Detail; Pricing Maintenance + Action List; Pricing Maintenance + Test 
Order; Production; Purchase Order Line Item Detail; Purchase Order Line Item Detail (CPMT); 
Purchase Order Line Items; Purchase Order Receipt History; Purchased Component Detail; 
QUOI; QUOT; Router/Traveler; SDAB; SDAL; Shipment Allocation Detail; Shipments by Line 
Item; Shipping Allocation Batch; Shipping Detail; Shortages by Order; SHPL; Single-Level 
Configuration Bill of Material Report; SSII; SSIL; Standard Costs Assigned Results; Standard 
Product Detail; Summarized Bill; Supply Peg Detail; Transaction Detail; VDII; VDIT; VDSC; 
VEIT; Vendor/Item Detail; VETI; VPFR; Where Used; WIPR; Workcenter Master; WUSE
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WCAL – Workcenter Calendars
Workcenter Calendars is used to create and maintain named shop floor calendars that can be assigned to 
workcenters. Workcenter calendar information includes the calendar name, tolerance limits, capacity 
adjustment amounts and a unique calendar for selecting shop days. Capacity adjustments may be created 
to change a workcenter's initial (baseline) capacity. Changes have a date effectivity and may be one-time-
only, replacement or recurring adjustments. After the workcenter calendar is saved, the changes are 
immediately available (based on effectivity dates) for updating schedules. 

Initially, the workcenter calendar is based on shop day information that is found in the SHOPCAL.DAT file. 
You can choose to continue using this shop calendar information instead of the workcenter shop calendar 
by selecting the Use Shop Calendar checkbox. Changes to the workcenter calendars do not impact the 
SHOPCAL.DAT file. 

If you choose to modify the initial shop day information, use the Shop Day Selection functionality. When 
assigning shop days to a workcenter calendar, date ranges can be selected, as well as exclusion days.

Fields
Adjustment Type

Adjustment Type identifies the method of capacity adjustment used on the calendar. 
Adjustment types are defined when the adjustment is created. Adjustment types include:

C = Initial. 
Used to set the default capacity available.

A = Adjust. 
Used to adjust the default capacity based on the specified recurrence pattern and 
range. The value can be a positive (add to the default capacity) or negative (add to or 
subtract from the default capacity).

R = Replace. 
Used to reset the default capacity from a starting date forward. The reset capacity 
becomes the new default capacity against which adjustment capacity records are 
applied. This capacity remains in effect until replaced by a subsequent replacement 
capacity record at a later date.

Where Used: Workcenter Calendars

Calendar Name
Calendar Name is the user-defined name of the workcenter calendar. Entry is up to 12 
alphanumeric characters.

Where Used: Workcenter Calendars; Workcenter Master

Calendar Type
Calendar Type identifies the type of calendar that is used for the workcenter. Calendar types 
available are shop calendar or embedded custom calendar. Default is shop calendar.
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Where Used: Workcenter Calendars

Chg
Change Type identifies the capacity adjustment as an "add" for new adjustments or as a "chg" 
for an existing adjustment that has been modified. A "err" change type displays if the 
adjustment is in error.

Where Used: Workcenter Calendars

Date
Change Date identifies the date that the capacity adjustment is active. A change date is 
required.

Where Used: Workcenter Calendars

Description
Adjustment Description identifies the capacity adjustment. Entry is up to 30 alphanumeric 
characters.

Where Used: Workcenter Calendars

Recurrence Pattern
Recurrence Pattern is where you determine the schedule of how often recurring adjustments 
will occur for a workcenter calendar. Recurring adjustments can be set to occur daily, weekly 
or monthly. They can also be set to occur every week on specific days of the week, or to skip 
a certain number of weeks.

Where Used: Workcenter Calendars

Recurrence Range
Recurrence Range is where you determine the starting and ending dates for recurring 
adjustments. Recurring adjustments can be set to end on a specific date or after a specified 
number of occurrences.

Where Used: Workcenter Calendars

Tolerance %
Capacity Tolerance Percentage is the percentage used to determine the visual color 
presentation on the Schedule Board when a load is approaching or exceeding the 
workcenter's capacity. For example, the capacity of a workcenter is 100 hours, and you enter 
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a lower tolerance of 5% and an upper tolerance of 2%. The load is displayed on the Schedule 
Board in a different color when it gets to 95 hours of capacity, which is 5% under capacity. The 
load is displayed in another different color when it reaches 102 hours, which is 2% over 
capacity. The colors are user-definable within the SFRM Module using the Options menu. 
Default color values are:

Green = Under Capacity
Yellow = Under Capacity (within Lower Tolerance)
Orange = Over Capacity (within Upper Tolerance)
Red = Over Capacity

Entry is up to 99. When both tolerances are set to 0, only the Under Capacity and Over 
Capacity colors are displayed.

Where Used: Workcenter Calendars

Type
Adjustment Type identifies the method of capacity adjustment used on the calendar. 
Adjustment types are defined when the adjustment is created. Adjustment types include:

C = Initial. 
Used to set the default capacity available.

A = Adjust. 
Used to adjust the default capacity based on the specified recurrence pattern and 
range. The value can be a positive (add to the default capacity) or negative (add to or 
subtract from the default capacity).

R = Replace. 
Used to reset the default capacity from a starting date forward. The reset capacity 
becomes the new default capacity against which adjustment capacity records are 
applied. This capacity remains in effect until replaced by a subsequent replacement 
capacity record at a later date.

Where Used: Workcenter Calendars

Value
Adjustment Value identifies the numeric amount of the capacity adjustment. An adjustment 
value is required and can be entered as a positive or negative number. Entry is up to 999999 
numeric characters.

Where Used: Workcenter Calendars
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WMST – Workcenter Master
Workcenter Master is a record of your company's workcenters. Workcenter information includes the 
description, calendar, capacity, setup status and completion status. Named calendars may be assigned to 
workcenters based on the capacity and schedules associated with the specific workcenter. You can 
maintain workcenters by adding, changing or deleting from the list.

New workcenters are created using default information. A workcenter default record can be setup in order 
to enter workcenter data more efficiently. The workcenter default name is DEFAULT and must include a 
run record and optionally include setup and completion records. The Item Master lists a WC[?] resource 
item for each default record type selected. For example, if the run, setup and completion records are 
selected for the default workcenter, three WC[?] resource records are listed in the Item Master.

Workcenter Master is divided into sections that include:

Reports

Workcenter Master Reports
To generate the report, choose Print Preview from the File menu.

Report Description
Lists all workcenter information including workcenter detail.

Access Method
To generate the report, choose Print Preview from the File menu.

Report Template
For more information on report templates, see “Reporting for SQL Server Systems” in System 
Help Topics.

Available From
Workcenter Master

Tab Title Description

Workcenters Allows you to maintain or view workcenters sorted in alphabetical order.

Workcenter Detail Allows you to maintain or view the details of a workcenter, including the run, 
setup and completion record information. Calendar and capacity information is 
also included for the run record.

Report Title

Workcenter Master
Lists all workcenter information including workcenter detail.
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Fields
Buyr

Buyer code is used to identify the person responsible for handling the purchase of the item. 
The suggested entry is the buyer's initials. Entry is any alphanumeric combination of up to 3 
characters. 

Where Used: A/P Receiving Detail; ABCR; APIE; APII; APIR; APPI; APPO; APPV; AVII; 
AVIT; BILI; BILL; Bill of Material; Bill of Material Detail; Buyer/Planner Code Maintenance; 
Contract Header Detail; Contract Purchase Orders; Contract Summary; Custom Product 
Detail; CWIP; Demand Peg Detail; IORD; IPPD; Item Browse Detail; Item Master; Item Master 
Planning Detail; Item Responsibility Assigned Results; ITHC; Lead Times Assigned Results; 
Line Item Details + Custom Product; Material Shortages Detail; MBIL; MPSR; MSCF; MSMT; 
Multi-Level Bill; Multi-Level Where Used; ORST; OVAR; PCST; PICI; PICK; Picklist Detail; 
POAN; POAS; POCI; POCP; POCR; POCT; POMI; POMT; PORI; PORV; Production; 
Purchase Order Header Detail; Purchase Order Line Item Detail (CPMT); Purchased 
Component Detail; QUOI; QUOT; SDAB; SSII; Standard Costs Assigned Results; 
Summarized Bill; VDSC; VPFR; Where Used; WIPR; Workcenter Master

Calendar Name
Calendar Name is the user-defined name of the workcenter calendar. Entry is up to 12 
alphanumeric characters.

Where Used: Workcenter Calendars; Workcenter Master

Capacity
Capacity is the total number of hours available per period for performing work. Capacity is 
used with Item Type = R (resource) items and is typically specified as a daily rate for a 
workcenter using the Item Class #7 field on the Item Master Detail screen. Entry is up to 
9999999999.

Where Used: Capacity Planning; Dispatch List; MPSR; MPSS; Workcenter Master

Completion
Completion Status indicates whether any unit completions for the run-time operations have 
been reported against the workcenter. The Completion Status options are:

Yes = Unit completions have already been reported against the workcenter 
operation.
blank = No workcenter completion item WC[C] exists for this operation.

Where Used: Workcenter Master
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Description
Workcenter Description is the description of the workcenter for a manufactured item. Entry is 
any alphanumeric combination of up to 29 characters.

Where Used: CWIP; Manufacturing Order Line Item Detail; Manufacturing Order Receipt/
Reverse; MCST; MOMI; MOMT; MORI; MORV; Order Browse; ORST; PICI; PICK; Picklist 
Detail; Router/Traveler; WIPR; Workcenter Master

DPC
Decimal Precision Code represents the number of decimal places displayed and printed for 
inventory-related quantities for an item. Decimal Precision Code = 0 displays quantities 
rounded to whole numbers. However, the actual quantity is stored with all decimal places in 
the database. Entry options include:

0 = Zero positions
1 = One position
2 = Two positions
3 = Three positions
4 = Four positions
5 = Five positions
6 = Six positions
7 = Seven positions
8 = Eight positions
9 = Nine positions

Where Used: Engineering; Item Master; Item Master Planning Detail; Production; 
Workcenter Master

Fix LT
Fixed Lead Time is the number of working days required for setup and queue time used in 
planning an order. It is added to run lead time and inspection lead time to estimate planned 
lead time for an order. Entry is up to 3 numbers.

Where Used: AVII; AVIT; BILI; BILL; Bill of Material; Bill of Material Detail; IPPD; Item 
Availability; Item Browse Detail; Item Master; Item Master Planning Detail; MBIL; MSMT; Multi-
Level Bill; Multi-Level Where Used; Production; QUOI; QUOT; Single-Level Configuration Bill 
of Material Report; Where Used; Workcenter Master

Insp LT
Inspection Lead Time is the number of working days normally required for inspection of an 
item. It is added to run lead time and fixed lead time to estimate total planned lead time for an 
order. For purchased items, Inspection Lead Time is used to determine the required dock 
date based on the date needed in stock. Entry is up to 3 numbers.
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Where Used: AVII; AVIT; IPPD; Item Availability; Item Browse Detail; Item Master; Item 
Master Planning Detail; MSMT; Production; QUOI; QUOT; Single-Level Configuration Bill of 
Material Report; Workcenter Master

Plnr
Planner code is used to identify the person responsible for planning the production or usage 
of an item. The suggested entry is the planner's initials. Entry is any alphanumeric 
combination of up to 3 characters.

Where Used: ABCR; AVII; AVIT; BILI; BILL; Bill of Material; Bill of Material Detail; Buyer/
Planner Code Maintenance; Custom Product Detail; CWIP; Demand Peg Detail; IORD; IPPD; 
Item Browse Detail; Item Master; Item Master Planning Detail; Item Responsibility Assigned 
Results; ITHC; Lead Times Assigned Results; Line Item Details + Custom Product; 
Manufacturing Order Line Item Detail; Manufacturing Order Receipt/Reverse; Material 
Shortages Detail; MBIL; MCST; MOAN; MOMI; MOMT; MORI; MORV; MPSR; MSCF; MSMT; 
Multi-Level Bill; Multi-Level Where Used; ORST; OVAR; PICI; PICK; Picklist Detail; 
Production; Purchase Order Line Item Detail; QUOI; QUOT; Router/Traveler; SDAB; 
Shortages by Order; Single-Level Configuration Bill of Material Report; SSII; Standard Costs 
Assigned Results; Summarized Bill; Where Used; WIPR; Workcenter Master

Run LT
Run Lead Time is the average number of shop days required for a manufacturing run or 
vendor lead time and is used in planning an order. Run Lead Time is added to fixed lead time 
and inspection lead time to estimate planned lead time which serves to time order release. 
Decimal places for fractional days allowed. MRP Planning uses fractional days as reference 
and plans using the next whole day increment. For example, if you specify Run LT = 2.1, MRP 
Planning assumes Run LT = 3 for calculation purposes. Entry is up to 8 numbers.

Note: Lead times established for an item are considered to be 0 when the item is used as a 
phantom (CT = P) in a bill of material.

Where Used: AVII; AVIT; BILI; BILL; Bill of Material; IPPD; Item Availability; Item Browse 
Detail; Item Master; Item Master Planning Detail; MBIL; MSMT; Multi-Level Bill; Multi-Level 
Where Used; Production; QUOI; QUOT; Single-Level Configuration Bill of Material Report; 
Where Used; Workcenter Master

Setup
Setup Status indicates whether any time has been reported against the workcenter setup 
operation. The Setup Status options are:

Yes = Time has already been reported against the setup operation.
blank = No workcenter setup item WC[S] exists for this operation.

Where Used: Capacity Planning; Dispatch List; Location Index; Schedule Board; 
Workcenter Master
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Starting Workcenter
The Starting field is used to request a list where the specified information appears first on the 
list. Starting entries may consist of a partial entry and if the entry is not in the list, the next 
highest entry appears first on the list. The Starting field can include one or more field 
combinations, each with its own entry requirements.

Where Used: A/P 1099 Distribution; A/P Payment Application Detail; A/P Payment Void 
Detail; A/P Received Item List; A/P Receiving Detail; A/R Payment Application Detail; APAH; 
APDS; APEX; APID; APIE; APII; APIR; APIV; APPA; APPD; APPI; APPO; APTX; ARAH; 
ARCD; AREX; ARIC; ARIH; ARPD; ARPH; ARSR; BAMT; Bank Payment Approval; BILI; 
BILL; BKMT; Browse Setup (customer); Browse Setup (item); Browse Setup (vendor); CACF; 
CCAN; CCAT; CCEX; CCMT; CIMT; CMCF; CMTA; CMTI; CNFA; COAN; COMI; COMT; 
Contract Item Detail/Pricing; CORV; CPMT; CUID; CUII; CUSI; CUST; FCMT; FCST; G/L 
Account Group/No List; G/L Account No List; G/L Batch Detail; G/L Journal Entry List; G/L 
Master Account Recap; G/L Org No List; G/L Org/Acct Group List; G/L Organization Group/No 
List; G/L Report List; G/L Source Code List; GLAG; GLAV; GLBD; GLCA; GLCI; GLDQ; 
GLEX; GLGQ; GLJD; GLJE; GLJI; GLJP; GLJR; GLMA; Global Extended Text Selection; 
GLOS; GLRD; GLRL; GLSC; GLSI; GLSS; ITBI; ITCB; Item Master; Item Shortages; ITMB; 
ITMI; ITPB; ITPI; IVCO; IVIA; IVIE; IVII; IVRV; LMMT; Location Selection Setup; MCST; 
MOAN; MOMI; MOMT; MORI; MORV; MPED; MPIT; MSMT; NMTA; OPSL; Orders on 
Shipment; ORST; Packaging Detail; PASS; PBCI; PBCT; PBMI; PBMT; PCMT; PCST; PICI; 
PICK; POAN; POAS; POCI; POCT; POMI; POMT; PORI; PORV; REDI; RTMT; RVED; SBOL; 
Selection Setup; Serial Number List; Serial Numbers Shipped; SHIP; Shipments by Line Item; 
SHPI; SSII; STAD; SUND; SUNR; SUPD; SUPR; TEXT; TXTA; VAT Summary (APSM 
Module); VATT; VEDI; VEID; VEND; VENI; Workcenter Master

UM
Unit of Measure identifies the standard unit for an item used in the manufacturing process. 
Entry is up to 4 alphanumeric characters.

Where Used: A/P PO/Inv Variance by Invoice; A/P Receiving Detail; APEX; APPI; APPV; 
APUV; Available for Shipping Allocation Batch; AVII; AVIT; BILI; BILL; Bill of Material; Bill of 
Material Detail; CCAT; CINV; CMLB; COBK; COCP; COMI; COMT; Contract Header Detail; 
Contract Item Detail; Contract Item Detail/Pricing; CORV; Costed Bill Detail; CPMT; CSLB; 
Custom Product Component Detail; Custom Product Detail; Customer Order; Customer Order 
Line Price Adjustment; Customer Order Receipt/Reverse; CWIP; Demand Peg Detail; 
Engineering; FCST; ICCR; IHIR; INVA; Inventory Allocation; INVR; IORD; IPPD; ITBI; ITCB; 
ITCI; Item + Quantity; Item Availability + Quantity; Item Browse Detail; Item History; Item Lot 
Receipt; Item Lot Trace and Serialization Detail; Item Master; Item Master Detail; Item Master 
Planning Detail; Item Responsibility Assigned Results; Item Shortages; ITHC; ITHR; ITMB; 
ITMC; ITMI; ITPB; ITPI; IVPR; IVRR; JEST; Job Estimates and Performance Report; Lead 
Times Assigned Results; LEXP; LHIS; Line Item Details + Item; LMSI; LMST; Location Index; 
Lot Detail; Lot Trace; Lot Trace Issue Detail; Lot Trace Receipt Detail; LOTR; LVAL; 
Manufacturing Order Line Item Detail; Manufacturing Order Receipt/Reverse; Material 
Exposure; MBIL; MCST; MOMI; MOMT; MORI; MORV; MPIT; MPSR; MPSS; MSMT; Multi-
Currency; Multi-Level Bill; Multi-Level Where Used; MUSE; Open Order Detail; OPSL; Order 
Completion Status; Order Cost Variance Status; Order Detail; Order Line Items; OVAR; 
Packaging Detail; Packing List; Partner Item Detail; PBCI; PBCT; PCST; PICI; PICK; Picklist 
Detail; POCI; POCR; POCT; POMI; POMT; PORI; PORR; PORV; POSR; POVD; Pricing 
Maintenance + Action Detail; Pricing Maintenance + Action List; Pricing Maintenance + Test 
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Order; Production; Purchase Order Line Item Detail; Purchase Order Line Item Detail (CPMT); 
Purchase Order Line Items; Purchase Order Receipt History; Purchased Component Detail; 
QUOI; QUOT; Router/Traveler; SDAB; SDAL; Shipment Allocation Detail; Shipments by Line 
Item; Shipping Allocation Batch; Shipping Detail; Shortages by Order; SHPL; Single-Level 
Configuration Bill of Material Report; SSII; SSIL; Standard Costs Assigned Results; Standard 
Product Detail; Summarized Bill; Supply Peg Detail; Transaction Detail; VDII; VDIT; VDSC; 
VEIT; Vendor/Item Detail; VETI; VPFR; Where Used; WIPR; Workcenter Master; WUSE

Workcenter
Workcenter is the identifier for a specific production facility, consisting of one or more people 
and/or machines, which can be considered as one unit for the purposes of capacity planning, 
scheduling and costing. If the SFRM Module is installed, workcenters are defined on the 
Workcenter Master. If the SFRM Module is not installed, workcenters are established on the 
Item Master as resource items. The workcenter's run, setup and completion records define 
how the workcenter should be used when constructing the bills of material.

When the workcenter is displayed on the Item Master, a five-character prefix is added to the 
workcenter name. Prefixes include:

WC[R] = Run-time hours for workcenter operations
WC[S] = Setup hours for the workcenter operations
WC[C] = Unit completions for run-time operations at the workcenter

Workcenter entry is any alphanumeric combination of up to 10 characters.

Where Used: Capacity Planning; Dispatch List; Location Index; Router/Traveler; Schedule 
Board; Workcenter Master

Yield
Item Yield Factor represents the expected output of items in the manufacturing process and 
is expressed as a percentage of total input. An Item Yield Factor greater than 100% indicates 
an expected gain of units in the manufacture of an item. It is used to plan for expected losses 
(or gains) by adjusting demand quantities. Entry is up to 5 numbers.

Where Used: CMLB; CSLB; Item Master Planning Detail; MSMT; Production; Workcenter 
Master
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